boyumlid

DOCUMENTATION

Visual Advanced Production Scheduler (VAPS)

Version: 1. 20 | as of 3 February 2025

Boyum IT Solutions GmbH
Pascalstr. 17

52076 Aachen

Germany

Tel:  +49(2408) 1410
Fax:  +49 (2408) 141 33
Web: www.boyum-solutions.com



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

Table of contents

Release and VErsion STATUS ........eiiieiiiiieiie ettt et e st sbe e st e sbeeesaree s 7
1.1.  Isthe VAPS available for BC/NAV, for cloud/on-prem, for all partners? And when?............. 7
1.1.1. Is the VAPS available for Dynamics 365 Business Central and Dynamics NAV?.............. 7
1.1.2. Is the VAPS available for Business Central on-prem and cloud?.........cccoocvieieviiieeennnen. 7
1.1.3. Is the VAPS available for sale? ... 7
1.1.4. Is the VAPS available for all NETRONIC PartNers?......ccccueerueerieeenieesiieesieesieeeneeeesneens 7
1.2, Where can | find the VAPS release NOTES? ......ccuoiiiiiiiiiirierieesie et 7
INSTAIING TNE VAPS. ...t et e et e e e e st e e e et e e e s e aaeeesasbaeeeannsaeeesnnraeeeennseeas 7
2.1. How can linstall the VAPS in my on-prem environmMent? .......cccccveeeeiieeeeecieeesccieeeeceieee e 7
2.1.1. Prerequisites to iNStall The VAPS: ... et e e e e eanens 8
2.1.2. The VAPS D365 on-prem can be installed in two different ways:.......ccccoevvveivieeeneeennennn 8
2.2. How can | deploy the VAPS into a cloud infrastructure? ........ccccovvveeviiereiieesiie e 9

2.2.1. For existing customers migrating to the new licensing system as of VAPS version
1.15.1.1 9

2.2.2. For new customers wanting to purchase the VAPS via AppSource or directly from

NETRONIC .ttt ettt e e e e e e bbbttt e e e e e e e b et et e e e e e e e e nnbabeeeeeeeeeaannnebeeeeeeeeaaannnnee 9
Look and feel of the visual SChedUIe ...........cocuiiiiiiii e 10
3.1, INfO WINAOW SHOWS PrOSIESS...ciiiiiiieiiiiiieeeiieieeeettee e ettt e e et e e et e e e s sbaeeessnbaeeeesnsaeeesnnsreeeans 10
3.2, The structure of the SChedUIE .....c...ooiiii e 11
3.3, Three different VIBWS ... ittt st 13
3.3.1. The CAPACItY VIBW .ueeeiie ittt et et e e et e e e bae e s e ae e e e sabae e e e aneeas 13
3.3.2. The Production Order View (read only) .......ccueeeceieiieeeee et 16
3.3.3. The Sales Order VIiew (read ONlY) .....couieeiieeeiee ettt 17
3.34. For better overview in large plans: the World VIEW ......cccccoveeiieieiieescie e 18
3.4, Thetime scale part of the SChedUIE .........ooouiiiiieeecee e e 19
R T Yo o Y[ o T=dr-Y o o IE-Yol o] 1113V USSP 20
3.5.1. Increase/reduce time SCale SOIUTION ...ccovvviei ittt eae e e eaaees 20
3.5.2. Show orders of a certain timespan ONlY.......c..coovciiiieiiii e 21
3.5.3. Yol o] 111 o =SSP 21
3.54, Return to default time range......ooceee e 22
3.5.5. SEANCH FUNCHION ...ttt e 22
3.6. The table part of the SChEAUIE .......oooiiiiiiie e e 24
3.6.1. The "STtandby" FESOUICE......iii it e e e e e e e aneeas 24
3.6.2. Collapsing and eXPaANiNG.......uieiicuiiieiiiiie et s e s srae e e s b e e s nnaeeeeas 24
3.6.3. Show/hide the RISTOZIaM ....ccveeieee et 26
3.7. The graphical part of the SChedUle..........cooouiiiiiiie e 27

boyumﬂ pace 1 ofF 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

3.7.1. The elements of the graphical partin detail ........ccoooveieieiiiiiie e, 27
3.7.2. (071 1=T o To =T SR O TSP PP P U VOTTOUPTPP 32
3.7.3. P O S e e e e e e e e e e e e eas 36
3.7.4. LIS -ttt ettt b e bt b et e ettt et e e nbeesheesane e 38
375, WK At et 39
3.7.6. o[0T g=Te I (BTN - | = SRR RPR 39
3.7.7. Info symbol for additional information on operations.......cccccccevevvvieeiiniie e, 39
3.7.8. LI =38 oo 14 e TSP 41
3.7.9. The "STandby" FESOUICE. .....cciiciiie e et e e et e e e ebae e e e areeas 41
3.8, Navigating in the Plan......oo et e et e e et e e e e a e e e e anreeaean 42
3.8.1. Adjust The tiME SCAIE .eeviie i e e e e e e araaaee s 42
3.8.2. Show operations of a certain timespan ONly.......cccvevciiiiiciie e 42
3.8.3. Yol o] 111 =SSR 42
3.8.4. Navigate Within ONE FOULING ....c.eiv i 43
3.8.5. Adjust the width ratio between table and diagram ........cccceevieeiiiiencee e 43
3.8.6. Return to default time range......coeiciiiei e 43
3.9. The histogram provides capacity information .........ccccccueiieiiiiiiiiiie e 43
3.9.1. Include/exclude standby operations for the load CUrve .........ccccevvveeieeveevee s, 44

4. THe VIEW COION MOTES...uiiiiieiieeiieee ettt ettt ettt b e s bt e b e s st e ebeesbeesbeesareeas 45
4.1.1. How to apply @ VIEW COIOr MO ......ccuiiiiieciie ettt e 46
4.1.2. How to change the default colors of a view color mode ........cccceeeeiieiiiicieiicciee e, 47
4.2, The Item VIEW (COIOr MOTE) .....uiiiiieiieetiee ettt ettt e eree e e ebre e e eabre e e eareeas 47
4.2.1. Change color for individual iteMS.......cuviiiieiiee e e 47
4.3.  The Machine/Work Center View (COlOr MOUE) .....cccuvevuieieerieiieeie e 48
4.1.  Change color for an individual Machine/Work CENter ........c.cocuvevveevieeieeiie e 49
4.2.  The Production Order View (COlOr MOAE) ....ccuveiiiiireiieiireec ettt e 49
4.2.1. Change color for an individual production order........ccceeeecieeeeiiiieee e 50
4.3.  The Production Order Status View (COlOr MOde) .....cueevieeeciiieniie et 50
4.4,  The Progress VieW (COlOr MOUE) .....occuiiiiiie ettt rtte e et e e saae e ae e enaeeennee s 51
4.5, The Shop FIOOr Status VIEW .....uuiiiiiiiieciiee ettt et e e abae e e e e e e arae e e earaeas 52
4.6.  The Execution Status View (COIOr MOTE) ....cooecuvrieiiieiiieicireeeee et e e 53
4.7.  The Availability VIEW (COIOr MOE).....c.uiiiiieciiiecee et e e e e 53
4.8. The Wait Times VIiew (COlOr MOUE) .......eiiiieiiiieeiie ettt re e raeeeaee s 54
4.9, The MRP VieW (COlOr MOUE)..ccuuiiiiiieiiieciie ettt ete et e st e e st e e saae e e aeeesaaeessreeesaeeennee s 55
4.10. The Production Line ASSIZNMENT VIEW .......eeieiiiiiiiiiiiiie et e e 56
4.11. The Production Line SEQUENCE VIBW .....ccuviiieiiiiieecieee ettt e s e e saaee e 56

boyumﬂ paGe 2 oF 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

5.

SELHING UP thE VAPS ... .ttt e e e et e e et a e e e s eabae e e e naaeeesansaeeesansaeeeaas 57
5.1. How can | define the default COIOrs?......c.uiiiiiiiiiiie e 57
5.1.1. General INfOrMAatioN ... .coi it 58
5.1.2. Specific settings and what they are for ... 58
5.2. How can | define individual colors for specific items? ........ccceeeeeiieieeiiiieeccee e, 60
5.3. How can | define individual colors for specific machine centers? .......ccccccevveeeviiieeeeiineeenn. 62
5.4.  How can | define individual colors for specific production orders?........ccccecvveeeicveeericneneenn. 63
5.5, HOW tO CONFIUIE T00IIPS . cecviiieiiiiiie ettt e s e e e e e snsaeeeeas 64
5.6.  How to configure bar [QDEls ........c..oeeeeiiiiieeeee e 66
5.6.1. FOrmatting the [ahelS .....ei e e s 69
5.7, Configure table TEXES .ouuiiii et e e e aaeea s 70
5.7.1. [ o XNV o I o] o Lol =TT [PPSR 70
5.7.2. FOrmatting the tEXE ...uevi i e 71

5.8. How to use flow fields for tooltips, table, and label texts in NETRONIC'S simulation tables 72

5.9.  The “GeNneral “SETHINGS ...oeeiiiiiei et e e et e e et e e et e e e e e aaeeeeeannreeaean 72
5.10. The “Scheduling” settings in the VAPS ........oo it 73
5.11. How to set the parameters for EMAD calculation ........ccccvvieviiieieiiiieee e 74
5.11.1. Consider EMAD on production order routing line level...........cccovieeiieiicciee e, 74
5.11.2. Exclude item type “NON-INVENTOIY” .....ooooiiieeeeee e e 75
5.11.3. Exclude blocked iINVENTONY.....ccc.uiii e e 75
5.11.4. Exclude not fully promised receipt date from automatic functions like Add All ...... 75
5.11.5. Include fully consumed items into EMAD calculation..........cccoeveienieeniiiiiniecniieeenne. 75
5.11.6. Consider EMAD in semi-automatic scheduling ........ccccoceeeeiiiiiieciiie e, 76
5.11.7. Apply EMAD tolerance to an it@M .......occueiiicciiiie ettt e 76
5.11.8. Consider sub-locations when calculating EMAD .......cccvviiiiiieecciie e 76
5.11.9. Shortcut to EMAD demand ......coceiiieiieiieiieecieeeesee st 78
5.11.10. Run EMAD calculation from JOb QUEUE ......cc.eeoiiriiiiiiiieiicecneeeeece e 78
5.12. Settings for integrating MRP/planning Worksheet..........ccceeovveecieeccee e 79
5.13. How to set up the automatic calculation of the earliest start date .........ccceevvevevveercieenns 79
5.14. The “Sales order handling” SETLINGS ....vciicviiii i 80
5.15. The “APPEAraNCE” SETLINGS...cciciiiiieciiee ettt e e e e e e e s sae e e e aaeeeesnsaeeeans 80
5.16. Show/hide the Notifications WINAOW ........occuvviiiiiiiiiiceie e 86
5.17. Define alternative routings/ alternative work/machine centers ........cccccocvveevverecveeecnennns 86
Integrating with Microsoft Dynamics 365 Business Central ........ccccceeeeecciiieeeeee e s i 89
6.1. Integrating with Business Central standard manufacturing........cccccceeevveeeiiiieeeciiieec e, 89
6.1.1. How does the VAPS integrate with work/machine centers? .........cccoevvevveeveviecvecnenn, 90

boyumﬂ paGe 3 oF 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

6.1.2. ProdUCION OFAEIS. ... .eiiiiiieiieite ettt sttt e nane e 94
6.1.3. ) =T aTe | ) A T oYU T ol TSR 95
6.2.  Output and coONSUMPLION POSTINGS..cceiiuriiiiriiiieeiiiiieeeiireeeesttee e e e st eessbaeeessabeeesnnsseeeeas 96
6.2.1. Fundamentals on output/consumption POStINGS:.......cccvveeeivieiiieeeiiieeie e 96
6.2.2. The impact of the production order status........ccccecveieeiiiee e 97
6.2.3. Visualization of progress information in the VAPS........ccciviiiie e, 97
6.2.4. Special case: Posting on an operation that is still on the standby resource................. 97
6.3. Integration with MRP/planning Worksheet..........ccoueevveieeiiccee e 97
6.3.1. Here is how we implemented this concept in the VAPS: .......cccoeeiiievieiiiieeciee e 98
6.4. Integration with shopfloor data .......cccccueeiiiiiiii i 101
6.5.  Integration of sales orders and production Orders ........cccceecvieeeeiiiee e 102
6.6. Show sales order number on production order liNe .......ccoeevieeeiiiieeiciiee e, 103
6.7.  Reflect sales department updates in the production schedule .........ccceeeeviiiiiniieeeenen. 104
6.8.  Planning Per SAlES ONUEIS ....coiuiieiieeeiie ettt stee s e et e e st e e saaeesnteesnaeesnsee s 104
6.9. Use sales order line information in tooltip, label, and table texts.......ccccccvvvveevieeecieennennn 106
7.  Finite capacity scheduling iNStrUMENTS .....c.vviiiiiiiie e e e e aaee e 107
7.1.  What is finite capacity SChedUlING? .....c..veiiiiiiiee e 107
7.1.1. Working with infinite capacity on certain work/machine centers.......c.cccocvervvervennen. 107
7.2, IMOVE OPEIATIONS ittt ettt e e e e ettt ee e e e e s b e b ee e e e e e e e e nnbbreeeeeeeeeeannenee 108
7.2.1. Change timing of an OPEratioN........cceevcieiiiie e 108
7.2.2. Change resource of OPeration.........cicccuiiie i 109
7.2.3. Move operations that have already been started..........ccoceeeevciiiiiiciieeccce e 109
7.3.  Change the duration of OPerations ........ccecieeiciieciie e 111
7.3.1. Pin operations, production order lines, production orders .........ccccoveeeeeiveeeecveeeeenns 111
7.3.2. Move (multiple) operations via dialog ........ccceeeuiieiieeiiiiece e 113
7.3.3. The underlying principles of drag & drop......cccceeeeiiieeieciiie e 114
74, SChEAUIE SUCCESSOIS ...cuviiiieiieieie ettt ettt b e st ere e saeesane e 114
7.4.1. The underlying principles of “Schedule SUCCESSOIS” ........iiviiiriiiririiecee e 115
7.5.  Apply StaNdard rOULING.....c..ei i 115
7.5.1. The underlying principles of "Apply Standard Routing"..........ccceevveiiieiiciiiee e 115
7.6, Apply alternative FOULING....cc.viiie ettt e e e e e e e e atae e e e eareeas 115
7.6.1. The underlying principles of "Apply Alternative Routing" .........cccccceevvieivieevieesiieens 116
7.7.  Schedule production orders from standby in one go by the "Add all" function................. 116
7.7.1. HOW T WOTKS .ttt st s e e sme e e sabee e 117
7.7.2. More efficiency by planning per sales orders .......cccoveeeeeiiieieciiei e 117
7.7.3. Regulate the behavior of preceding and succeeding linked production orders.......... 119

boyumﬂ paGe 4 or 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

7.8. Move unhandled production orders, production order lines, or operations to standby in
one go 121

7.8.1. Definition of “Unhandled” ...........oceoiiiiiiii e 121
7.8.2. Move unhandled operations to Standby per work or machine center........c.ccccecueennn. 122
7.9, FIll A1 tIMES ettt et et s 123
7.9.1. HOW T WOTKS .ttt ettt et e st e s snee e sbee e 123
7.9.2. Fill idle times on a single work or machine center......cccocovveivciiie e 124
7.10. TIGNTEN QUEUES .eeeeeeeeiee et e e e et e e st e e e et e e e e eab e e e e e abaeeeeenbaeeeennseeas 124
7.11. Calculating and working with earliest material availability........cccccoeeiiiniiiininiiieecies 125
7.11.1. Material availability: Fundamentals.......ccceeeiiiiiiiiiiiie e 125
7.11.2. Basics of the EMAD calCulation .......coovveiiiiiiiiienieeeieesc e 125
7.11.3. HOW WE @llOCALE ..ottt s 126
7.11.4. SEttiNg the EIMIAD ...cooiiie ittt sttt ettt e e aae e s te e saeeesnree s 127
7.11.5. Consider the EMAD on the production order routing line level .........cccccccecveeennn. 127
7.11.6. Exclude items from EMAD calculation ........cocceeviiiiiiiiniiciieececeeesee e 130
7.11.7. Consideration of the supplier's delivery date promises in planning...........cccccc...... 131
7.11.8. Handling of operations with missed EMAD...........ccccouiieieiieee et 133
7.11.9. Handling of completely picked it€mS ......ccueeiieiiiieece e 134
7.11.10. Apply EMAD tolerance to an it@M .......occueeeeeciiie e e 134
7.11.11.  Shortcut to EMAD demand eNntri€s ......cccevverieriiriiiieeieeseeseeee et 134
7.11.12. Run EMAD calculation from JOb QUEUE ........c.coviiiiiiiiiiiiieceecceeeee e 135
7.12. Sequence-dependent SETUP tIMES ..ocovuviiiiiiiiie e 135
7.13. Resolve conflicts due to overloads or link constraints .........coceeveeieenieniinicesceeeeee 138
8. SIMUIATIONS .ttt sttt sttt e b e bt e s bt she e et e et e et e e beenheenaeeea 139
8.1.  What s this simulation idea all aboUL? .........ccceeviiiiiiiirie e 139
8.2. How does the production simulations page Work?........ccccoeveeeiiiiii e, 140
8.2.1. Functions of the Simulations PAgE .....cececueeeeiie it 140
8.2.2. Content of the simulations overview table ...........occoiiiiiininieee e 141
8.3.  How do | create a new SImuUIatioN? ........c.cocuiiiiiiiieniene et 141
8.3.1. THhe FILEr SETHINGS oo ettt e e e s aae e e s sbaeeeeenes 143
8.3.2. How to define regularly used base view and production order filters ..........cceee.... 145
8.4. How changes to a simulation are managed ........cccceeeeeeciiiiieie e 147
8.4.1. General changes to production OFdErs ........c..evvviiiieiiieee e 147
8.4.2. A specific change to a production order: the status change.........ccccccoeeveeeiiivee e, 147
8.4.3. A change to the production order routing line status........cccccceveeeiieeeieciee e, 148
8.5, ComMPAre SIMUIALIONS . ....viiee it e e e et e e s esaree e s s nnbee e e e nnreeas 148
8.6. How do | publish @ SIMUIQLION? ...cceeiiiiiiie e 150

boyumﬂ paGe 5 or 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

8.7. Handling of simulations with warehouse activity ines.........ccccceevvivieeiiieeeennenn.
S B D - AV o B o Y AU - o 1 <L PP
9.1. Working with subcontracting Work CENTErs ........ccccveveriiiiiieeiiiee e

9.1.1. Handling of subcontractor production orders with related purchase orders

9.2. Infinite capacity for work centers/machine centers .........cccoveeeeeeiieeciieeccieeciees
9.3.  Using data filters: filter on capacities........cceveviiiiriiiieiiiie e
9.4.  (Basic) production line SChedUliNg ...........ccueeviieiiiiiiiiecee e
9.4.1. BUSINESS CeNLral SELUP woovvvviieeeiiiie ettt e e
9.4.2. Scheduling: We take the “line dependency” into account.........cccceevcvveernene
9.4.3. Visualization: We also monitor the “physical dependency” .......ccceeevvernene
9.4.4. How to cope with the limitationS........ccooieiiiiiieiii e,

boyumlid

paGe 6 oF 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

1. Release and version status

1.1.1s the VAPS available for BC/NAV, for cloud/on-prem, for all partners? And
when?

Learn about "all things availability" when it comes to the Visual Advanced Production Scheduler.

1.1.1. Is the VAPS available for Dynamics 365 Business Central and Dynamics NAV?

No, the VAPS is only available for Dynamics 365 Business Central. The minimum version required is
Business Central v14 (cu4).

1.1.2. Is the VAPS available for Business Central on-prem and cloud?

The VAPS is available both for Business Central on-prem and cloud.

1.1.3. Is the VAPS available for sale?

Yes, the VAPS is available for sale and to be implemented at and used by customers. Version 1.0 was
released on 17 January 2020.

1.1.4. Is the VAPS available for all NETRONIC partners?

No. The VAPS requires specific skills and expertise as it enhances and changes Business Central
significantly.

Please reach out to sales@netronic.com if you want to achieve the VAPS certification.

1.2.Where can | find the VAPS release notes?

Learn how to find the release notes for the Visual Advanced Production Scheduler. Learn how you
can check if you're on the latest version. Learn what is new.

The release notes of the Visual Advanced Production Scheduler can be found here:

https://www.netronic.com/microsoft-dynamics-365-business-central/visual-advanced-production-
scheduler/release-notes

2. Installing the VAPS

2.1.How can | install the VAPS in my on-prem environment?
Learn where and how you get the runtime package of the VAPS

First, you as a partner need to become "VAPS certified". Talk to sales@netronic.com to find out
details about the certification process.
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Once you are VAPS certified, you'll get access to our "NETRONIC VAPS Partner Community". It is
based on Microsoft Teams, and your place to go to get your demo version/ runtime package of the
product as well as Marketing and Sales collateral.

2.1.1.

Prerequisites to install the VAPS:

An up and running full-fledged Dynamics 365 Business Central Installation

Minimum required version: Business Central vi14 (cu4).

Access to the backend via the “Business Central Administration Shell” or the “NAV
Container Helper”

The Web Client needs to be enabled — and using the Web Client is highly recommended

2.1.2. The VAPS D365 on-prem can be installed in two different ways:

. THE NAVSERVER INSTANCE IS INSTALLED DIRECTLY ON THE COMPUTER

What is needed for the installation:

Admin access to the NAV/BC server computer

Access to the NAV/BC Admin Shell & Development Shell with admin rights on this
computer

The “Name” of the NAV/BC Serverinstance into which the extension should be installed
An updated NAV/BC license installed, which has the extension objects included

Access to the NAV/BC Web Client to test the installation

Access as “SUPER” user to NAV/BC, to assign Permission Sets to other users

Installation instructions:

Run the "Business Central Administration Shell" as administrator and enter the following
commands:

Publish-NAVApp -Serverinstance NAV -Path “NETRONIC Software GmbH_Visual Advanced
Production Scheduler_1.x.y.z_runtime.app” -SkipVerification

Sync-NAVApp -Serverinstance NAV -Name “Visual Advanced Production Scheduler”
Install-NAVApp -Serverinstance NAV -Name “Visual Advanced Production Scheduler”

If the install call gives an error regarding “DataUpgrade,” try

Start-NAVAppDataUpgrade -Serverinstance NAV -Name “Visual Advanced Production
Scheduler”

Open the NAV/BC Web Client as user with “SUPER” permissions

Check the “extension management” page if the extension got installed properly

Check if you can open/run the extension

Assign the “NETRONIC VAPS” permission set to all users which should work with the extension.

. THE NAVSERVER INSTANCE IS RUNNING FROM A DOCKER ENVIRONMENT

What is needed for the installation?

Admin access to server computer and the corresponding Docker environment
Access to a powershell with the NAVContainerHelper module installed
The “Name” of the NAV/BC Container into which the extension should be installed
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An updated NAV/BC license installed, which has the VAPS objects included
Access to the NAV/BC Web Client to test the installation
Access as “SUPER” user to NAV/BC, to assign Permission Sets to other users

Installation Instructions:

Please enter the following command with the help of the "NAV Container Helper":
Publish-NavContainerApp -containerName navserver -appFile “NETRONIC Software
GmbH_Visual Advanced Production Scheduler_1.x.y.z_runtime.app” -skipVerification -
sync -install

If the publish call gives an error regarding “DataUpgrade,” try
Start-NAVContainerAppDataUpgrade -containerName navserver -Name “Visual
Advanced Production Scheduler”

Open the NAV/BC Web Client as user with “SUPER” permissions

Check the “extension management” page if the extension got installed properly
Check if you can open/run the extension

Assign the “NETRONIC VAPS” permission set to all users which should work with the
extension.

2.2.How can | deploy the VAPS into a cloud infrastructure?

If you want to use the VAPS in a cloud environment you can download the app from Microsoft or
purchase it via your partner.

In both cases, the VAPS needs to be licensed. With the release of VAPS version 1.15.1.0, we have
implemented a new licensing system within the extension. This update is specifically designed to
ensure that proper licensing is maintained within SaaS environments. This also applies to existing
customers migrating to the new licensing system.

To ensure a smooth and fault-free licensing process, we've included the necessary steps for you in
the following instructions.

2.2.1. For existing customers migrating to the new licensing system as of VAPS version
1.15.1.1

How to license the VAPS - new licensing system .

2.2.2. For new customers wanting to purchase the VAPS via AppSource or directly
from NETRONIC

How to purchase and license the VAPS via AppSource or NETRONIC.

Available on

Microsoft AppSource
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3. Look and feel of the visual schedule

3.1.Info window shows progress

When a simulation gets loaded into the VAPS, multiple stages of data processing are executed until
the visualization finally appears and the user can start working with it. Especially when there are
large amounts of data to be loaded/reloaded, this can take some time during which the users do not
know what is happening and are often unsure whether the application is still working.

To give the users more feedback as to what is happening during the loading process, we have
implemented a new info window that:

gives feedback that something is happening at all (meaning the extension has not crashed)
informs about the amount of data getting loaded, thus explaining why the process might take
so long

informs about how long this process might take and how long the users might need to wait
also helps our support team during customer trainings or support cases to get a better
understanding of the customers' environment.

View - Visual Advanced Production Scheduler

NETRONIC VAPS 5] Open in Excel Actions Fe

Capacities - Processing Activity: 1/4 Reading Simulation from Business Central

Working on it...

January 20

Work Center Group: 2 of 2

Work Center: 5 of 5

Machine Center: 14 of 14

Calendar Entry: 1698 of 2204 @
Production Order: 122 of 122

Production Order Line: 122 of 122

Prod. Order Routing Line: 588 of 588
Prod. Order Capacity Need: 1390 of 1390
Sales Header: 0 of 0

Sales Line: 0 of 0

Cancel
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The info window also shows up when you create, delete, copy, publish, and close (with saving) a

simulation.

Working on it..

Processing Activity: Simulation completely deleted
Work Center Group: 2 of 2

Work Center: 5 of 5

Machine Center: 14 of 14 )
Calendar Entry: 250 of 250

Production Order: 21 of 21

Production Order Line: 23 of 23

Prod. Order Routing Line: 115 of 115
Prod. Order Capacity Need: 226 of 226
Sales Header: 0 of 0

Sales Line: 0 of 0

3.2.The structure of the schedule

The VAPS provides you with a visual drag & drop frontend to manage your production schedule.

Since the VAPS is a Gantt Chart, it naturally has all its characteristics and elements:

Visual Advanced Production Scheduler 2 X
NETRONICVAPS | Actions ~  Fewer options 2
" B-bruary 2024 A~ ‘Man:h 2024
Capacities
Wk 05 | Wk 06 | Wk 09 Wk 10
o .
S i
4 Turning | Drehen = H E
Standby (e0) g 1 A 10 1¢ }
R R 1 1071 (¢ ¢
I 101076 ( ¢
i 101077 (| ]
CTX400 3 (] 4
CTX 2500 »
Beta 500 »
Beta 600 »
4 Sawing | Sagen »
Standby (o) d i 1c
Sow s v | T A0 ot aci o oo (i aa
4 Gear Cutting | Verzahnen »
Standby (e0) f 10 0110 101 1
101075 (80,
Il [iE
Aclive color mode: [tem View Active view filler: No view filter active Last EMAD calc. fime: 06.11.23 15:10 Last shopfioor update: 31.01.24 13:26

e Atime scale at the top.

o Atable at the left.

e On the right below the time scale, a diagram displaying the schedule with a calendar in the
background indicating work free periods in grey while working times appear in white.

e A menu ribbon is placed above the plan, the item “NETRONIC VAPS” summarizing all menu
options that we think are the most frequently used ones::
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NETRONIC VAPS | Actions ~  Fewer options

€ Undo 2@ Update Simulation > Apply Routing X Exit discarding changes 88 Sales Order View

» Redo % schedule Successers > Apply Alternative Routing @ Capac ty View 59 Production Order View
All options of the VAPS can be found under “Actions”:

uﬂgh _ lil ﬁ Eillinﬁﬂi . ‘;“h “inﬂﬂﬂﬁﬂi .

Visual Advanced Production Scheduler

MNETROMNIC VAPS | Actions »  Fewer options

Edit ?
Schedule >
4 Production
4 Turning | Dreher View >
Standby (oo}
Capacity Management »
Timeascale >
CTX400 | Calendar ’ 1401029 4 1010
CTX 2500 . View Filter EI 101021 (10107 10
| ) T
Beta 500 coarch 5 i101 osol (s 10103ﬂ

Beta 800 \ 4 I 1O TON023 (A5 RIOs ]

In case the “Actions” item is not visible in the menu ribbon, click “More options". To hide it
again, click “Fewer options.”

Please note, that, depending on the task you are currently working on (setting-up the VAPS,
working in a simulation etc., the contents of the menu ribbon will differ.

e Aninteractive status area can be shown below the visual schedule, providing the planners with
useful information about
o Whether new warehouse activity line or shopfloor data is available. Clickable to load the
new data.
The active color mode, clickable to select another mode.
Whether a view filter or the focus mode is active. Clickable to choose another filter.
The last time the EMAD was calculated.
The last time the schedule was updated with shopfloor data.

Aclive color mode: Execution Status Actlive view filter: No view filter active Last EMAD calc. time: 11/06/23 03:10 PM Last shopfioor update: 01/31/24 01:29 PM

The status area is activated by default but can be switched off in the "Appearance" area of the
VAPS setup.
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Appearance

Zoom Factor(3&) ‘ 1oo| Weekend Coloring

Layout ‘ COMPACT v | Colorize Weekend @

Toaltip Delay (ms) ‘ ‘I2SO| Weekend Color |#DFFA9F ‘
Standby Color ‘#FBFSBBQB B | Bar coloring mode |Graded £ ‘
Dateline Grid Mode |Weekly v | | Hide Status Bar O

3.3.Three different views

There are three different views in the VAPS: the Capacity View, the (read-only) Production Order
View and the (read-only) Sales Order View.

You can switch between the views by the corresponding context menu items:

View ~ Timescale
@, Enable Focus Mode
Disable Focus Mode
[& Show Setup Times

Hide Setup Times

Capacity View

88 53les Order View

k]

B8 Production Order View

I&View Color Mode >

3.3.1. The Capacity View

The capacity view shows capacity loads of work centers and machine centers, grouped by work
center groups:
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Th, 08. Feb 2024 Fr, 09. Feb 2024/ Sa, 10. Feb 2024 Su, 11. Feb 2024 Mo, 12. Feb 202 Tuweb 2024 We, 14. Feb 202{ Th, 15. Feb 2024 Fr, 16. Feb 2024| Sa, 17. Feb 2024 Su, 18. Feb 2024 ¢4
00:00 (12:00 |00:00 |12:00 |00:00 |12:00 |00:00 (1200 |00:00 |12:00 |00:00 |12:00 |00:00 |12:00 |00:00 |12:00 |00:00 |12:00 |00:00 [12:00 [00:00 [12:00 |00

e, 07.

Capacities
Beta 500 3
Beta 800 3

4 Sawing | Sagen )

Standby (o)

Saw | Sage »

4 Gear Cutting | Verzahnen »

Standby (o)

LC 500
LC 180

»
13
Phoenix »
4 Milling | Frasen »

101062 (&)

Standby (o)

Active color mode: Production Order View Active view filter: No view filter active Last EMAD calc. time: 06.11.23 15:10 Last shopfloor update: 31.01.24 15:27

Select display mode for overlapping operations

Usually, overlapping operations are shown in an "optimized" way, meaning that the resource row
with the respective operations gets extended in height so that the operations are completely visible.
Since the VAPS schedules with finite capacity, overlapping operations are avoided, and hence this is a
rare case.

——

However, some customers have contacted us with the following use case: They need to create
operations with a length of zero to define a common starting point for parallel routings without
blocking capacity. These operations will then be scheduled at the first possible position which will
result in a very high stacked resource. For these cases, we added two new context menu items so
that users can now decide whether overlapping operations are to be shown overlapped in one row
or stacked. This also applies to resources on Standby.

T s o
{
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4 Milling & Turning (o) »

Standby (oo}

Fill Idle Times an this Machine Center

N Cefine additional Down Time

Define additional Up Time

Edit additional Down Time

Remove additional Up Time

Sort Order

A Asse

Show operations overlapped in one row

p Asj| Show operations stacked

The picture below illustrates the different display modes:

Stacked view Overlapped view

Reorder the table per drag and drop
The table context menu offers an option to enable manual sorting per drag and drop:
Remave additicnal Up Time

4 Sort Order
Enable Manual Sort Order Mode

Show operations overlapped in cne row

Show operations stacked

Once enabled, you can, e.g., drag the “Wagner BAZ” machine center easily to another place:

Wagner BAZ »
TC 229 Brother »
My very i = r=m s =

4 Assembly

4 Assembly - Team 1 »

Visualization of the field ""Earliest Start Date™
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The VAPS comes with the convenient automatic scheduling functions "Add all", "Fill idle times",
"Apply routing," and "Tighten operations". With the new version, users can limit these functions to
only schedule production order routing lines/operations so that they start at or later than the date
defined. This is done by the new field "Earliest Start Date", having been implemented on production
order, production order line, and production order routing line level. Depending on the configuration
in the “Appearance” section of the “Setup” menu, this line will appear when hovering over and/or
clicking an operation with an earliest start date.

S Jan 142024

Capacities

4 Inveniory department
d Aapeenibly deparment ]
Standty (o)

Wi Seamans

Earbait Sract Dute 1010005 - 10
= § &

Eryan Walton

Lireclp Mitchedl

If the earliest start date is defined on all levels, the latest available date will be used for scheduling
and if the "Consider EMAD" option is activated, this date will also be taken into account, meaning
that the latest of all four dates will be considered.

Operations with an earliest start date can nevertheless still be dragged manually to an earlier start.

3.3.2. The Production Order View (read only)

The Production Order View shows production orders categorized by their status.

Soheduling 5190

4 1616008 Bicyde P '
101005 o001 1 T
10 (Wheel assembiy i
20 [Chain assembily] m
30 [Finad assembidy) m
|

A0 [Cortrol

¥ 100001 Touring Bigrae PP ’ '

® 1011002 Bigyole
1011003 Bigyde

10011004 Bicpdle
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The categories are indicated by different colors:

p Firm Planned

Production orders, their production order lines, and production order routing lines are sorted in
ascending numerical order. Within each production order, the relating production order lines with
their production order routing lines are listed. The default sorting order for nearly all elements in the
plan can be changed either by context menu or via the “Configurations” tab in the VAPS setup.

| '€ 7z + fi] o/
H

VAPS Setup

MNew | Actions Fewer options

Configurations ~~ ==
#% Tooltip...
3M
#% Label..

#% Sort Order...

Configures the sort order.

€ Reset all configurations...

Consider EMAD when... ‘) Consider Send-Ahead ‘3
Consider EMAD when... ‘j Scheduling 5tart (rela... 1D
Consider Queue Time - - @lD Max. Number of Sche... 3

3.3.3. The Sales Order View (read only)

The Sales Order View shows those sales orders that have production orders against it and when
those production orders (lines) are scheduled. A visual alert is given if the production order's finish
date is past the sales order's requested delivery date.
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R:uary 2022
Sales Orders (read-only) 04
20 |30

Required Due Date

4 1000120
4 10106110000 | 20
10 (Wheel assembly) E
20 (Chain assembly) m
30 (Final assembly)
40 (Control) 4
50 (Packing table 1) m
4 1100120 &

4 10106210000 | 20 101062 | 10000 | 24

10 (Rim assembly) E

20 (Drilling) 2}
30 (Deburr)
40 (Machine Inspection)

50 (Wheei assembly)

3.3.4. For better overview in large plans: the World View

Especially in large plans, it often happens that the planner loses herself a bit in the vastness of
operations. To help them find their way and to not lose track of the overall situation, we
implemented the "World View" that shows a small additional window underneath the actual plan
and is available in all three views described above.

By dragging the red rectangle in the "World View", you can quickly shift your focus to another part of
the plan.
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Fewer options

Calendar

View - Visual Advanced Production Scheduler X
NETRONIC VAPS. Open in Excel Actions
Edit~~  Schedulews = Vieww  Timescale - Search 4=
23 ] g Y 0 34 i} 06 0 g 3]
[& Enable Focus Mode ﬂ“u“ﬂﬂ.ﬂ!ﬂuﬂ.ﬂ.ﬂ“““u“ﬂ“ﬂ?ﬂ“““ﬂl -
4 Machining g | | 2 |
Disable Focus Mode r i 2 |
Cutting = £ i
< |
[& Show Setup Times E E |
Standby (oo A t |
LI, Hide Setup Times i o i
Cutting #1 Show World View i oo 3 0 0 3 T il a%i0di30 Rido
Cutting #2 [& Hide World View do L2 ﬂ. maao FiliopEnopdn gido <8N«
Capacity View B
i !
4 Drilling 28 Production Order View . !
Standby (sc) 4 View Color Mode > |
- Al ~d ML~ i A~ URRA A WAL A S i Ve s ) - -
i ea
oo
o diae

View Filter

3.4.The time scale part of the schedule

The time scale is one of the three main areas in your schedule and is positioned at the top of the

view.

Capacities

BO, 25. Jan 2021

Tu, 26. Jan 2021

We, 27. Jan 2021 Th, 28. Jan 2021

@

12:00

Fr, 29. Jan 2021

00:00

The time scale covers the period that was defined in the simulation's filter. This is the time from the
earliest date to the latest date.
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CREATE SIMULATION /

Saved Settings

Changes to the options and filters below will be saved only to: 'Last used options and filters'

Use default values from: Last used options and filters e

Filters

Description Simulation Created on 08/05,/20 10:10 AM
Minimum Status ¥
Earliest/Latest Date Input Type Absolute Date v

Earliest Date Formula

Latest Date Formula

Earliest Date 3/1/2020
Latest Date 3/31/2020
Default View Color Type ltem View ¥

3.5.Zooming and scrolling

The VPS offers various options of adjusting the size of your working area and going directly to a
particular place in your diagram.

3.5.1. Increase/reduce time scale solution

Depending on how much detail or summary is required, you can either increase or reduce the time
scale solution by mouse wheel or touchpad (move two fingers up and down on your touchpad)
within the time scale.
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Wednesday, 20. January 2021 Friday, 22. January 2021 Saturday, 23. hllﬂl‘m Sunday, 24. Jai
Capacities 3
01:00| 06:00 | 12:00 | 18:00 00:00 (06:00 (12:00 | 18:00 |[OC:00 |06:00 | 12200 |18:00 |00:00 | D6:00

4 Machining

4 Cutting »
Standby (oo}
Cutting #2
Cutting #3

4 Drilling »
Standby (o9)
Drilling #1 [ ]
Drilling #2

4 Milling & Turning 3

3.5.2. Show orders of a certain timespan only

A more precise way of showing certain parts of your plan is offered by the options of the "Timescale"
menu items. Click the according one to show either

e all orders of your current workday
e all orders within a week starting from the current work date
e all orders of a month starting from the current work date

[ | Actions Fewer options

Timescale
# Fit into View
¥ Scroll to Workdate
Scale to > 48 Work Day
B8 Work Week

M Work Month

3.5.3. Scrolling

The VAPS offers the following options for quickly navigating to certain positions in the diagram:

e the common scrolling options by vertical and/or horizontal scrollbar
e dragging the timescale either right or left
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e scroll directly to the Dynamics 365 Business Central work date by selecting the corresponding
item from the “Actions” menu.

| Actions Fewer optit

Timescale ~~
# Fitinto View

¥ Scroll to Workdate
Scale to >

|

3.5.4. Return to default time range

Select "Fit into view" to switch directly to the timescale as defined in the filter settings of the
simulation.

3.5.5. Search function

In both views, you can search for certain production orders:

Actions Fewer options

1escale - Search ~

#% Search Operation

Search Sales Order
I

e Inthe Capacity View, users can search for production orders and production order lines.

e Inthe Sales Order View, users can search for sales orders and sales item lines.

e The respective view then automatically scrolls to the first search result which gets
highlighted as well.
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O Search

SEARCH SIMULATION

L.'yeneral

Status Filter

B8 Open in Excel

Nene

- Prod. Order Mo. Filter

|1010-{?

Riouting
Prod. Order Reference Mo. Operation Mo

Status T Mo T T * Description Starting Date Ending Date
—*  Firm Planned 1 101047 10000 10 Cutting #2 1/15/2021 1/18/2021

Firm Planned 101047 10000 20 Drilling #1 1/18/2021 1/19/2021

Firm Planned 1011047 10000 30 Milling #1 1/19/2021 1/20/2021

Firm Planned 101047 10000 40 Inspection Table #2 1/21/2021 172272021

Released 101047 10000 10 Drilling #1 1/28/2021 2/1/2021

=
I 40

40 |

The search dialogs can be personalized the same way as is known from Business Central by
adding columns in the fields list.

+ Field Clear personalization
O Search B Open in Excel More options Ny Add Field to Page X
SEARCH PRODUCTION ORDER LINE 7 A X Place fields by dragging from the list to a
position on the page.
[General
7 Code
Status Filter None v Prod. Order No. Filter Rk Variant Code Ready
Text
Description Ready
Status T Prod. Order No. t Line No. t Item No. Routing Reference No.
2 Text
= Firm Planned : 101023 10000 3001 10000 ~f Description 2 Ready
Firm Planned 101033 10000 3002 10000 T
Firm Planned 101034 10000 3002 10000 Location Code Ready
Firm Planned 101035 10000 3006 10000 Code
Firm Planned 101036 10000 3006 10000 Shortcut Dimension 1 Code  Ready
Firm Planned 101040 10000 1000 10000 [ Code
Firm Planned 101042 10000 1100 10000 Shortcut Dimension 2 Code  Ready
Firm Planned 101043 10000 1200 10000 Code
Firm Planned 101044 10000 1300 10000 Bin Code Ready
Firm Planned 101045 10000 1300 10000 [
Firm Planned 101046 10000 1300 10000 L Quantity Ready
Firm Planned 101047 10000 1700 10000 Decimal
Firm Planned 101048 10000 1700 10000 f Finished Quantity Ready
Firm Planned 101049 10000 1900 10000 [ Decimal
Firm Planned 101050 10000 1901 10000 Remaining Quantity Ready
Firm Planned 101051 10000 1902 10000 | Decimal
Firm Planned 101052 10000 1903 10000 Scrap % Ready
Firm Planned 101083 10000 1000 10000 | .
Firm Planned 101054 10000 1001 10000 Due Date Ready
Firm Planned 101055 10000 1300 10000 - B
Starting Date Ready
Time
. = - Starting Time Ready
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3.6.The table part of the schedule

The table is one of the three main areas in your schedule and is positioned at the left. It shows your
resources grouped by work center groups, work centers, and machine centers.

3.6.1. The "Standby" resource

The standby resource does not exist in your Dynamics 365 Business Central work centers. It is a
virtual machine center that we automatically create in every work center. It contains all production
order routing lines/operations that are not yet scheduled from within the VAPS, and hence are just
scheduled by the Business Central scheduling run. The standby resource gets highlighted by a yellow
background and an infinity symbol next to its name:

February 2021

Capacities Wk 06 Wk 07 Wk 08
06 |07 08 09 10 11 12 13 14 15 16 17 18 19 20
4 Machining
4 Cutting »
Standby (eo) il 1
Cutting #1 » 10100/iefp1dioiforf ifi101018
Cutting #2 » fiig10d5
Cutting #3 »
» Drilling » 1010C107008 finot0m qi0101
i ac q i 101l

Please note that

o the standby resource always is treated as a resource with infinite capacity
e all other machine centers are treated as finite capacity resources)

3.6.2. Collapsing and expanding

Symbols located to the left of the work center groups and work centers provide the ability to collapse
or expand these centers. This feature allows you to conveniently hide or reveal specific details,
making it easier to navigate through the information presented in the table.

4 »

In the picture below, the work center group "Machining" is expanded, and the related work centers
are collapsed:
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< VISUAL ADVANCED PRODUCTION SCHEDULER | WORK DATE: 1/28/2021 ¥

NETRONIC Promoted Open in Excel Actions Fewer options

February 2021

Capacities Wk 06
4 Machining -
} Cutting » 101001cfp1diol A 1401101018
i iol
101005
» Drilling » qo10¢ 101008 f 1101011 diogl
i ®& i 101
101006
101005
» Milling & Tuming » i fio1008 fi jog it 10111010101
[] 1010057 (101008
fiog i
[
» Painting » 101008 ooz | o il it #8019/ io1006
101008 101008 (10100¢ 1
10100101009 1 101006
4 Assembly & QA |

Capacities
4 Machining
4 Cutting »
Standby (o) T 1
Cutting #1 » 1010 icb1dioiforf idi101018
Cutting #2 » fi 11005
Cutting #3 »
» Drilling » io10c101008 1101011 0161
i & i i

a0

Please note, that in collapsed work center groups, no operations are shown:

anuarg.tr 2021
Capacities k 03

» Machining

4 Assembly & QC
4 Assembly »

Standby (o0)

Assembly station #1

Assembly station #2

boyumlid
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The VAPS automatically saves the complete collapsed/expanded state of a view so that you can start
exactly with the status you saw when you left the view.

3.6.3. Show/hide the histogram

In the "Capacities" view, planners can easily get a visual representation of the workload by displaying
a histogram. To access this feature, simply look for the symbol located on the right-hand side next to
the name of the work center or machine center:

Cutting b

Clicking this symbol will either show or hide the capacity curve for this work or machine center. The
picture below shows the histogram for the "Drilling" work center:

Capacities

February 2021

4 Drilling

Standby (co)

Drilling #1
Drilling #2

» Milling 8 Turning

Actions

Edit

Schedule

View

Capacity Management ~

Timescals
Calendar
View Filter

Search

boyumlid

2,098 -
1,049 -

i

» 101009 101008 | fi/i@i00e
» [} il i©1005
» 101C 101008

Fewer options

Change Uptime >
> Change Downtime >

> Capacity Aggregation >

10101011

s

W By Week

. By Meonth

1101018

10100!

101005 [1C
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3.7. The graphical part of the schedule

The graphical part - the diagram - is one of the three main areas in your schedule and is positioned in
the middle of the view. It shows you which machine center is working on which production order
routing line/operation and when.

B January 2021 February 2021
Capacities i wk 05 Wk 06
1 26 101
' 1010 0 p
a
| q0102 .
{ (=]
Cutting #1 101027 4101028 ] ¢ ?
| . 2
—I = =
Cutting #2 01018 i 01007 i &
Cutting #3 10 ([ oioo: =
4 Diilling »
Standby (e0) 10 {16101 7061 01014
" o
Drilling #1 a0 i 101101027 101022 i o]
i
Drilling #2 d0i6)o1910]§10d 101023 fiio]
4 Milling & Turning »
Standby (o) JiE 91012 | MpordiER  f6iEhe
00
Milling #1 doiol [gjon i Ym 101022
Milling #2 . 101024 101 :
Turning #1 i 1 10102 w0l ﬁ
Milling & Turning 101 1010 ool o3 i
. . .

3.7.1. The elements of the graphical part in detail
Bars

Each production order routing line/operation of a production order is represented by a bar that is
either colored or white. The colored area of a bar indicates that this timespan is during the work time
of the underlying machine center. The white area of a bar indicates that this timespan is during the
non-work time of the underlying machine center (also see below "Calendar". The bar color depends
on the selected color scheme (see below).

The following information can be gathered from optical indicators:

e  Currently marked operation

0

e QOperation changed but not saved yet
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e Violated due date

e Violated routing links

e QOperations potentially scheduled outside the visible time range
In addition to being indicated by a warning symbol, these operations get moved to the
standby resource.
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e Pinned operations, production order lines, production orders

The context menu allows to pin the above elements so that they can't be moved.

! Unpin

| Pinwith Capacity blocked

¥

¥

Pin without Capacity Consumption »

Move to Standby

H

Mavigation

'Em 0105

Pin Operation with Capacity blocked
Pin Prod. Order Line with Capacity blocked
Pin Production Order with Capacity blocked

Schedule Successors

Apply Routing

Apply alternative Routing

=
0

Set Facus

Remowve Focus

Change Prod Order Status

{ Apply Shop Floor Changes

: Change Duraticn

| Move Pinned/Started Operation

Standard MRP Behavior
Exclude from MREP
Include into MREP

Show Additional Information

The different options are visually indicated as follows:

e Pin without consuming capacity

oo |

e Pin consuming capacity

boyumlid
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o Link violation after having pinned an element. The picture below shows that the
predecessor of a pinned operation was moved behind this operation

e Setup times

The setup times can be visualized as light grey section at the beginning of the bar.

I

You can switch between showing and hiding the setup times by a menu item:

View Timescale
@ Enable Focus Mode

Disable Focus Mode

[& Show Setup Times

Hide Setup Times

Il'i View Color Mode

The color representing the setup time can be easily specified in the VAPS color settings:
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Color Setup

General
Default Item Celor w#OO0ER Default Production O... wO0O0ER
Default Maching/ Wor... #0005 Setup Time Color c0de

e Display mode for overlapping operations

Usually, overlapping operations are shown in an "optimized" way, meaning that the resource
row with the respective operations gets extended in height so that the operations are
completely visible. Since the VAPS schedules with finite capacity, overlapping operations are
avoided, and hence this is a rare case.

.20

_ 0 L —
T = m

However, some customers have contacted us with the following use case: They need to
create operations with a length of zero to define a common starting point for parallel
routings without blocking capacity. These operations will then be scheduled at the first
possible position which will result in a very high stacked resource. For these cases, we added
two new context menu items so that users can now decide whether overlapping operations
are to be shown overlapped in one row or stacked.

4 Milling & Turning (o) b

Standby (o0}

Fill Idle Times on this Machine Center

N Define additional Down Time

Cefine additional Up Time 1

Edit additional Down Time

Remove additional Up Time

Sort Order

A Asse

Show operations overlapped in one row

p Asj| Show operations stacked

The picture below illustrates the different display modes:
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Stacked view Overlapped view

3.7.2. Calendar

The grey and white area in the background visualizes the work and non-work periods of the
respective work/machine center. They are derived from the respective shift calendars.

Fr, 29. Jan 2021 Sa, 30. Jan 2021

00:00 12:00

I R R

Show/hide non-working times

Some planning situations require to focus on the working periods of a work or machine center only.

To show or hide non-working periods, click the "Calendar" item in the "Actions" menu and select the
desired option. This feature allows to hide or show the common non-working periods.

Actions Fewer options

mescale ~ Calendar ~ View Filter ~ Search v

U U U U
N i Show Non-working Periods i
- X Hide Non-working Periods
Non-working times are shown:
NETRONIC VAPS Open in Excel More optlons
e 03. Feb 2021 | Th, 04. Feb 2021 Fr, 05. Feb 2021 Sa, 06. Feb 2021 Su, 07. Feb 2021 Mo, 08. Feb 2021
Capacities
07:0] 12:00 00:00 12:00 12:00
4 Cutting
Standby (eo)
Cuttin #3 RS DN |
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Non-working times are not shown

NETRONIC VAPS Open in Excel Actions Fewer options
4 Cutting »
Standby (eo)
Cutting #2 10 i 10 -1( —w.aiu 10 410430 #10
30

e Handling of standby resources

Currently, the calendar of the related work center is applied to standby resources, so that
when the non-working period is hidden, the non-working periods that are shared by all
calendars will not be displayed and the timescale gets collapsed during these periods. On the
other hand, switching the non-working periods on means that those periods that are
common to all calendars will be displayed.

e Individual design of weekend colors and of date line grids

Some of our customers use a 24-hour working calendar and, as they told us, sometimes have
difficulties to navigate and plan by day in the diagram area because the change between the
days and/or weekends and working periods are not clearly visible. This, in turn, forces the
planner to constantly look back and forth between the timescale and the plan. So, we set to
work and implemented three new visual elements to create a better connection between
timescale and diagram area:

o vertical separation lines between individually selectable intervals
o individual background and bar coloring, and transparency degree for weekends
o anindividual background color and transparency degree for the standby resource

In the picture below, the date line grid mode is set to "Daily", the background color for the
weekend to a light blue, and the Standby color to a slightly darker yellow with a high degree
of transparency:
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NETRONIC VAPS Open in Excel | Actions Fewer options
Rnuary 2021 February 2021 L~ J
Capacities k02 Wk 05 wi
22 23 24 01 02 03 04 05 06 o7 os
4 Machining 2
o
£
4 Cutting » 2
=
Standby (o) 109 . -:I
Cutting #1 » 5
Cutting #2 » I I
Cutting #3 »
4 Drilling »
2 T aNal
Drilling #1 » 2( 10

The according settings can be found in the "Appearance" area of the VAPS setup dialog:

e Dateline Grid Mode

Dateline Grid Mode Daily v
Mone

Weekend Coloring Auto

Colorize Weekend P

Weekend Color ‘ #9FD7FA |

The "Auto" mode causes the grids to automatically adjust to the resolution of the time scale
resulting from zooming in or out.

e Weekend coloring

Dateline Grid Mode ‘ Daily V‘

Weekend Coloring

Caolorize Weekend ‘)

Weekend Color ‘#QFD?FA

If you want to color the weekends individually, you can activate this here.

o By clicking “...”you open the Color Picker dialog where you can
= select the desired color
= adjust the transparency:
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Color Picker | - 2 K

Selected Color | #oFD7FA

Kl -

= reset the weekend color to default comfortably and at one click:

Color Picker | - 7 X

Selected Color |#9FD?FA

Manage >
. &

Actions b Yd’ Reset Color to Default...
| |
Fewer options ® Reset color to default.
+ Show as menu I
[

“ can cel

(@]

Bar colors: Select individual bar color schemes that ensure that the label texts are
always visible.

Colorize Weekend ® )
Graded

Weekend Color Solid
Only Allocated Times

Bar coloring mode Graded v/

The options in detail:

boyumlid

= Graded (default): nonworking times are displayed in a lighter shade of the
main color; in case there are assignments during non-working periods they
are drawn in the main color

7 ENENENINCE - 0 EECE T
i i
i

i
I10| :
i
| I | |
1
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= Solid: draws a continuous block in the main color

=  Only Allocated Times: nonworking times appear with a white background

i i
IiO Iw 10 :
o NN |
TCa N N

e Standby color

The procedure for editing the standby color is the same as for the weekend coloring:

Appearance

100 P4 Color Picker
STANDARD

A note on transparency: weekends, standby and calendar grids may overlap and by setting the
transparency, the user can determine what should be hidden or what should shine through. For

example, if you want to see the calendar grids or the weekends on the standby resource, you have
to make the standby color translucent accordingly.

3.7.3. Progress

For production order routing lines of released production orders, a progress bar can be displayed

below the actual bar being based on the posted quantity consumption or on the production time
passed

General

Progress Calculation Based on Time s

MNane
Bazed on Time
Based on Quantity

The color of the progress bar depends on the routing status and the percentage of completion:

e finished: black
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” u

e Status “none,” “planned,” “in progress”:

o Progress by quantity / by time < 100% : grey

o Progress by quantity / by time > 100 % : red

When attempting to move operations that are "in progress," a warning message appears, prompting
whether scheduling should proceed with the original quantity or with the current remaining quantity.
In the latter case, the input quantity will change, with a warning to the user that this action may
result in misleading progress bar information.

How should the input quantity of the changed operation be
handled?

Keep the current input guantity of 26.4
OR
Update the input quantity with current postings to 0

CAUTION: If the input quantity gets updated, the progress bar
information for this routing line will be misleading.

i® Keep the input quantity

() Update the input quantity

o I
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3.7.4. Links

Predecessor/successor relations are shown as arrows ("links") between the bars. They are only
shown for the production order that is currently selected.

e links between operations of one production order

]
-

o
o

e links between operations of different production orders if they are linked to each other by
reservations (make to order) OR links between production order lines coming from one
production order (make to stock)
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3.7.5. Work date

A red vertical line in the chart indicates the work date, this usually being the current date.

4 Drilling b

Standby (o0} i

Drilling #2

3.7.6. Required due date

The “Required Due Date” is a dedicated VAPS field that can be set on the “Production Order” card
and is visually represented in the plan by a corresponding line. Depending on the configuration in the
“Appearance” section of the “Setup” menu, this line will appear when hovering over and/or clicking
the relevant operation.

Feqguired Due Date 2722021 =

This date can only be set and modified by the user and is recommended for cases where specific
production orders have strict due dates.

a
4 Machining E
=F]
=
b Cutting b i o
2
b=
(e
a
- o
4 Drilling 2

3.7.7. Info symbol for additional information on operations

In Business Central, users can add additional information to a production order routing line by
creating comments, tool information, personnel information, and quality measure information that
are used, e.g., for describing certain specialties that need to be followed during the production
process. As this is, of course, valuable information, the VAPS helps the planner to quickly recognize
whether a production order line has such additional information so that the special requirements are
not overlooked.
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To activate this feature, tick the according option in the "General" settings of the VAPS setup dialog:

General

Hide Links between Production Order Lines @ Show Infosymbol on Additional Information

Show Symbol on Comment
Show Symbol on Tool Information

Show Symbol on Personnel Information

0c8

Show Symbol on Qlty Meas. Information

Shortcut to creating additional information

You can directly create and edit additional information by clicking the according item in the context
menu.

Unpin |_
007 - Pin with Capacity blocked

Pin without Capacity Consumption

Show in Sales Order View L

Show in Production Order View 1

Schedule Successors
Apply Routing
Apply alternative Routing

Set Focus -

Remove Focus 1

Change Prod Order Status
Change Started Operation

Change Pinned Operation

Standard MRP Behavior
& Comments

Tool Information

Exclude from MRP

Include into MRP Personnel Information

i/ Show Additional Information H Quality Measure Information
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3.7.8. The tooltip

The tooltip of the VAPS provides further details about an operation and is customizable.

MNo.:

ltem.:

Status:

MNo.:

Prod Order Description:
Last Date Modified:
Quantity:

Required Due Date:
Operation No.:

Setup Time:

Starting Time:
Starting Date:

Ending Time:

Ending Date:
Alternate Routing Set:
Category:

Work Centre:

Machine:

3002

3 Operations Subcontracing in Middle1 Operation Simple Subcontracting
Firm Planned

101034

3 Operations Subcontracing in Middle1 Operation Simple Subcontracting
04/14,/20

20

a1/28/21

20

10

11:50:00 AM

a1/27/21

1:50:00 PM

a1/28/21

Subcontractor 1

3.7.9. The "Standby" resource

The standby resource does not exist in your Dynamics 365 Business Central machine centers. It is a
virtual machine center that we automatically create in every work center. It contains all production
order routing lines/operations that are not yet scheduled from within the VAPS, and hence are just
scheduled by the Business Central scheduling run. The standby resource gets highlighted by a yellow
background (and an infinity symbol next to its name in the table part):

February 2021

Capacities Wi 06 Wik a7
4 Machining
4 Cutting ]
Standby (s 1 1
Cutting #1 v 604 it 4§ 1] iioi0s
Cutting #2 ¥ s i
Curting #3 v
# Drilling 13 101{l:1l:l1l:-35| il 101011 Ao
i ] 1 I donl

Please note that

e the standby resource always is treated as a resource with infinite capacity
e all other machine centers are treated as finite capacity resources )
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3.8.Navigating in the plan

The VAPS offers various options of adjusting the size of your working area and going directly to a
specific position in your plan

3.8.1. Adjust the time scale

Depending on how much detail or summary is required, you can either increase or reduce the time
scale solution by mouse wheel or touch pad.

3.8.2. Show operations of a certain timespan only

Click the according item to show either

e all operations of your current workday
o all operations within a week starting from the current work date
e all operations of a month starting from the current work date

Actions ~~ Fewer options
Edit 5 February 2024
Schedule >
! ﬂJ gt
! = I
en  \jew e i =] B
| g =
. | =
Capacity Management > | =
| 3
Timescale > Fit into View
Calendar > ¥ Scroll to Workdate
View Filter e Scale to > ¥ Work Day
Search > E ¥ Work Week
¥ 10
W Work Month
1 4 | |
3.8.3. Scrolling

The VIS offers the following options for quickly navigating to specific positions in the diagram:

e the common scrolling options by vertical and/or horizontal scrollbar
e dragging the timescale either right or left by mouse
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e scroll directly to the Dynamics 365 Business Central work date by selecting the corresponding
item from the “Actions” menu.

Actions Fewer options
2024
Edit e
Wk 05
Schedule 5 & 26 27 28 29 30
! =
| =
hen  view > ! E
i =]
| =
Capacity Management > |
Timescale > B Fitinto View
Calendar > ¥ Scroll to Workdate Wﬁﬁ'}
Scrolls to th kdate.
View Filter > Scale to | Cro7s to e werkazEte
Search > |
L | i

3.8.4. Navigate within one routing

This function allows you to navigate in your plan easily and quickly, integra especially if you have long
routings with lots of operations. It can be found in the "Navigation" entry of the context menu.

3.8.5. Adjust the width ratio between table and diagram

You can modify the width ratio between the table and the diagram by moving the vertical splitter bar
between them.

3.8.6. Return to default time range

Select "Fit into view" to switch directly to the timescale as defined in the simulation's settings.

3.9.The histogram provides capacity information

A histogram offers visual decision support by showing impending capacity problems. In the VAPS, you
have the option to view histograms of work centers and their associated machine centers. These
histograms allow you to easily identify available capacities, as well as any instances where capacities
have been exceeded, indicated by red markings.

The histogram is a capacity utilization chart:

e The outer (black) line shows you the maximum available capacity per selected aggregation
(derived from the capacity of the underlying machine centers).

e The grey-filled area indicates how much of that available capacity will be utilized by the
current schedule.

e Thered area indicates that, according to the current schedule, you will need more capacity
than what is available on Friday, February 12th.
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February 2021
Wk 06
0§ 07 08

Wk 07

10 11 12

Capacities
4 Drilling 4
2,098 -
1,049 -
0
Standby (co)
Drilling #1 »
Drilling #2 »
» Milling & Turning »

4
1l

107009 101008 | fl#0i00s
[ ] i 101005
101¢ 101008

10101011

1«

mr——

1101018

10100!

101005 1€

By “Actions”-> Capacity Management” -> "Capacity Aggregation” you can select the aggregation that

fits your requirements best.

| Actions ~  Fewer options

Edit
Schedule

B View

Capacity Management >

Timescale

Calendar

View Filter

Search

Change Uptime >
? Change Downtime >
2 Capacity Aggregation > i 8y Second
2 - By Day
? ] By Week
L4
- By Month

3.9.1. Include/exclude standby operations for the load curve

Until version 15 of the VAPS, the workload shown in the histogram was determined by considering
both the scheduled production orders and those on standby, as shown in the picture below:

R R

101062 (410105
101059 (50)

However, we have recognized that our customers have varying preferences. Some require a
histogram that exclusively reflects the current workload, while others prefer to include standby
operations for a comprehensive view, enabling them to identify potential bottlenecks or unrealistic
delivery times. To accommodate these diverse needs, we have introduced a new switch in the VAPS
setup dialog. This allows users to specify whether they want to include standby operations in the

histogram or not.

boyumlid

paGe 44 oF 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

General
Hide Links betwesn P... @ Show Infosymbeol on Additional Information
Include Operations o... m Show Symbol on Co...

Show Symbol on Tool...

Show Symbol on Pers...

I0C8

Show Symbol on Qlty...

This is what our example from above looks like when the operations on standby are excluded from
the load curve:

4. The view color modes

The VAPS offers different views that let you stress different aspects of your plan by defining and
using certain colors for the bars depending on the things you want to highlight. This will help you
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tackle certain challenges and answer certain questions.

4.1.1. How to apply a view color mode

You can apply the view color modes in two ways:

e When creating a new simulation, you can choose the desired mode as the default view color
type from a drop-down list:

Default View Calor

Description Type Invalid Outdated C
Simulation Created on 07,/05/23 12:12 PM Production Order ... O O f
Simulation Created on 07,/05/23 12:13 PM Availability O O f
Simulation Created on 07,/05/23 12:13 PM Availability O O L
Simulation Created on 07,/05/23 12:13 PM Availability O O L
Simulation Created on 26.09.23 11:07 ltem View O OJ L
— | Simulation Created on 10.07.24 14:52 : ltem View A O OJ L
Item View

Machine/Work Centre View
Prod, Order Status

Progress

Availability

Wait Times

Production Crder View
MRP WView

Shop Floor Status
Production Line Assignment
Production Line Sequence

Execution Status
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e |nthe visual schedule, select Actions --> View --> View Color Mode:

MNETRONIC VAPS | Actions
o Edit
Capacities
Schedule
4 Production
4 Turning | Drehen View
Standby (o)
Timescale
CTX400 Calendar
CTX 2500 View Filter

Beta 500
Search

Beta 800
4 Sawing | S3gen
Standby (o)
Saw | Sage
4 Gear Cutting | Verzahnen

Standby (o0)

4 G

Capacity Management

»

View - Visual Advanced Production Scheduler

Fewer options

> B Enable Focus Mode

> |& Disable Focus Mode

> & Show Setup Times

> EO‘.—:-&.';_'.:’ es

> & Show World View

> | [& Hide World Vie
lu\f'iew Color Mode

Other

4 G

B Item View

¥ Machine/Work Centre View

Prod. Order View

88 prod. Order Status View
[l Progress View

[&] Shop Floor Status View
[ad] Execution Status View
%":—; Availability View

%"‘5. Wait Times View

BE MRP View

Active color made: Item View Active view filter: No el ai it e RGN AYT-VE <t EMAD calc. time: 15.08.23 0

| B Production Line Sequence View

Sets the mode to the execution status view.

F

4.1.2. How to change the default colors of a view color mode

The default colors of a view color mode can be specified in the VAPS Color Setup dialog.

4.2.The Item View (color mode)

The Item View helps you to focus on production orders for certain items.

The Item View highlights production orders for items that you want to visually stand out. For that
reason, you can define a default item color in the color setup and item-specific colors on the item

card.

The Item View is useful if you have certain items that require a
specific attention. This could e.g., be items for production orders
that are very time sensitive. Or it could be items where the cost

of material are very high.

Important to know: the item color is applied to an entire production order (line).

4.2.1. Change color for individual items

If, for some reasons, you want to highlight one or more specific items, you can do so by changing
their individual color on the respective item card:
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Item Show more
No. @ ] El Base Unit of Measure |PCS v |
Description |B|cyde | Item Category Code | ~ |
Blocked (ClD] |cmor (VAPS) |#Dcf151 ||
Type | Inventory V|

Example

The below screenshot shows a production schedule with the Item View applied. The following
settings are used:

e Default item color = grey
e |tem color "frame" = blue
e |tem color "rim for mountain bike" = red

January 2021 February 2021
Capacities Wk 05 Wk 06 Wk 07 Wk §
27 ‘ZB 29 30 31 01 02 03 04 05 06 07 08 09 10 11 12 13 14 15
4 Machining I =
» Cutting ’ - G ot L S B |
ol i f |
» Drilling » (1ol 101007 | " T i od | ool ||po1mf1 [ |
10 l | foli @ | i
'z .
» Milling & Turning » f il fo i @ fdod 'ons! [ |
fiporoto | il [ | f |1mo16 I
e T |
) Painting » fior011 Bib{ @ rddfo| flofl@  fiioo2 i i
d filfioos [ |
1081601009 Idi

4.3.The Machine/Work Center View (color mode)

The Machine/Work Center View helps you to focus on production orders for certain items. It
highlights production orders that are processed through certain work or machine centers. For that
reason, you can define a default machine/work center color in the color setup and e.g., machine
center-specific colors on the machine center card.

The Machine/Work Center View is particularly useful if you have
one (or a few) bottleneck resources that require your special
attention. In such a case, you can make them visual stand out with
this view.

Important to know: the machine center color is applied to single
production order routing lines/operations.
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4.1.Change color for an individual Machine/Work Center

If, for some reasons, you want to highlight one or more specific machine/work centers, you can do so

by changing their individual color on the respective machine/work center card:

General

Ne. fi1d ]| - Blocked @
Name Cutting #1 Last Date Modified 9/3/2019
Work Center No. 100 ~ Calor (VAPS)
Search Name CUTTING #1

Example

The below screenshot shows a production schedule with the Machine/Work Center View applied.

The following settings are used:

e Default machine/work center color = by production order status
e Machine center color for machine center "drilling #2" = red

January 2021 February 2021
Capacities Wk 05 Wk 06
29 30 31 2 3

4 Machining
b Cutting » 10ie 10 fileit g fdoioo; § 4
hofl—— ¢ | |
4 Drilling » 101007
Standby (co) .nc" |m. 4101011
1|
b
Drilling #1 » 1070
101
Drilling #2 » \1011
b Milling & Turning » i 1 o i fof Aoroos
1101010 10101 i f 101010
18100
b Painting » 101011 101¢ 10101 1011 101000  {fifiooz
i (il | o008

4.2.The Production Order View (color mode)

i

1017 101
101
101005

1019

limioid

101008

The Production Order View helps you to focus on certain production orders. It highlights production
orders that you want to visually stand out. For that reason, you can define a default production order
color in the color setup and production order-specific colors on the production order card.

The Production Order View is useful to recognize certain
production orders at a glance. This could be the case, e.g., if your
orders are typically both make-to-order as well as make-to-stock.
Then, if things get tight because a deadline approaches and you
need to shift out some order, you might want to shift out your
stock orders, because with them, there is usually more time
flexibility. If you have defined a unique color for your stock
orders you can quickly and easily recognize them.

Important to know: the production order color is applied to an
entire production order (line).
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4.2.1. Change color for an individual production order

If you want to highlight one or more production orders in your plan, because, perhaps, they are

urgent or belong to quite important customers, you can change the color on the Production Order
Card:

General

Ne. @ Due Date 1/28/2021 =B
Description 1 Operation Simple Required Due Date 1/28/2021 i
Description 2 Assigned User ID o
Source Type ltem v Blocked @
Source No. 3000 v Last Date Modified 4/16/2020
Search Description 1 OPERATION SIMPLE Color (VAPS)
Quantity 180

Example

The below screenshot shows a production schedule with the Production Order View applied. The
following settings are used:

e Default production order color = blue
e Production order color for orders no. 101034 and 101036 = red

. ponday, 25. January 20| Tuesday, 26. January 2021 Wemay, 27. January 2021
Capacities
15:00 (18:00 |21:00 | 00:00 | 03:00 | 06:00 | 09:00 | 12:00 |15:00 | 18:00 | 21:00 | 00:00 |03:00 | 06&:00 | 09:00 | 1200 | 15:00 | 18:00 |21:00
»

4 Cutting

Standby (o)

Cutting #1

Cutting #2

Cutting #3 [i01034 | (o036 |
4 Drilling »

Standby (oo)

Drilling #1

4.3.The Production Order Status View (color mode)

The Production Order Status View helps you to quickly see where in your scheduling & execution
process your production orders are. It differentiates production orders by their respective status and
lets you define different colors for the following statuses:

e Planned
e Firm planned
e Released

The Production Order Status View is particularly useful if you want

to quickly see where in your scheduling & execution process your
production orders are.
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Important to know: the production order status color is applied to
an entire production order.

The picture below shows the default colors coming with the VAPS.

Example

The below screenshot shows a production schedule with the Production Order Status View applied
with the default colors coming with the VAPS.

January 2021 February 2021
Capacities Wk 05 Wk 06 Wk 07

27 28 01 02 5] 04 05 06 07 08 09 10 1 12
4 Machining
» Cutting » 1A filof ol fdoloos A @ ¢
| 10 f 401019
101009
» Drilling » 10¢ (101007 flor>>fo1 [ | i0 1010606 {6003 1o
10iC (101007 10100 [ ]] i@
10
» Milling & Turning » it 1 fod i nofl i0100¢ i it e
it 10101 10100 flor 1010 ]1¢
i 101005
» Painting » 101010 101009|10100 ¢4 01¢jfffj 002 o i@ iotooa o
101011 10107 018101008 [N{i01008 jo18d0100 fo
101001
4 Assembly & QA
» Assembly » 1101011 101011 i
) QA » i (oof | ] 1010§ 101
1010} 1 | 101008

4.4.The Progress View (color mode)

The Progress View helps you to quickly see which productions are late. This is both with respect to
production orders that start late and those that finish late. It differentiates production orders by
their lateness and lets you define different colors for the following statuses:

e Progress status missed. It indicates production orders that are planned to finish past a
requested date. Hence, this is the default color that is used if the end date of an operation is
past the required due date.

e Progress status not started. It indicates production orders that should have been started by
now but are not. Hence, this is the default color that is used if the start date of a planned
operation is before the current date/time.

e Progress status OK. It indicates those production orders that neither start nor finish too late.
Hence, this is the default color that is used if none of the above mentioned two colors get
applied.

The Production Order Status View is particularly useful if you
want to quickly see if you are running late.

Important to know: the progress status color is applied to an
entire production order.
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Example

The below screenshot shows a production schedule with the Progress View applied and using the
default colors coming with the VAPS:

February 2021

Capacities Wk 06 Wk 07 Wk 08
06 o7 08 09 10 11 12 13 14 15 16
4 Machining =
b cuting » 000 101005 01
» Drilling » fi fioiots B
[
» Milling & Turning » fiG 01005 W @ 1s |
flo10fill f@not00s | B
161005 [
b Painting » 076610028 01065 D 00s -
J ibroog foiGEe | fibrore [ \
4 Assembly & QA
» Assembly » | flotoos |
flowoos |
» QaA » S 101002 || fio1011 |

4.5.The Shop Floor Status View

The Shop Floor Status View helps you to quickly highlight and recognize deviations between actual
data from the shopfloor and the schedule.

The Shop Floor Status View lets you recognize how incidents that happen
on the shopfloor impact your schedule.

Important to know: the shop floor status color is applied to an entire
production order routing line.

Example

The screenshot below shows a schedule with the Shop Floor Status View applied with the -described
default colors. Please note that this view also comes with a vertical line indicating when the last
“update according to actuals” was made.
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4.6.The Execution Status View (color mode)

The VAPS offers the "Shop Floor Status" color scheme to highlight deviations between the
planned schedule and actual data from the shop floor. To offer even more transparency, we
implemented the "Execution Status" color scheme to give feedback on the operations' status
on the shop floor: "ready to get in progress", "in progress", "finished", operation with
posting issues, and "rest"

The direct predecessors and successors are taken into account
Example

The below screenshot shows a schedule with the Execution Status View applied with the default
colors.

136 (0] m
:
4 |

4.7 The Availability View (color mode)

The Availability View helps you to focus on the material availability of your production orders. It lets
you see which production orders have or don't have the needed material when the first operation is
meant to start.

The Availability is useful to recognize the material availability of
your production orders at a glance.

Important to know: the availability color is applied to an entire
production order (line).
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Example
In the picture below ,the Availability View is applied. The default settings are:

e production orders where the material is available = green
e production orders that are scheduled before the required material is available = red

January 2021
Capacities Wk 05

425 |29

February 2021

4 Machining
4 Cutting »
Standby (e aE N m Ll
o g
o

Cutting #1 -

Cutting #2 L

Cutting #3 B

4.8.The Wait Times View (color mode)

The Wait Times View helps you to recognize bottlenecks quickly and gives you an overview of critical
and uncritical waiting times of operations at the machines.

The idea behind this view: operations might need to wait for other
operations to finish as the other operations have (an implicit) higher
priority.

Important to know: the wait times color is applied to an entire
production order (line).

The below screenshot shows a production schedule with the Wait Times View applied. The default
settings are:

e no waiting times = grey
e waiting times, but the production order finishes in time = orange
e waiting time and part of a late production order = red
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Capacities

4 Machining
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Standby (o)
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4.9.The MRP View (color mode)

The MRP View helps you to quickly differentiate production orders that belong to the VAPS area of
responsibility from those that belong to the MRP area of responsibility.

The MRP view lets you recognize production orders that are not touched
by the planning worksheet since they belong into the VAPS area of

responsibility.

1200 | 00:00

54, 30, Jan 2021} Si, 31, Jan 2021 Mo, 01. Feb 202| Tu, 02. Feb 2021 We, 03. F
0 20 0:0 1200 | 00:00

0000 |1200 |00:00

101012

i Ll

101028

i |

1010¢

Important to know: the MRP color is applied to an entire production order

(line).

101014 (i

10n |

The below screenshot shows a production schedule with the MRP View applied. The orders planned
by the VAPS appear in orange, the ones planned by MRP in blue.

gnualyzom L~ J
Capacities k01 | wko2 Wk 03 Wk 04 Wk 05
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The darker red shows that for this production order you have set an exception to the standard rule

by context menu

EmE

B
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4.10. The Production Line Assignment View

The Production Line Assignment View lets you quickly recognize assignment errors when you work
with production lines.

If you work with production lines, the Production Line Assignment View will visually indicate if there
is a violation of the “line dependency” restriction, such as multiple operations from one production
order switching between lines.

I
4 Line3 >
Standby (co)

Step 1
Step 2 P000041 (36) « P000048 P§
Step 3 P000041 (36)

Step 4

N v Y| v W

4 lined
Standby (c0)
Step 1

Step 2 000041 (16) °

Step 3 P000040 (35)

v v v W

Step 4

er: No view filter active Last EMAD calc. time: 09.05.23 19:10

4.11. The Production Line Sequence View

The Production Line Sequence View lets you quickly recognize sequence errors when you work with
production lines.

If you work with production lines, the Production Line Sequence View will visually indicate if there is
a violation of the “physical dependency” restriction, such as one production order overtaking the
other.

4 Lineva >

Standby ()
Step 1

Step 2

Step 3 P000041 (36)

Step 4 POCZ POG!P000042 (15)

v v v v w

4 Lined
Standby (c0) |
Step 1 P000040; PE

PO00040 (35% PO0004T (16) o [N

P000040 (35)  P00004%

Step 2
Step 3

v v v v

e: Production Line Seq view filter: No view filter active Last EMAD calc 19:10 Last shopfioor update
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5. Setting up the VAPS

5.1.How can | define the default colors?

Define default colors at one central page so that you can quickly apply different color schemes in the
planning board.

The Visual Advanced Production Scheduler allows you to quickly change the coloring in the planning
board. This enables you to focus on different kinds of information at one glance - quicker. Overall, we
support the following color schemes:

e |tem view

e Machine/ work center view

e Production order view

e Production order status view

e Progress view

e Shopfloor status view

e Availability view

e Wait times view

e MRP view

e Production line assignment view
e Production Line Sequence view
e Execution Status view

All these color schemes are based on default colors. You can define them on the "color setup" page,
which you can access from the NETRONIC VAPS menu, or by simply searching for "color setup". The
color setup page looks as follows:
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Color Setup

Actions ~ Automate ~

Default Machine/Wor... #00086ff Setup Time Color #d0d0e1 -

Progress Status

Progress Status Missed #{f0000 Progress Status Ok #04ff00

Progress Status Mot 5. #f9100

Shop Floor Status

Plan Not Changed Co... #20ff20 Quantity Exceeded C... #ffb00
Start Changed Color #8111 Plan Changed Color #ffbd00
Resource Changed C... #{f0000

Execution Status

Ready to get in Progr... #00ee00 Finished Operations #eeeees
In Progress Operations #999999 Rest of Operations #0008ff
MRP Domain

Color when planned .. #0080ff Color when planned ... #ff8000

Production Status

Planned Production ... #66ccff Releasad Order #ffh366

Firm Planned Order #007acc

5.1.1. General information

You can define colors either by their hex value or by clicking the three dots in each color-related line.
This opens a color picker.

All colors that you define here are always only applied to the bars in the planning board. Hence,
these colors are used to determine the color or a production order routing line (operation) in the
planning board.

5.1.2. Specific settings and what they are for

Let's look at all the settings that you can make in more detail.

General
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Default item color: This is relevant for the Item View. This is the color in which every bar is
shown in the Item View. If you want to focus on certain items, you have to define item-
specific colors on the item page.

Default machine/ work center color: This is relevant for the Machine/ Work Center View.
This is the color in which every bar is shown in the Machine/ Work Center View. If you want
to focus on certain machines, you have to define machine-specific colors on the machine
center (or work center) page.

Default production order color: This is the color in which every bar is shown in the
Production Order View. If you want to focus on certain production orders, you have to define
production order-specific colors on the production order page.

Setup time color: The color being used for the small rectangle at the beginning of the bar
that visualizes setup times of an operation.

Progress status

These colors are relevant for the Progress View.

Progress status missed: Indicates production orders that are planned to finish past a
requested date. Hence, this is the default color that is used if the end date of an operation is
past the required due date. The required due date is a new data field provided by the VAPS.
It is fixed and will not be changed by any Business Central scheduling run. The "progress
status missed" color will be applied to all operations of a production order of which a
minimum of one operation ends past the required due date.

Progress status not started: Indicates production orders that should have been started by
now but are not. Hence, this is the default color that is used if the start date of a planned
operation is before the current date/time. The "progress status not started" color will be
applied to all operations of a production order of which a minimum of one operation ends
past the required due date.

Progress status OK: Indicates those production orders that neither start nor finish too late.
Hence, this is the default color that is used if none of the above mentioned two colors get
applied.

Shopfloor Status

These colors are relevant for the Shop Floor Status View

Here you can define the standard colors for deviations from the plan:
e No deviations

e Start date changed

e Changed resource

e Exceeded quantity

e Any other deviations from the plan

Execution Status

These colors are relevant for the Execution Status View. You can specify the default colors for the
operations’ different processing status on the shop floor:

Ready to get in progress
In progress operations
Finished operations

All other operations
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MRP Domain
These colors are relevant for the MRP View.
e Specify the default colors for bars that are planned by MRP or by the VAPS.
Production Status
These colors are relevant for the Production Order Status View.

e Planned order: Defines the color in which all planned production orders are shown.
e Firm planned order: Defines the color in which all firm planned production orders are shown.
e Released order: Defines the color in which all released production orders are shown.

Material Availability
These colors are relevant for the Availability View.

e Material available: Defines the color in which production orders are shown when the
material is available.

e Material not available: Defines the color in which production orders are shown when the
material is not available.

Waiting Times
These colors are relevant for the Wait Times View.

e Due date warning: Defines the color in which production orders are shown that have
operations that need to wait AND the production order runs late.

e Wait time warning: Defines the color in which production orders are shown that have
operations that need to wait, but the production order finishes in time.

e Wait time default: Defines the color in which production orders are shown that have no
waiting times.

Work center
e Subcontract work center color: Defines the default color for subcontract work centers.
Production Line

These colors are relevant for the Production Line Assignment View and the Production Line
Sequence View and are important when you work with production order lines.

Specify the default color for

e No conflict

e Operations that are not assigned to a production line
e QOperations assigned to a wrong production line

e QOperations that are sequenced in the wrong order

5.2.How can | define individual colors for specific items?

Define item colors on the item card. This helps you to make production orders visually stand out in
the "ltem View".
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You can make production orders visually stand out in the Item View. That means you can define
specific colors for specific items that you do not want to be shown in the default item color.

You can do this from the item card. We added a color field to the item header.

You can either type in the color's name:

& ITEM CARD | WORK DATE: 1/28/2021 . -+ T
Process ltem History Special Sales P...ces & Discounts Request Approval Show Attached
Item Show more
No. ‘ 1000 . | Base Unit of Mea... N |
Description ‘ Bicycle | Item Category Co... ‘ N |
Blocked @ - |
Type ‘ Inventory v

Or you can specify and color via color picker if you click the three dots at the end of the color field:

& ITEM CARD | WORK DATE: 1/28/2021

1000 - Bicycle

Process Item History Special Sales P..

COLOUR PICKER

General

Iltem

No. ’ 1000
Description ’ Bicycle
Blocked @ )
Type ‘ Inventory

| e

This populates the color field with the respective hex code (you also can type in the hex code directly

if you know it):
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& ITEM CARD | WORK DATE: 1/28/2021 -+ [i]
1000 - Bicycle

Process [tem History Special Sales P...ces & Discounts Request Approval Show Attached

Item Show more
No. 1000 e Base Unit of Mea... PCS ~
Description Bicycle Item Category Co... ~
Blocked @ Colour #dedela

Type Inventory v

5.3.How can | define individual colors for specific machine centers?

You can make production orders visually stand out in the Machine/ Work Center View. That means
you can define specific colors for specific machine and/or work centers that you do not want to be
shown in the default item color. If an operation is assigned to that machine/work center, it will be

shown in the color you select for it.

You can do this from the machine/ work center card. We added a color field to the machine/work
center header.

e You can either type in the color's name:

& MACHINE CENTER CARD | WORK DATE: 1/28/2021 — Tl
Process Machine Center ~ Show Attached Navigate Fewer options
General
No. 1101 Blocked @
Name Cutting #1 Last Date Modified 5/6/2019
Work Center No. 1100 v Colour red
Search Name CUTTING #1

e Oryou can specify and color via color picker if you click the three dots at the end of the color
field:

boyumﬂ paGe 62 oF 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

MACHINE CENTER CARD | WORK DATE: 1/28/2021

11071 - Cutting #1

Process Machine Center Show Attached
General

No. 1101 1
Name Cutting #1

Work Center No. 1100

Search Name CUTTING #1

COLOUR PICKER

General

This populates the color field with the respective hex code (you also can type in the hex code
directly if you know it):

é

MACHINE CENTER CARD | WORK DATE: 1/28/2021

1101 - Cutting #1

() + w®

Process Machine Center Show Attached Navigate Fewer options
General

No. 1101 Blocked @
Name Cutting #1 Last Date Modified 5/6/2019
Work Center No. 1100 v Colour #ed1010
Search Name CUTTING #1

5.4.How can | define individual colors for specific production orders?

If you want to highlight certain production orders you can define specific colors for specific
production orders that you do not want to be shown in the default item color.

This is done on the production order card where we added a color field to the production order

header.

Specify the color by either
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e Entering the color's name

€ FIRM PLANNED PROD. ORDER | WORK DATE: 1/28/2021

101035 - 3 Operations Subcontracting in Middle as Alternative

Process QOrder ‘ More options

jof

General

No. ‘10‘\035 Quantity ‘ 25‘
Description ‘ 3 Operations Subcontracting in Middle as Alternative | Due Date ‘ 1/28/2021 i ‘
Description 2 ‘ Required Due Date ‘1/28/‘202‘\ = ‘
Source Type ‘ Item Assignad User ID ‘ v ‘
Source No. ‘ 3006 Last Date Modified 4/16/2020

Search Description ‘ 3 OPERATIONS SUBCONTRACTING IN MIDDLE AS ALTEF| Color (VAPS) [purplel ]

e Clicking on
hex code will be entered.
e Typeinthe hex code.

5.5.How to configure tooltips

" in the color field and select the color via color picker - the color's respective

The tooltips of the VAPS provide further information on the following items of your production

schedule:

Machine Center
Froduction Order Line
Operations

5ales Order Status
5ales Order Number
5ales Line ltem Number
Sales Line Item Number
Work Center Group

Work Center

You can specify which information is to be shown in the tooltip of the respective item in the "Tooltip"
dialog - to be reached by clicking "Configurations" in the "Actions” menu of the "VAPS Setup" dialog:
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Mew Actions Fewer options

Configurations
7 Tooltip...
#% Label..

€ Reset all configurations...

TR TUIFTIIRRETON Y AT ATTIFT T %W

In the dialog popping up, you select the item for which you want to customize the tooltip and then
either delete, edit, or add fields and then click the “Edit” item from the “Actions” menu:

u]
o

VIEW - SELECT TOOLTIP

/X

il
o
i

Description

Machine Center
Production Order Line
Operations

Sales Order Status
Sales Order Number
Sales Line ltem Number
Sales Line ltem Number
Work Center Group

Work Center

The dialog “Edit — Define configuration” pops up.

EDIT - DEFINE CONFIGURATION

i
it
N

Production Order Line

Table Name Field Name
Production Order Line Status

Production Order Line Description
Production Order Line Prod. Order No.
Production Order Line Line No.
Production Order Line Starting Date-Time
Production Order Line Ending Date-Time
Production Order Line Due Date
Production Order Line Routing No.
Production Order Line Quantity (Base)

— |Produc1ion Order Line ] Routing Reference No.

Close
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Here you can:

e Add anew field:
either click +NEW or just click in the last row. You can select the desired Dynamics 365 BC

“" ”

data by clicking “...” either for table and field name.

AVAILABELE VALUES /

Value T
= Production Order

Production Order Line

e |Insert a new field:
Select the field above which you want to insert a new one and proceed as described above.
e Delete afield:

Click “*"and select “Delete line”
=% New Line |
. . i
= Delete Line
i
i

M Select More

5.6.How to configure bar labels

You can decide which D365 BC information is to be shown as bar label.
Bar labels are shown on

e operations in the Production View
e operations in the Capacity View

In the picture below, you see the bar label of a production order line in the Sales View, showing

e the production order number
e the number of the production order line
e the quantity

101053 | 10000 | 20
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You can specify which information is to be shown on the bar label of the respective item in the
according dialog to be reached by clicking "Configurations" in the "Actions” menu of the "Setup"

dialog:

Mew | Actions Fewer options

Configurations ~
7 Tooltip...
/% Label..

€3 Reset all configurations...

R TITFETRIRREN AT Y AT ATTITET T W

e Inthe "View - select label" dialog, select the item and/or view for which you want to customize
the bar label - in our case "Production Order Line":

O Search [x:} Open in Excel | More options

i
N
X

VIEW - SELECT LABEL

Description
Operation in Capacity View
Production Order Line

Operation in Sales View

Close

e The “Edit — Define Configuration” dialog pops up:
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O Search  —+ New B# Edit List ii] Delete A Move Up ¥ Move Down [z} Open in Excel
EDIT - DEFINE CONFIGURATION = k2 /‘

Production Order Line

Table Name Field Name
Production Order Line Prod. Order No.
VAPS Format Strings |

Production Order Line Line No.

VAPS Format Strings |

=3 Production Order Line ~] & Quantity (Base)

Close

e Here you can add, insert, edit, and delete fields as well as change their order. You can select the
desired table name and field name from your Dynamics 365 BC data by clicking “...”

O Search bz} Open in Excel

AVAILABLE VALUES /‘

Value t

Machine Center

Production Order

Production Order Line

Production Order Routing Line
= VAPS Format Strings

Work Center
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5.6.1. Formatting the labels
Separate the field contents in the table label by a line break, a blank or other separators by selecting

the according separator from the “VAPS Format Strings” table.

AVAILABELE VALUES

Value
MNew Line
Space

|
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5.7. Configure table texts

You can decide which D365 BC information is to be shown as labels in the table for:

The picture below shows the table text for a production order routing line, containing:

5.7.1.

Machine centers

Production order lines
Production order routing lines
Production orders

Sales order lines

Sales orders

Work centers

Work center groups

the operation number
a blank
the description in brackets

10 (Assembly station #1)

How to proceed

For customizing the table label, proceed as follows:

Click "Configurations" in the "Actions" menu of the "User Setup" dialog:

Available Values JORV

Value
Mew Line

Space
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e Inthe "View - select table text" dialog, select the item for which you want to customize the
table label which, in our case, would be "Production Order Routing Line":

View - Select Table Text 7 X
2 Search EE Open in Excel More options =
Description

Machine Center

Production Order Line
Production Order Routing Line
Production Order

Sales Order Line

Sales Order

Work Center Group

Work Center

The “Edit — Define Configuration” dialog pops up:

Edit - Define Configuration

S0 Search <+ New  EE Edit List il Delete A MoveUp W Move Down  EE Open in Excel

Production Order Routing Line

Table Mame Field Name
Production Order Routing Line Operation No.
VAPS Format Strings Space

— | Production Order Routing Line Description

Here you can add, insert, edit, and delete fields as well as change their order. You can select the

o ”

desired table name and field name from your Dynamics 365 BC data by clicking “...”.

5.7.2. Formatting the text

Separate the field contents by a blank, or by the separators shown below by selecting the according
character from the “VAPS Format Strings” table.
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AVAILABLE VALUES

Value

Space

5.8.How to use flow fields for tooltips, table, and label texts in NETRONIC'S
simulation tables

With certain conditions met, flow fields can also be created directly in NETRONIC's own simulation
tables, and be used for tooltips, bar labels, and table labels.

Important: Please note that only persistent records can be used as the foundation for calculating the
values in the flow field formulas. This means that values resulting from interactive rescheduling in
the planning board are not considered in the calculation. Additionally, there is no event triggered
before the flow field value is calculated, making it impossible to apply a date filter to restrict the
calculation to dynamic values, for example. Therefore, we recommend utilizing this feature only
together with values from standard Business Central tables.

5.9.The “General “settings

General
Hide Links between P... @ Show Infosymbol on Additional Information
Include Operations o... m Show Symbol on Co... m
Progress Calculation ‘ Based on Quantity v Show Symbol on Tool... @
Disable Warehouse A... m Show Symbol on Pers... @
Show Symbol on Qlty... @

e Decide whether you want to see links between production order lines or whether you want
to hide them.
e Choose whether standby operations are to be included in the histogram

e Select whether a progress bar is shown and hether the progress should be calculated based
on the time consumed or the quantity produced. The calculation of the consumed quantity is
derived from the input quantity, allowing consideration for scrap as well.
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Basad on Time

MNone

Based on Time
Based on Quantity

e Specify whether an info symbol will be shown on the according production order routing
lines when additional information was added to this routing lines in BC.

5.10. The “Scheduling” settings in the VAPS

The VAPS offers two semi-automatic scheduling tools, the functions "Add all" and "Fill idle times'
either with or without considering the EMAD. The settings described below make sure that these
functions work properly.

Scheduling Parameters

Consider EMAD Max. Number of Sche... ‘ 3

Consider Queue Time Add all default behavior for linked Production Orders

808

Default for Add unpla... o

D Default for Do not ad... @

Consider Send-Ahead

s

Scheduling Start (rela...

e Consider EMAD: Tick this option, if the EMAD shall also be considered when using "Add all" and
"Fill idle times.
o  With the function "Add all" you can schedule a bunch of production orders in one go.
o The function "Fill Idle Times" helps you to avoid idle times on machine centers and thus
fully use your capacities.

Recommendation: If material availability is crucial for you, switch on this option, so that you
never schedule without having material available.

e Consider queue time: Decide whether the queue time specified in Business Central on the
work/machine center card is to be considered for the scheduling process.

e Consider send-ahead time: Decide whether the send-ahead time specified in Business Central
when defining a routing is to be considered for the scheduling process.

e Scheduling Start: Here you can define the scheduling start for the two functions, starting from
the current work date. This will be indicated in the plan by a blue vertical line.
Recommendation: We recommend to initially set it to "2D" or "3D" to the short-term schedule
as stable as possible.

e Maximal Number of Scheduling Iterations: This option is mostly related to the "Fill idle times"
functions and lets you specify how often the scheduling process shall be carried out. No matter
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which number you have entered here, the process will be stopped, when it brings no more
change to the schedule.
Recommendation: We recommend starting with 5, if this takes too long, reduce to 3. But at least
enter 1 here.

e Add all default behavior for linked Production Orders: With this option you can determine the
default behavior of preceding and succeeding linked production orders when adding them from
standby to the plan.

5.11. How to set the parameters for EMAD calculation

When you want to setup an EMAD (= Earliest Material Availability Date) calculation, you need two
settings:

e Define the "Look ahead window" i.e., specify how far from now (= today) you would like to make
the allocation of component supply to component demand. This is done in the "VAPS Setup":

Material Availability

Look Ahead Window 3M Use Routing Links @
Lo

Exclude None-Inventory ltems

e Define which kind of demand type should get supplied first, second, third etc. This is done in the
"EMAD Demand" dialog under "Manage -> Edit List". Here you can also change the priority

order:
&« EMAD DEMAND PRIORITY | WORK DATE: 1/28/2021 " SAVED D =
O Search - New B Edit List lil Delete B8 Open in Excel Y O=
Priority Document Type t
= 1 Sales Line v

2

Service Line

Job Planning Line

Prod. Order Component
Assembly Component
Transfer Line

5.11.1. Consider EMAD on production order routing line level

Without any further specification, the VAPS calculates the EMAD on production order line level with
no EMAD per operation at all. You can, however, have the VAPS also consider routing links so that
the EMAD can be calculated by the production order routing line which means that a production
order line can be started even when the material for one (or more) operations is not yet available.

This option has to be switched on the VAPS Setup page:
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Material Availability

Look Ahead Window 12W Exclude None-Invent...

Use Routing Links Exclude Blocked Inve...

5.11.2. Exclude item type “non-inventory”

By clicking the according option, you can specify that the item type “non-inventory” is to be excluded
from the EMAD calculation.

Material Availability

Look Ahead Window 12W Exclude None-Invent...

Use Routing Links Exclude Blocked Inve...

5.11.3. Exclude blocked inventory

You can easily and quickly block certain lots from the EMAD calculation. This could become
necessary, e.g., if you have items the material of which is on-site but need a further quality

inspection. Then you could block them from the EMAD calculation, and we would treat them as not
available.

5.11.4. Exclude not fully promised receipt date from automatic functions like Add All

You can exclude production orders without a promised delivery date from the planning with "Add all"
and "Add all incl. alternatives". You can still plan these orders manually per drag and drop. You can
still plan these orders manually per drag and drop

Material Availability

Look Ahead Window 12W Exclude Blocked Inve... m
Use Routing Links D Exclude Mot Fully Pro... Q
Exclude Mone-lnvent... D Include Fully Consum... 0

5.11.5. Include fully consumed items into EMAD calculation

Planners can decide whether to include or exclude fully consumed items into/from the EMAD
calculation by ticking the according option:
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Material Availability

Look Ahead Window 12W Exclude Blocked Inve... o
Use Routing Links o Exclude Mot Fully Pro... @
Exclude None-Invent... o Include Fully Consum... @

5.11.6. Consider EMAD in semi-automatic scheduling

The VAPS offers two semi-automatic scheduling tools, the functions "Add all" and "Fill idle times"
either with or without taking into account the EMAD. The settings below make sure that these
functions work properly. All settings can be found in the scheduling settings of the VAPS Setup:

Scheduling Parameters

Consider EMAD Scheduling Start (relative to Workdate) 1D
Consider Queue Time Max. Number of Scheduling Iterations 3

Consider Send-Ahead

5.11.7. Apply EMAD tolerance to an item

As is commonly known, the EMAD calculation provides a date from which the required quantity of
component demand is available and before which the production order must not start. The newly
implemented EMAD tolerance allows defining the criterion not too narrowly so that, e.g., an order
could already start if only 95% of the required material is available. To be able to do so, we have
enhanced the item card with the respective setting option. When calculating the demand, the
entered value is multiplied by the available quantity.

1001 - Touring Bicycle

Process Item Prices & Discounts Request Approval More options

Item Show more
No. 1001 Show in VIS @ )

Description Touring Bicycle Item Category Code v
Blocked @ Color (VAPS)

Type Inventory v EMAD Tolerance Percentage 5,00
Base Unit of Measure PCS ~ Exclude from EMAD (VAPS) (D)

5.11.8. Consider sub-locations when calculating EMAD

With this feature, we resolve the challenge faced by manufacturing companies that store materials in
multiple locations. Treating different location codes as one tackles the issue of supply shortages at
the production facility by offering a consolidated view of inventory across all relevant locations.
Here’s why this approach works:
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e Unified inventory view: By treating all involved location codes as one, the system views the
combined inventory levels, thus recognizing the overall available supply instead of seeing a
possible shortage at one or two particular locations.

e Elimination of short-notice transfers: The need for short-notice transfer orders is minimized
since the inventory system accounts for the combined stock at all locations. This reduces the
frequency of urgent transfers and the associated disruptions.

e Accurate production scheduling: The VAPS will now schedule production orders based on
the total available inventory, preventing the orders from showing up in red due to perceived
shortages. This ensures a smoother production workflow.

e Improved planning efficiency: With a comprehensive view of inventory, planning and
replenishment processes become more efficient, leading to better stock management and

reduced risk of supply gaps.

We have implemented this in the VAPS by enabling locations to have sub-locations, which is done on

the Location Card:

& Location Card

e
BLUE - Blue Warehouse

+/ Saved I

@ Online Map & Dimensions  ***

TG Complementary Inventory Locations | -

Zones = Bins & Inventory Posting Setup TF Warehouse Employees
General

Code ‘ BLUE | Use As In-Trans
Name ‘ Blue Warehouse |

Address & Contact

Related Specifies linked Compl!

Automate >

Fewer options

Show more

Address

Address ‘ South East Street, 3 |
Address 2 ‘ |
Post Code ‘ B27 4KT e |
City ‘ Birmingham e |

|

Country/Region Code ‘GB

Show on Map

Another dialog appears, where the user can define the needed additional locations:

boyumlid

Contact

Contact
Phone No.
Email

Home Page

|Jeff Smith

| +44-(0)20 8207 4533 ‘
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| €& Complementary EMAD Inventory Locations + Saved o=/
X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder v 2 Y ®
O search  +Mew  BEREditlist  [i] Delete AT
| Main Location t W Complementary Location 1 Basefilter [D Datafilt
Name
i BLUE : v 2
|
Code t Name v
BLUE Blue Warehouse -
GREEN Green Warehouse
OUT. LOG. Qutsourced Logistics
OWN LOG. Own Logistics
RED Red Warehouse
o
+ New Select from full list

When calculating EMAD, the sub-locations are consolidated with the main location, enabling
inventory checks across all defined locations if the demand originates from the main one.

5.11.9. Shortcut to EMAD demand

On the Item card you can directly navigate to the EMAD demand entries.

= Item Card | Work Date: 28.01.2021 - Tii]

1000 - Bicycle
Process [tem Prices & Discounts Request Approval | Actions Related Fewer options
Le] History ~ Item - ﬁg Availability ~ % Purchases 1k Sales - B9 Bill of Materials ~ ™ Warehouse i Service @R

@ Items by Location

No. El ltem Category Code | o |
>

2 Item Availability by

Description Service ltem Group | ~ |

Statistics >
Blocked Automatic Ext. Texts @

TR} EMAD Demand
Type o v Compmnn ltem Mo | |

Show Demand Entries calculated from Earliest Material Availability Date process, I
Base Unit of Measure PCS s | Purchasing Code | s |
Show in VIS @ Color (VAPS) |#0cf1 51 |
Last Date Modified 08.11.2019 EMAD Tolerance Percentage | U,OO|
GTIN | Exclude from EMAD (VAPS) - @)
5.11.10. Run EMAD calculation from Job Queue

With the help of the Business Central job queue, you can schedule certain background jobs for
regular execution. The EMAD calculation, which until now could only be called via the VAPS
(interactively with - depending on the data volume - long calculation times), can now be triggered via
the job queue as soon as the VAPS is installed. Thus, it could be run at night, for example, without
supervision and without the need for someone to log on to the system to start the VAPS.

Setting up the job queue has to be done within Business Central by the administrator
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5.12. Settings for integrating MRP/planning worksheet

Please note, that the concept of MRP/planning worksheet is described in detail in this chapter.
Here, you can:
o enable/disable the MRP/VAPS integration

o define a frozen period relative to the work date, meaning the period in which the VAPS is
responsible and production orders remain untouched by the planning worksheet.

MRP Setup

Enable MRP/VAPS Int... Frozen Period 2W

5.13. How to set up the automatic calculation of the earliest start date

Usually, the fields “Earliest Start Date” on production order, production line, and production order
routing line level have to be filled manually.

We have improved the handling on the production order level so that the “Earliest Start Date” on this
level can be calculated and filled automatically. In particular, customers who often have orders
whose required due date is relatively far in the future will appreciate this functionality.

The settings for this can be found in th area “Earliest Start Date Calculation” Here you can define
which mode of calculation should be used along with the associated custom values:

e None —same behavior as previously
Recommended usage: If the shopfloor can manage the current production order volume,
allowing for immediate ASAP planning without any need to “bench” tasks to align with
the required due date so that storage cost will be minimized.

e Simple Date Formula - will be applied to the “Required Due Date” to fill the Earliest Start
Date.

Recommended usage: If the shop floor must delay production orders to prevent long-
term storage of components or finished items until delivery, AND if the average
production order can be completed within a day or a few days of entering the shop floor
with minimal variation between orders.

e Weighted Production Order Time Demand - encompasses all times (setup time, run time
multiplied by quantity, wait time, and move time) to represent the total raw duration of
the production order. This total is then multiplied by a user-defined factor and
subtracted from the "Required Due Date" in real time (without using work/shift
calendars).

Recommended usage: If the shop floor must delay production orders to prevent long-
term storage of components or finished items until delivery, AND if the average
production order spans several days, albeit with significant variation between

orders. Recommended multiplication factor: on a one-shift Mo-Fr shopfloor, a factor of
8 would give the best results.
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The settings of the VAPS dialog are taken as default. However, users also have the option to
customize settings for individual production orders on the related production order card, which will
overwrite the default settings from the dialog.

VAPS
Color (VAPS)
Selected Earliest Calculati... Inherit from VAFS Setup R
|
Earliest Start Date Formula None
) Simple Date Formula
Weighted Demand Factor Weighted Prod Order Time Demand

This allows users to establish a "one size fits all" setting that applies broadly, while still having the
flexibility to apply unique settings for specific production orders.

The calculation of the Earliest Start Date will be performed:

e whenever a “Refresh Production Order...” is run

e on changing the required due date

e on changing the custom value (date formula or multiplication factor)

e on performing a new action “Recalculate Earliest Start Date” on both the production
order card and production order list as well as in the VAPS setup which the user can
activate

5.14. The “Sales order handling” settings

Decide whether you want to

e keep reservations when production order due dates get shifted

e show the sales order number on the production order line

e automatically update the due date of a connected production order when sales order
dates (Planned Delivery Date, Planned Shipment Date, Shipment Date) are postponed.

Sales Order Handling

Change Sales Lines @ Update the Required ... @
Sales Order on Prod. ... @

For more information, see here.

5.15. The “Appearance” settings

This area offers various setting options that affect the appearance of your plan
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Appearance

Zoom Factori(%e)
Layout

Tocoltip Delay (ms)
Standby Color

Dateline Grid Mode

Here you can:

e Specify a zoom factor in percent.

| ‘H}U‘
|COMPACT v ‘
| 1250‘
|#F3F38399 - ‘
|1.r't|"E'e-kI3-r A ‘

Weekend Coloring

Colorize Weekend
Weekend Color
Bar coloring mode

Hide Status Bar

Asynchronous Time-...

Asynchronous Rende...

Date Line Behavior

@

| #DFFASF |

|Graded £ ‘

Cl)
@
@

|Sh0w on Hover £

e Choose a layout: In the "Compact" layout, the display is reduced as much as possible to
provide a better overview, especially with large plans.

o Standard layout, zoom factor 100 %:

Capacities

anuary 2021
k02

4 Machining

4 Cutting

Standby (o)

Cutting #1

Cutting #2

Cutting #3

4 Drilling

Standby (o)

Drilling #1

Dirilling #7

boyumlid

Scheduling Start

20
20

2n illbn | ]

i

1

pace 81 oF 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

o Compact layout, zoom factor 100 %

4 Machining
4 Cutting
Standby (e2)

Cutting #1
Cutting #2
Cutting #3

4 Drilling
Standby (o)

Drilling #1

Drilling #2

4 Milling & Turning
Standby (o)
Milling #1

Milling #2
Turning #1

Milling & Turning

Scheduling Start

l@

10

30

o Standard view, zoom factor 80 %

Capacities
4 Machining
4 Cutting

Standbry (==}

Cutting #1

Cutting #2

Machine Center
No.: 120
Name: Cutting #2

Woaork Center Name: Cutting

Drilling #1

Drilling #2

4 Milling & Turning

Standby [=a)

Milling #1

Milling £2

Turning #1

Milling & Turning

boyumlid
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e Specify a tooltip delay: give a time in milliseconds after which the tooltip shall appear

Appearance

Zoom Factor(%) 100 Tooltip Delay (ms) 750

Layout STANDARD

e Support of visual connection between timescale and diagram/ planning area
o Select an individual background color and transparency degree for the standby
resource. The procedure for editing the standby color is the same as for the
weekend coloring (please see description there):

Appearance

100 P4 Color Picker 7 X
STANDARD

DBDB0G,

“ Cancel

o Chose a date line grid mode for the vertical separation lines between individually
selectable intervals

Dateline Grid Mode Daily A

None
Weekend Colering Auto

Colorize Weekend Weekly

‘Weekend Color |#9FD7FA ‘

o The "Auto" mode causes the grids to automatically adjust to the resolution of the
time scale resulting from zooming in or out.

METRONIC VAPS Open in Excel Actions  Fewer options

Bm.m.s G W hursciay, 04.

| 1800| 2100

ay, 02. February 2021 Wednesday, ruary 2021

Capacities

00 06:00 | 09:00 | 1200 15:00 | 1800 21:00 | 00

00| 1500| 18.00 | 2100 | 000 20 rm)n‘ 1200 |'..m||

Standby (o0)

Drilling #1 Y |
Drilling #2 Y i
4 Milling & Tuming o

Standy (o)

Milling #1 v

o Make settings for the weekend coloring
= Decide, whether you want to color the weekends individually:

Weekend Coloring

Colorize Weekend m
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o Specify weekend color and transparency by clicking to open the "Color Picker"

Color Picker |

Selected Color

| #9FD7FA

o reset the weekend color to default comfortably and at one click:

Color Picker |

Manage
Actions
Fewer options

~ Show as menu

>
]

> Yo Reset Color to Default...

_Reset color to default.
I |

Selected Color

|#9FD?FA

“ Ca n(el

e Bar colors: Select individual bar color schemes that ensure that the label texts are always

visible.

Colorize Weekend

Weekend Color Solid

Only Allocated Times

s
Graded

Bar coloring mode Graded

The options in detail:

o Graded (default): nonworking times are displayed in a lighter shade of the main
color; in case there are assignments during non-working periods they are drawn in

the main color
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20 3 N 2 0 N A
i

Sch*@ng Start

Schefluling Start

—_

o Only Allocated Times: nonworking times appear with a white background

Scheguling Start

A note on transparency: weekends, standby and calendar grids may overlap and by setting the
transparency the user can determine what should be hidden or what should shine through. For
example, if you want to see the calendar grids or the weekends on the standby resource, you
have to make the standby color translucent accordingly.

e Show/hide the status area below the visual schedule

4 Sawing | Sagen »
Standby (ea)
Saw | Sage »

4 Gear Cutting | Verzahnen 3
Standby (c2)

Active color mode: item View Active view filter: No view filter active Last EMAD calc. time: 06.11.23 15:10

Last shopfloor update: 31.01.24 16:32

e Improve visual responsiveness and performance when navigating big plans by ticking off/on
the options:

o Asynchronous Time-Area Stretching
o Asynchronous Rendering
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e Specify whether the date lines “Required Due Date” and “Earliest Start Date” get visualized
by hovering above and/or by clicking the corresponding operation.

Show on Click

Show on Click and Howver

Asynchronous Time-...

Asynchronous Rende...

Date Line Behavior Show on Howver e

5.16. Show/hide the notifications window

When simulations get outdated or invalidated, e.g., when you add or delete production orders, the
VAPS shows a notification window, informing you about this:

X Simulation is outdated

If you don’t want this notification window to be shown tick the according option in the VAPS Setup
dialog:

Show Notification

Enable Motification

5.17. Define alternative routings/ alternative work/machine centers

You might have work/machines that can do the same job. With the alternate routing sets, you can
define these alternatives. Plus: you can also define production (and setup!) coefficients if some work
/machine centers can run faster than the others.

You can define alternative routings/ alternative work/machine centers on the "alternate routing set"
page, which you can access from the NETRONIC VAPS menu, or by simply searching for "alternate
routing set". The alternate routing set setup page looks as follows:
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< @ + i v Saved o /2

Alternate Routing Set

Related

Header

No. Version No.

Description Blocked

Alternate Routing Lines~

Setup Time

Type Center No. Machine Center Name Multiplier  Run Time Multiplier
= | Work Center ~| 100 Cutting 1 1
Work Center

Machine Center

You then can create a new alternative routing set by clicking the "+" icon which you find at the top of
the page. Then you need to give your routing set a unique number:

« ) + w /
Alternate Routing Set

Show Attached

Header

No. Set#1 - Cuttind Version No. v
Description Blocked @

After that, you can add all those machines and/or work centers to the alternate routing set that can
work as alternative resources within one routing.

However, you not just define the respective alternative resources. In addition to this you can also
define two different types of production coefficients:

e The setup multiplier
e The runtime multiplier
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2 ) + uw VSNED
Alternate Routing Set
Header
Description | Blocked ®

Alternate Routing Lines~~
MACHINE CENTER
NO.
1101
1102
1103

MACHINE CENTER NAME
Cutting #1
Cutting #2
Cutting #3

SETUP TIME
MULTIPLIER

1.00
1.25
0.80

RUN TIME
MULTIPLIER

1.00
0.80
2.00

In the above example, the alternate routing set "SET#1 - CUTTING" determines the following:

1. The machine centers 1101, 1102 and 1103 (cutting #1, cutting #2, and cutting #3) are

alternative machines.

2. The machine center cutting #1 is the reference machine (both setup time multiplier and run

time multiplier equal 1).

3. Cutting #2 takes 25% longer to set-up than cutting #1 but can run 20% faster (only takes 80%

of the run time).

4. Cutting #3 can be set-up 20% faster than cutting #1 but runs 2x longer.

Once you defined an alternate routing set, you can add it to any routing that you have.

boyumlid
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< ROUTING | WORK DATE: 1/28/2021 -+ [ii] / SAVED A
ER Copy Routing... Ml Versions €2 Where-used Show Attached Page Actions Navigate Report Fewer options ¢
General
No 1300 Search Description FRAME
Description Frame Version Nos. '
Type Serial v Active Version
Status Certified v Last Date Modified 7/20/2019
Lines Manage  Operation  Fewer options O

PREVIOUS  NEXT SE
OPERATI OPERATL... OPERATL... ALTERNAT.. DE..
NO. NO. NO. TYPE NO. DESCRIPTION SET SE.. SETUP TIME RUN TIMI
10 : 20 Machine Cent 1101 Cutting #1 SET#1 - CUTT... 60 1
20 10 30 Machine Ce... 1202 Drilling #2 30 1
30 20 40 Machine Ce... 1303 Mill & Turn 120 1
40 30 Work Center 2200 Q&A 0

The above example shows the routing 1300 for the item frame. Operation 10 by default is assigned
to machine center 1101 (cutting #1). However, you see that the "SET#1 - CUTTING" is also defined as
the alternate set.

When you now create a new production order using this routing, and when you then (re)calculate
the production order via the standard Business Central scheduling, the alternate set is added to the
production order routing line of that production order.

Consequently, all alternative machine centers will get highlighted when you drag operation 10 of the
routing in the planning board. Also, when you reassign it from cutting #1 to one of the alternative
machine centers, the setup time multiplier and the runtime multiplier will get taken into account.

6. Integrating with Microsoft Dynamics 365 Business Central

6.1.Integrating with Business Central standard manufacturing

The VAPS integrates with some standard Business Central tables & function:

e  Work/machine centers
e Shop calendars

e Production orders

e Routings
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6.1.1. How does the VAPS integrate with work/machine centers?

In the plan, work center groups, work centers and machine centers are shown as follows:

Capacities
=
4 Machining ‘ Work Center Group ‘ a
s
< cas : :
@
Standby (o) ‘ Machine Center ,Standby resource”, automatically added to each work center ‘ ?‘;
— o
cuir £ =
By double-clicking you can open the according Business Central card:
¥ €& . PROD.ORDER | WORK DATE: 1/28/2021 . Tii] -/ SAVED =

=

101035 - 3 Operations Subcontracting in Middle

as Alternative

Process Order ‘ More options ®
General
MNo. 1(]1(]35 ]El Quantity | 25|
Description | 3 Operations Subcontracting in I'v| Due Date | 1/28/2021 |
Description 2 | | Required Due Date | 1/28/2021 |
Source Type | Item V| Assigned User ID | o |
Source No. | 3006 ' | Last Date Modified 8/12/2020
Search Description | 3 OPERATIONS SUBCONTRACTIN| Color (VAPS) |#*3d00ff [ |
Lines Manage Maore options BT

Item Mo. Due Date Description Starting Date-Time Ending Date-Time Quantity
— 3006 1/28/2021 3 Operations Subcontracting i... 1/26/2021 12:15 ... |1/27/2021 4:00 PM 25
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Shop calendars

In Business Central, the work times come via the work center. This means, that you have to specify a
shop calendar code on the Work Center card and this shop calendar code then defines the work
times/non-work times.

Scheduling
Unit of Measure Code -~~~ | MINUTES M ‘ Shop CalendarCode -+~~~ 1 ~ |
oty | 3 queetme
Efficiency -« - -+ - reeveeeeeieenns | 100 ‘ Queue Time Unit of Meas. Code
Consolidated Calendar ® 2 Two shifts Monday-Friday
+ New Select from full list
|

Please note that you need at least one shop calendar code. If you have multiple work centers with
multiple shifts you need multiple shop calendar codes.

Add capacity to machine center

In addition, you'll have to update the capacity of the machine center. The machine center inherits the
calendar of the work center, but you need to specify this on the machine center card.

CALC. MACHINE CENTER CALENDAR

Options

Starting Date [ 1/1/2021

Ending Date | 12/31/2021

Filter: Machine Center

—+ Filter...

Filter totals by:

=+ Filter...

Schedule... ‘ ‘

The capacity curve

The capacity curve shows the capacity of a work center group. It is calculated by taking the capacity
per day from the shop calendar and multiply it by the number of machine centers.
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February 2021
Capacities
4 Drilling 4
2,098 -
= T N .
0
Standby () l
u
Drilling #1 » 101009] {01008 | |ffd0i00e [1d0 101011 I
Drilling #2 » [} 8010050 i §  fooo)
» Milling & Turning » 101¢ 101008 fie flb100d fic

Add/remove work time

With the VAPS, you can comfortably define variations in capacity for multiple machine/work centers
or entire shifts in one go.

The VAPS lets you

e add/remove work time for multiple machine/work centers in one interaction
e add/remove work time for entire shifts by work shift codes for one or multiple
machine/work centers

Both options can be found under the "Actions" menu entry "Capacity Management"

| Actions ~ Fewer options
Edit 5 f 2024 February 2024
Schedule > -
i g e i
=3 !
en  View > i £ i
| ! = = !
Capacity Management > Change Uptime > Add Additional Uptime > By Date/Time
Timescale > Change Downtime > Edit Additional Uptime By Shift
Calendar > Capacity Aggregation | _
014 101040 (510102210
View Filter > | 0140103810
Search > . ﬁ 01030 (50) ﬂ m m i |

T | oigorczs e [ |foiosetoRiforgiato

In the picture below, downtimes have been added by date/time for two machine centers:
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Add Downtime by Date/Time s X
Downtime

Start Time 08:00:00 End Time 23:00:00

Timeframe

Start Date ‘0:1.03.202«1 i Capacity Type Machine Center v
End Date ‘08.03.2024 i | Capacity No. MO00S0|MODOED

Absent Details

Absent Details Maintenance

This is what the result looks like:

IS,

|
- 4 Gear Cutting | Verzahnen »
Standby (o)

LC 500 »
LC 180 »
Phoenix >

fﬁ | |
.

{ip1782 101185101156 60) Lot

/| i
|
i
i

In the "Edit" dialog, you can change all your up/downtimes:
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Edit - Capacity Absence
O Search E¥EditList  [3 Delete Related Fewer options
Starting Ending Time
Date t Time 1 t Description Capacity
> I 080000 130000  Wartung 1
04.03.2024 16:00:00 23:59:59 Lack of worker 1
05.03.2024 16:00:00 23:59:59 Lack of worker 1
06.03.2024 16:00:00 23:59:59 Lack of worker 1
07.03.2024 16:00:00 23:59:59 Lack of worker 1
08.03.2024 16:00:00 23:59:59 Lack of worker 1
04.0[%}2024 1 08:00:00 23:00:00 Maintenance 1
05.03.2024 08:00:00 23:00:00 Maintenance 1
06.03.2024 08:00:00 23:00:00 Maintenance 1
07.03.2024 08:00:00 23:00:00 Maintenance 1
08.03.2024 08:00:00 23:00:00 Maintenance 1
04.03.2024 08:00:00 23:00:00 Maintenance 1
05.03.2024 08:00:00 23:00:00 Maintenance 1
06.03.2024 08:00:00 23:00:00 Maintenance 1
07.03.2024 08:00:00 23:00:00 Maintenance 1
08.03.2024 08:00:00 23:00:00 Maintenance 1

6.1.2. Production orders

Upd..

No. 1

M00010
MO00040
M00040
MO00040
M00040
M00040
MO0050
M00050
MO0050
M00050
M00050
MO00060
MO00060
MO00060
MO00060
MO00060

N
X

B

Capar
Type

Mac

Mac

Mac
Mac

Production orders are represented in the VAPS by the bars of the single operations. Double-clicking a

bar will open the respective card:
The following production order data are visualized in the plan:

e production order number: displayed on the bars

e starting date/time - when the first operation of the production order starts
e ending date/time - when the last operation of the production order starts

e required due date, a field added by us : symbolized by a vertical line, shown for the

production order just selected

e order in which operations are worked off, coming from the routing - visualized by links
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Required Due Date

e Earliest start date calculation type: the VAPS allows to calculate the earliest start date on
production order level automatically. The default settings being valid for all production
orders are made in the according area in the VAPS setup dialog.

However, users also have the option to customize settings for individual production orders,
which will overwrite the default settings from the dialog.

VAPS
Color (WAPS)
Selected Earliest Calculati... Inherit from VAFPS Setup R
|
Earliest Start Date Formula None

) Simple Date Formula
Weighted Demand Factor Weighted Prod Order Time Demand

Detailed information about the automatic calculation of the earlies start date can be found
here.

6.1.3. Standby resource

The standby resource contains all production order routing lines/operations that are not yet
scheduled from within the VAPS, and hence are just scheduled by the Business Central scheduling
run.
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The standby resource gets highlighted by a yellow background (and an infinity symbol next to its
name in the table part):

February 2021

Capacities Wi 06 Wi 08
4 Matchining
4 Curting ]
Standby (=) T i
Cutting #1 b - it od i i o1 il 101013 :
Cutting #2 b | | o .
Custting #3 b
I Diilling ] - 11}1{I:1l:l1t¢8| 1 1'21':]'1? diogs
i i 1 ! i

You can also get an overview of orders that are not yet scheduled by the VAPS in the simulation data:

Schedu... f
by VAPS  StandBy |

6.2.0utput and consumption postings

Output and consumption postings can be seen as information about the progress of your production
execution. When you post output or consumption on your production order line you basically tell
your system that you started or finished an operation or that you have achieved a certain percentage
of completion.

6.2.1. Fundamentals on output/consumption postings:

e QOutput/consumption postings can happen very often, sometimes, even automatically
e They reflect a constant data updating process
e No impact on an existing simulation:
o The simulation doesn't get outdated
o The simulation doesn't get invalid
e The progress information you see in the visual schedule is about the moment in time when
you created your simulation.
e After posting output/consumption you have to create a new simulation
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6.2.2. The impact of the production order status

e You can only post output and consumption to a released production order
e Any output/consumption posting on a released production order results in showing a
progress bar in the VAPS

6.2.3. Visualization of progress information in the VAPS

For production order routing lines of released production orders, a slim progress bar is displayed
below the actual bar being based on the posted quantity consumption. The color of the progress bar
appears as follows:

e finished: black and grayed out

e still in progress and output/consumption <= originally planned quantity: grey

e still in progress and output/consumption > originally planned quantity: red

Please note, that

e you can only post output and consumption to a released production order
e QOperations that are already in progress, cannot be moved any more
e the percentage of completion is shown in relation to the net working time.

6.2.4. Special case: Posting on an operation that is still on the standby resource

This is a rare case that normally should not happen, but you need to be aware of it.
Important to know

e If you post output/consumption on an operation that is still on the standby resource, this
operation gets automatically moved to the machine center that is specified in the routing
because if an operation is started (what the posting means) it de facto cannot be on the
standby resource any longer.

o If there already is another operation on this specific machine, this could result in an overload
which the planner has to fix manually.

6.3.Integration with MRP/planning worksheet

The VAPS/MRP integration establishes clear rules as to which production orders belong into the VAPS
area of responsibility and hence have to be untouched by the planning worksheet.
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With this functionality we wanted to overcome the constant battle between planning and
scheduling, and the VAPS offers a close cooperation and interweaving between the finite capacity
scheduling (VAPS) and the planning worksheet (MRP).

The VAPS is responsible for the shorter-term finite capacity scheduling, whereas MRP and the
planning worksheet are responsible for the mid-term demand planning. The VAPS/MRP integration
establishes clear rules as to which production orders belong into the VAPS area of responsibility and
hence have to be untouched by the planning worksheet.

We determine this by two parameters:

e Timeframe (we introduce a "frozen period" as a period in which production orders will not
get changed by MRP)
e Production order status

The below chart summarizes these areas of responsibility:

PRODUCTION ORDER STATUS

Released Firm Planned Planned

VAPS

=

“Planning flexibility” i
VAPS i

simulation is published

MRP / planning

=

E and next regenerative wo rksheet

plan is created

=
=

In frozen
period

TIMEFRAME

VAPS MRP / planning MRP / planning

= worksheet worksheet

After frozen
period

6.3.1. Hereis how we implemented this concept in the VAPS:

For the needed settings, we have implemented a corresponding area in the VAPS Setup dialog:

MRP Setup

Enable MRP/VAPS Int... Frozen Pericd 2W

Here, you can

e enable/disable the MRP/VAPS integration

e Define a frozen period relative to the work date, meaning the period in which the VAPS is
responsible and production orders remain untouched by the planning worksheet.

e Select the according options from the enhanced context menu which fits your situation to
allow deviations from standard rules concerning the VAPS/MRP integration:
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O

Unpin

30 o .
Pin with Capacity blocked

A0 Pin without Capacity Consumption

Show in Sales Crder View L

] Schedule Successors
Apply standard Routing

Apply alternative Routing L

' Set Focus

Remove Focus 1

Change Prod Order Status I

Standard MRP Behavior |

Exclude from MRP

Include into MREP i

e Check in the enhanced planning worksheet which production orders are scheduled by VAPS.

Acticn
Warning MNo. Scheduled VAPS Message
1000 Cancel
LS-10PC MNew
L5-10PC MNew
Emergency L5-120 Mew
LS-120 Mew
1 5-150 Mew

e When action messages are carried out, a warning message is given that this might change
production orders that are scheduled by the VAPS.
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Acti.,
Warning No VAPS Message Ref Line No.  Mes Date Due Date Starting Date-Time |

One or mare of the affected orders is already scheduled by VAPS.

Do you want to continue?
;\

e The color scheme "MRP" view helps you to quickly differentiate production orders that
belong to the VAPS area of responsibility from those that belong to the MRP area of
responsibility.

View ~ Timescale - Search ~

@ Enable Focus Mode

@ Disable Focus Mode

@ Show Setup Times

El Hide Setup Times

=) Capacity View

B8 Cales Order View

Il View Color Mode > Bl ltem View

§F Machine/Work Centre View

Prod. Order View

B8 prod. Order Status View

lafl Progress View

FE Availability View

ﬁ% Wait Times View

| = - —

EE MRP View
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The darker red shows that for this production order you have set an exception to the
standard rule by context menu as described above

8 mE B

6.4.Integration with shopfloor data

Customers need and want to update their schedule based on actual data and if unexpected incidents
happen on the shopfloor, they want to quickly see the impact on the schedule. This is exactly what
this functionality offers. For easy and comfortable use, we implemented the following features:

e (Capability to load recent shop floor data (capacity ledger entries) into simulation

e Special color mode “Shop Floor Status View” to highlight deviations between actuals and
schedule. The below screenshot shows the “Shop Floor Status View” with the default
colors applied

a Mo, 29. Jan 202{ Tu, 30. Jan 2024] We, 31. Jan 2024 Th, 01. Feb 2024

Capacities

1
4 Production i 2 St =
4 Turning | Drehen vl | E si |9
Standby (e2) = —! £
| = '!3
H @
a AIE:
i e v
i S|
i o
CTX400 v
CTX 2500 b
Beta 500 b

e Color mode “Execution Status View” to give feedback on the operations' status on the

shop floor: "ready to get in progress"”, "in progress", "finished", and the "rest".
The screenshot below shows the "Execution Status" view with the default colors applied:

60
P4

04TIEOD) |
030f604 |
10880 |

e Option to (automatically) update the schedule based on actuals, either via the "Actions"
menu or via the context menu
o information from capacity ledger entries gets written into the production order
routing lines
e Vertical line indicating when the last “update according to actuals” was made
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NETRONIC VAPS Actions Fewer options

Edit > Load New Shop Floor Data

Capacities

. Schedule . Apply Shop Floor Changes
4 Production |
4 Turning | Drehen  view > Other
Standby ()
CTX400 Capacity Management
CTX 2500 Timescale >
Beta 500 7 g
Calendar > o ',\
Beta 800 o H@ £
4 Sawing | Sigen View Filter > i
Standby (e0) Search :
Saw | Sage g 1111101065 (80) ioi'ﬂ_;i ’(ﬁﬁo'wa @8)

e Button in the status bar that turns yellow, when new warehouse acitvity line or shopfloor
data is available. By clicking this button, users can also initiate these actions in addition to
using the existing “Action” menu entries.

LC 180 » (101005 (50) | 101007 (70) ]
Phosnix o0

4 Milling | Frasen

@ Choose one of the following options:

Standby [oo)

() Load Warehouse Activity Information
R () Load Mew Shopfloor Data

® Load Mew Shopfloor Data and Warehouse Activity Information
TC 229 Brother

Cancel

ALAIVE WA TS, CACUULLH T olalUus

ALUYE VICYY TN .

6.5.Integration of sales orders and production orders

Planners do not want reservations between production orders and sales orders to break if there are
delays in production. Finite Capacity Scheduling Instruments. Instead, they want to quickly
understand which sales orders run late due to material and/or capacity constraints.

To solve these problems, the VAPS offers an (optional) integration of sales orders and production
orders with the following functionalities:

e The automatic shift of sales order expected shipment date in case production orders have to
get shifted

e Reservation between production orders and sales orders is being kept although the
production order due date > original sales order expected shipment date
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e Comprehensive report to see which sales orders have been shifted
shifts

Simulations Alternate Routings ~ Color Setup ~ VAPS Setup  EMAD Demand Priority
Sales Line Changes: ~ All -~ £ search [i] Delete B EditList  B% Sales Order More options
Sales Line
Shift Date-Time v Date-Time Done User Number
05042023 16:46 $0:000016 10000 | 11.02.2024  08.03.2024
I

due to production order

Item No Customer

POO0007 The Cannon Group PLC Jo

This functionality has to be enabled in the "Sales Order Handling" area of the VAPS setup:

Sales Order Handling

@)
@)

Change Sales Lines Update the Required ...

Sales Order on Prod. ...

6.6.Show sales order number on production order line

@

With this function we further expanded the integration of production orders and sales orders,
making the connection shown already on the according production order line card. What is more,

you can also directly open the sales order from here:

<«

Firm Planned Prod. Orders

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder

A Search  + New Manage Home Reports More options
@& Change Status % Update Unit Cost.. [ Statistics

MNo. Description Source No. Routing No. Quantity ~ Starting Date-Time  Ending Date-Time Due Date
101052 Prod 9 - type 5a P000009 P00000S 40  04.03.2024 06:00  07.03.2024 14:00 08.03.2024
101055’ Comp 0 - Prod 000009 - type 4 ~ COMP-P0000... COMP-P000Q... 40  20.02.2024 12:19 21.02.2024 23:06 22.02.2024
101056 Comp 1 - Prod 000009 - type 2~ COMP-P0000... COMP-P000Q... 40  20.02.2024 12:06 21.02.2024 12:01 22.02.2024
101057 Prod 10 - type 1c PO00010 P000010 56  21.02.2024 23:06 29.02.2024 13:52 01.03.2024
101058 Prod 11 - type 1 P000O11 P000011 40 12.03.2024 08:39 14.03.2024 13:59 15.03.2024
101059 Prod 12 - type 7a P000012 P000012 50 19.02.2024 13:19 29.02.2024 08:12 01.03.2024
101062 Prod 13 - type 2¢ P000013 P0O00013 40 08.02.2024 15:41 14.02.2024 10:16 15.02.2024
101064 Prod 14 - type 5d P0O00014 P000014 40  16.02.2024 13:08  01.03.2024 0&:12  02.03.2024
101066 Prod 15 - type 4b P0O00015 P000015 75 21.02.202423:19  04.03.2024 10:57  05.03.2024
101067 Prod 16 - type 3¢ P00CO1& P0O00016 50 11.03.2024 08:00 14.03.2024 10:09 15.03.2024
101068 Prod 17 - type 2f P00C017 P000017 50 13.03.2024 08:00 18.03.2024 14:55 19.03.2024
101069 Prod 18 - type 1 P00C018 P000018 80 26.02.2024 20:29 12.03.2024 15:19 13.03.2024
101070 Prod 18 - type 1 P0O0C018 P000018 120 22.02.2024 20:29 13.03.2024 11:14 14.03.2024
101071 Prod 10 - type 1c PO00010 P000010 60 28.02.2024 22:10 07.03.2024 16:00 08.03.2024
101072 Prod 19 - type 1 P0O00019 P000019 75 27.02.2024 18:45 07.03.2024 16:00 08.03.2024
101073 Prod 20 - type 1 P000020 P000020 50 28.02.2024 13:55 06.03.2024 16:00 07.03.2024
101074 Prod 10 - type 1c P0O00010 P000010 100 27.02.2024 18:50  12.03.2024 16:00  13.03.2024
101075 Prod 19 - type 1 P000019 P000019 80 29.02.2024 21:50  12.03.2024 16:00  13.03.2024
101076 Prod 20 - type 1 P000020 P000020 70 01.03.2024 15:05  12.03.2024 16:00  13.03.2024

boyumlid

Search
Description

Assigned User
D Status

Firm Planned PROD'S - T..
Firm Planned COMPO - P...
Firm Planned COMP 1 -P...
Firm Planned PROD 10 - ...
Firm Planned PROD 11 - ...
Firm Planned PROD 12 - ...
Firm Planned PROD 13 - ...
Firm Planned PROD 14 - ...
Firm Planned PROD 15 - ...
Firm Planned PROD 16 - ...
Firm Planned PROD 17 - ...
Firm Planned PROD 16 - ...
Firm Planned PROD 16 - ...
Firm Planned PROD 10 - ...
Firm Planned PROD 19 - ...
Firm Planned PROD 20 - ...
Firm Planned PROD 10 - ...
Firm Planned PROD 19 - ...

Firm Planned PROD 20 - ...
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This function has also to be activated in the "Sales Order Handling" area of the VAPS setup.

Sales Order Handling

Change Sales Lines @ Update the Required ... @
Sales Order on Prod. ... @

6.7 .Reflect sales department updates in the production schedule

This feature automatically updates the due date of a connected production order when sales order
dates (Planned Delivery Date, Planned Shipment Date, Shipment Date) are postponed. This ensures
that the production schedule accurately reflects updates made by the sales department. Please note
that the new feature only covers situations where sales lines are postponed. If they are moved to an
earlier date, the production orders are not rescheduled automatically, which may result in schedule
conflicts and the removal of reservations. The feature is disabled by default and can be activated in

the VAPS Setup dialog:

Sales Order Handling

Change 5ales Lines @ Update the Required ... @
Sales Order on Prod. ... @ Update the Required Due Date from Sales Order Line
Changes

Specifies if the reguired due date of production orders
should be updated from sales order line shipment date

Show Notification
changes.

Enable Motifications @

Learn more

6.8.Planning per sales orders

Sales orders can have different priorities and planners often like to schedule them en bloc based on
these priorities. This would ensure that the next free capacity is used in the best possible way for the
corresponding sales order.

But, however, what if a sales order consists of, let's say, 40 items that on the other hand lead to 40
production orders? This is where it gets difficult because these 40 production orders are on Standby
with the other production orders.

Two according options in the "Add all" and "Add all incl. alternatives" menus offer to solve this

problem:

boyumﬂ pace 104 or 159



DOCUMENTATION VISUAL ADVANCED PRODUCTION SCHEDULER

Actions ~~ Fewer options
Edit >
Schedule > Add Al > Add All from Standby
N View > Acld All incl. Alternatives > Add All from Selectad Production Orders
Capacity Management > Fill Idle Times Add All from Selected Sales Orders
Timescale > Fill Idle Times incl. Alternatives
Calendar > Tighten Queues

101036 (80)

View Filter > Move to Standby EIN(32) 101047 (100)

101050°(30) 10104840)

Search > Recalculate Current Schedule
» 101048 (7 0) 101(

The options in detail:

o "Add all from selected production orders" shows a list where you can select from all
production orders where at least one operation is still on standby:

Select Production Orders to be Added | 2~ - 7 X

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder b
No. Description ~ Source No. Routing No. Quantity  Starting Date-Time Ending Dat
— 101033 * Prod6 - Type 1a P000006 P000006 70,00 07.02.202409:34 01.03.202
101071 Prod 10 - type 1c P000010 P000010 60,00 28022024 22:10  07.03.202
101072 Prod 19 - type 1 P000019 P000019 7500 27.02.2024 18:45  07.03.202
101073 Prod 20 - type 1 P000020 P000020 50,00 28.02.2024 13:55  06.03.202
101074 Prod 10 - type 1c POO0010 P000010 100,00 27.02.2024 1850  12.03.202
101075 Prod 19 - type 1 P000019 P000019 80,00 29.02.2024 21:50  12.03.202
101076 Prod 20 - type 1 P000020 P000020 70,00 01.03.2024 15:05 12.03.202
101077 Prod 10 - type 1c P000010 P000010 50,00 29.02.2024 17:00  07.03.202
101078 Prod 19 - type 1 P000019 P000019 30,00 04.03.2024 23:00 07.03.202
101082 Prod 21 - type 4d P000021 P000021 2500 12.03.2024 15:55  14.03.202
101083 Prod 5 - Type 2¢ P00000S P00000S 30,00 04.03.2024 19:30  07.03.202
101087 Prod 20 - type 1 P000020 P000020 34,00 15022024 08:11  20.02.202
101066 Prod 15 - type 4b POO0015 P000015 7500 21.02202423:19  04.03.202
101062 Prod 13 - type 2¢ P000013 P000013 40,00 08022024 15:41  14.02.202

4 »
=]

e "Add all from selected sales orders" shows a list where you can select from all sales orders
with an assigned production order where at least one operation is still on Standby:
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Select Sales Orders to be Added

X Reminder: your work date is 31.01.2024

Released
Released

Open

No.

$0-000005
$0-000011
50-000012
$0-000014

g
A Move Up
Use today | C T
¥ Move Down
Requested | .
DE‘IVEI’}’ Date { v ShD“’ as menu
20.02.2024 32789456 Lovaina Contractors
08.03.2024 35122112 Bilabankinn
13.03.2024 41557832 Mabel Scherrer AG
15.03.2024 21245278 Maronegoce

Salesperson
Code

OF
OF
OF
OF

“ Ca“(el

In both dialogs, you can change the order by "Move up" and "Move down".

6.9.Use sales order line information in tooltip, label, and table texts

Tooltip, label, and table texts of production order lines can be equipped with information about
connected sales order lines.

Define Configuration

O Search  —+ New B Edit List

Production Order Line

Table Name

Production Order Line
Production Order Line
Production QOrder Line
Production Order Line

= Production Order Line

boyumlid

i Delete A MoveUp ¥ Move Down

Field Name

Status

Description
Prad. Order No.

Line No.

~
X

3
i

‘ [Connected Sales Lines ‘

NETRONIC VAPS

Actions ~  Fewer options

Sales Orders (read-only)

Wk 03

4 Released
4 50-000002

4 PO000T0| 56
4 101057 [ 10000 | 56

Prod. Order Line

Status: Firm Planned

Description:

Prad. Order No.:

Prod 10 - type 1c
101057

Line No.: 0000

¢ Connected Sales Lines: SO-000002 - 10000 [
— —

bnuar_‘,- 2024

Wk 04 Wk 05

Workdate

Scheduling Start
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7. Finite capacity scheduling instruments

7.1.What is finite capacity scheduling?

The VAPS works with finite capacity scheduling. Finite capacity scheduling means to schedule with
limited capacities:

e |t makes sure that you do NEVER overload a machine center (exception see above under 7.2).
e Any change in the schedule leads to automatic recalculation of the entire schedule.
e This principle is also applied to complex routings:
o serial
o parallel
Dependencies are considered:
o dependencies between operations (of one production order)
o dependencies between production orders (if made from reservations)

7.1.1. Working with infinite capacity on certain work/machine centers

As mentioned above, finite capacity scheduling makes sure that you do NEVER overload a machine
center. However, there are cases, where it could be useful to have work centers/machine centers
with infinity capacity. Some customers have e.g., certain clearly defined bottleneck areas in which it
is imperative to plan with limited capacity and other areas in which it is perfectly possible to plan
with unlimited capacity. Moreover, in cases of orders being late, this feature helps to find out more
easily where the bottleneck is, based on the overload that has occurred (when setting a machine
center to infinite). The according option can be found on the respective work center/machine center
cards.

Scheduling

Unit of Measure Code MINUTES Shop Calendar Code 2

Capacity 4 Queue Time 0
Efficiency 100 Queue Time Unit of Meas. ...

Consolidated Calendar e ) Schedule with Infinite Capa... (@ )

Having activated this setting will be indicated by the == symbol on the respective work/machine
center:

MNETRONIC VAPS Open in Excel Acti

Capacities

4 Milling & Turning (oo} ]
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The behavior on such an "infinite" center is the same as on standby resources and subcontractor
work centers. Operations may overlap without driving out each other. Switching on or off this option
will affect the respective center in all existing simulations but operations having been scheduled
already will not be rescheduled automatically.

7.2.Move operations

Operations can easily be scheduled and rescheduled either interactively by drag & drop or via
context menu considering the rules of finite capacity scheduling.

7.2.1. Change timing of an operation

If you move an operation horizontally along the time scale, you'll change the timing. While moving
the operation, a “phantom” bar will remain at the original place until the mouse gets released.

i
RCIE

-

Consider move and wait times when calculating ending date-times

The scheduling logic of the VAPS is adapted to that of Dynamics Business Central 365 so that also
move and wait times are taken into account for scheduling. In the picture below, operation 30 ends
at 1:00 pm and the following operation 40 starts at 1:30 pm. The tooltip explains the gap: operation
30 has a move time of 30 minutes which isn't visualized at the bar but gets considered for scheduling
and so the ending date-time of operation 30 is calculated as 1:30 pm.
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10 -— 50
\ﬁm 1
1
|
.
e N
Prod. Order Routing Line +40 o
Status: Planned
Operation No.: 30
Prod. Order No.: 101001
Description: Deburr
Starting Date-Time: 01/18/21 11:55 AM
Ending Date-Time: 01/19/21 01:30 PM
Move Time: 30
Wait Time: 0
Previous Cperation No.: 20
Mext Operation No.: 40
Production Order Line Line Mo.: 10000

7.2.2. Change resource of operation

If you move an operation vertically you can change the machine center where the operation is to be
worked upon. While moving the operation, a “phantom” bar will remain at the original place until
the mouse gets released.

E?fmﬂﬂﬂ 15:05:02

R

258/01,/2021 10:05:02

i

7.2.3. Move operations that have already been started

Operations that have already been started, i.e., operations having postings already, can also be
changed interactively. For this, click “Move Pinned/Started Operation” in the context menu:
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, 01. Feb 2024

00:00 Unpin

Pin with Capacity blocked

Pin without Capacity Consumption  F—

Warkdate -

Mavigation >

Scheduling Start

Schedule Successors

Apply Routing

Apply alternative Routing

[

|
- Remove Focus

M - Change Prod Order Status

Apply Shop Floor Changes

Set Focus

Change Duration

Move Pinned/5tarted Operation

| o005 10100€0)  1¢

Standard MRP Behavior
Exclude from MRP
Include inta MRP

Show Additional Informaticn H

The operation gets a red frame and can be moved to another point in time and/or another
machine center. :

o . [
. o I
[ I

In both cases, the following dialog pops up:

How should the input quantity of the changed operation be
handled?

(@ Keep the current input quantity of 80

() Update the input quantity with current postings to 70
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Here you can decide whether you want to schedule the operation at the new date and/or
place with the remaining quantity or virtually start anew with the original quantity. A possible
scenario for this could be that a machine broke down and the already produced items are
defective.

7.3.Change the duration of operations

The duration of operations can be changed interactively. For this, click “Change Duration” in the
context menu:

MNETRONIC VAPS ‘ Actions Fewer options
Ebruary 2024 March 2024
Capacities k 06 | Wk 07

11

Beta 500 » i
Beta 500 » -
4 Sawing | Sigen » é
Standby (c0) = 101
—
Saw | Sage » 5T
4 Gear Cutting | Verzahnen »
Standby (0) I:@ 1010 i
101075 (80)
LC 500 » 101070 (120) 0108
LC 180 »
Phoenix »
4 Milling | Frasen »
Standby (o) oicce ) | LED® (0107360
B 107
Wagner BAZ » .ﬂ 1034 (50) 10100 ﬂ]
TC 229 Brother » 3 10 101033 (70) .]Hu ‘
My very old mill (eff = 20%) »
4 Assembly
4 Assembly - Team 1 » Emsz (50) l 101086 (80) |/101059 (50) it
01034 (S 3
Standby (eo) a H |

7.3.1. Pin operations, production order lines, production orders

If you want to make sure that a certain element doesn't get moved any more by any automatic
scheduling, you can pin (and unpin) it by the according context menu option:
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' I
10 (105
{ Unpin ] E E

| Pinwith Capacity blocked * | Pin Operation with Capacity blocked |
Pin without Capacity Consumption * | pin Prod. Order Line with Capacity blocked
Move to Standby * | Pin Preduction Order with Capacity blocked
Mavigation *

Schedule Successors
| Apply Routing -

Apply alternative Routing

Set Facus

Remove Focus

Change Prod Order Status

| Apply Shop Floor Changes

: Change Duraticn

| Move Pinned/5Started Operation

| Standard MREP Behavior
Exclude from MRP
Include into MRP

i _.!1 NAR(70) 401049 £ 101(

These pinned elements can be seen as being dealt with manually by the scheduler working with the
VAPS

Allow moving of pinned operations

However, in case operations are dealt with manually, some customers need an extra portion of
flexibility as exception from the overall automatic scheduling. This is offered by the above-described
context menu item "Move Pinned/Started Operations" which allows to move a pinned operation
without unpinning it.

The according operation gets a red frame and can now be moved without any restrictions.

This means that it also can get placed manually in a way the automatic scheduler would never place
it. For example, you can drag & drop a pinned operation so that the start date of the successor is
before the end date of the predecessor.
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7.3.2. Move (multiple) operations via dialog

Unpin ]

Pin with Capacity blocked ]

Pin without Capacity Consumption® £

Maove to Standby *

Mavigation »

Schedule Successors I
Apply Routing

Apply alternative Routing

Move Operation(s)

Set Focus

=

Remove Focus

Change Prod Order Status

o
[

Apply Shop Floor Changes

—4
=

Change Duration

Maove Pinned/Started Operation

Standard MRP Behavior l
Exclude from MREP [
Include into MREP

= Show Additional Information » a

With this function, you can move multiple operations individually, rather than as a single block.

By clicking the "Move Operation(s)” item in the context menu, the dialog "Select Production Order
Routing Line(s) to move" will appear, allowing you to precisely choose the desired operation(s) and
even change their order. Following this selection, all further adjustments can be made in the dialog
"Move Production Order Routing Line(s) Settings." Here, you can define parameters such as the new
start date, capacity type, target machine center, and more.
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NETRONIC VAPS Actions v Fewer options

4
bruary 2024 L~ q
Capacities k 06
o7 |o8 |09 |10 1l

4 on " [
4 Turning | Drehen » |
Standby () | i
CTX400 » o

CTX 2500 »

Beta 500 >

Beta 800 >
4 Sawing | Sagen 4
Standby ()

B Unpin

Pin with Capacity blocked >
f Pin without Capacity Consumption>
Saw | Sage > Move to Standby >

Navigation >

4 Gear Cutting | Verzahnen »
Standby (co)

Apply Routing
= v Peos e e o005 2
. i Apply alterative Routing

Schedule Successors

Set Fodtis

Remove Focus

- Change Prod Order Status
Apply Shop Floor Changes

Change Duration
- WMove Pinned/Started Operation
| Standard MRP Behavior
o
~ | includeintoMRP

| Show Additional information > |

— N ——

7.3.3. The underlying principles of drag & drop

e The sequence on a machine can be changed.
e Can have an impact on other machines (as successors might get moved).

e We do not allow you to violate the routing structure (exception: if operations are pinned)

o predecessors will never be impacted
o right move -> successors will get moved
o left move -> successors will not get moved

7.4.Schedule successors

With this instrument you tell the software to give the current production order the highest priority

from here. The function "Schedule successors" can be found in the bar’s context menu:

Pin with Capacity blocked

Pin without Capacity Consumption

Schedule Successors

Apply standard Routing

Apply alternative Routing

Set Focus

Remove Focus

h
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By ticking this item, you schedule all successors of the currently marked operation (if you marked the
first operation of a production order then, of course, the complete production order will get
scheduled).

7.4.1. The underlying principles of “Schedule Successors”

e Changes the timing (start date; hence: end date) of all successors.
e  Will not change the sequence on the machine where it is triggered.
e Has an impact on other machines (as successors will get moved).

e Will not violate the routing structure.

7.5.Apply standard routing

This instrument is meant to help you efficiently bring production orders from the standby resource to
a dedicated machine center.

The function "Apply Standard Routing" can be found in the bar’s context menu:

Unpin
Pin with Capacity blocked

Pin without Capacity Consumption

Schedule Successars

Apply standard Routing

Apply alternative Routing

Set Focus

Remowe Focus

By ticking this item, you add the operations of a production order to the schedule starting at least at
the current work date, or later, if requested by a linked predecessor without changing the schedule
and using the standard machines from the standard Business Central routing.

7.5.1. The underlying principles of "Apply Standard Routing"

e Changes the assigned machine center of the triggering operation and all successors (move
e from standby to a concrete machine center).

e Changes the timing (start date; hence: end date) of all successors.

e Adds this production order to the schedule with the lowest priority.

e Will not change the sequence on any machine.

e Will not violate the routing structure.

7.6.Apply alternative routing

This instrument is meant to help you efficiently bring production orders from the standby resource to
a dedicated machine center simultaneously looking for the best alternatives (i.e., earliest
completion)
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The function "Apply Alternative Routing" can be found in the bar's context menu:

I
Unpin

Fin with Capacity blocked

Pin without Capacity Consumption

Schedule Successors

Apply standard Routing

Apply alternative Routing

Set Focus

Remowve Focus

By ticking this item, you add the operations of a production order to the schedule starting at least at
the current work date, or later, if requested by a linked predecessor, without changing the

schedule but making sure that it will be finished as early as possible. For this, the alternative routing
you have defined will be used.

7.6.1. The underlying principles of "Apply Alternative Routing"

e Changes the assigned machine center of the triggering operation and all successors (move
from standby to a concrete machine center).

e Changes the timing (start date; hence: end date) of all successors.

e Adds this production order with the lowest priority applying an ASAP strategy

e Will not change the sequence on any machine.

e  Will not violate the routing structure.

7.7.Schedule production orders from standby in one go by the "Add all" function

With the function "Add all" you can schedule a bunch of production orders in one go, considering
alternate machine centers, if desired.

Production orders that are not yet scheduled in the VAPS, are shown on the respective standby
resource - a collection, so to say, of production orders that need to be added from the scheduler to
the schedule. With the function "Add all" you can add them to the schedule all at once.
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Actions ~~ Fewer options
Edit 5 February 2024
Schedule P Add All > Add All from Standby

| View > Add All incl. Alternatives > Add All from 5elected Production Orders
Capacity Management > Fill Idle Times Add All from 5Selected 5ales Orders
Timescale > Fill Idle Times incl. Alternatives E
Calendar p Tighten Queues i I
View Filter > Move to Standby L1021 (40) I 10§18 10104 101035 10104 180
Search > Recalculate Current Schedule

107089 TUT023 (48] 10105 1071033 109( 101043

’I i E"I .r"*lliil

Of course, this doesn't happen at random, but follows strict prioritization rules.

7.7.1. How it works

e Based on the assumption that late production orders are to be avoided, the VAPS
automatically creates a prioritized list of the production orders that are on standby,
proceeding as follows:

o calculating a buffer time per production order, following the formula:

o buffer time = [required due date] - [end date of last operation as per BC]

o starting with released production orders, then firm planned, then planned

o within each category, assigning the highest priority to production orders with the
lowest buffer, the next highest to those with the next lower buffer, etc.

e The orders are added to the schedule according to their priority

e The following settings can be made in the VAPS setup:

o define the "schedule start" date
o decide whether you want to take into account EMAD
o specify the number of iterations

7.7.2. More efficiency by planning per sales orders

Sales orders can have different priorities and planners often like to schedule them en bloc based on
these priorities. This would ensure that the next free capacity is used in the best possible way for the
corresponding sales order.

But, however, what if a sales order consists of, let's say, 40 items that on the other hand lead to 40
production orders? This is where it gets difficult because these 40 production orders are on Standby
with the other production orders.

Two according options in the "Add all" and "Add all incl. alternatives" menus offer to solve this
problem:
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Actions ~~ Fewer options
Edit >
Schedule > Add Al > Add All from Standby
N View > Acld All incl. Alternatives > Add All from Selectad Production Orders
Capacity Management > Fill Idle Times Add All from Selected Sales Orders
Timescale > Fill Idle Times incl. Alternatives
Calendar > Tighten Queues - 10036 (30)

View Filter > Move to Standby EIN(32) 101047 (100)
Search > Recalculate Current Schedule 1010g530) 101035990

¥ 101048 (70) 1010

The options in detail:

e "Add all from selected production orders" shows a list where you can select from all
production orders where at least one operation is still on standby:

Select Production Orders to be Added 2 - 7 X
> Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder R
Add All Options
Add unplanned preced... c Do not add unplanned ... @
MNo. Description Source No. Routing No. Quantity  Starting Date-Time Ending [
- 101033 :  Prod 6 - Type 1a PO00006 PO0D0O00& 70,00 07.02.2024 09:34  01.0.3
101071 Prod 10 - type 1c PQ00010 POO0OO10 60,00 28.02.2024 22:10  07.0.
101072 Prod 19 - type 1 PO00019 P0O0D0O0O19 7500 27.02.2024 1845 07.0.
101073 Prod 20 - type 1 PO00020 PO0D0020 50,00 28.02.2024 13:55  06.0.
101074 Prod 10 - type 1c PO00010 POOCO10 100,00 27.02.2024 18:50 12.0.

e "Add all from selected sales orders" shows a list where you can select from all sales orders
with an assigned production order where at least one operation is still on Standby:
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Select Sales Orders to be Added © -+~ - 7 X

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder e

Add All Options

Add unplanned preced... Q Do not add unplanned ... @
Requested Bill-to Salesperson
Status No. Delivery Date Customer No. Bill-to Name Code
- Open :  50-000005 20.02.2024 32789456 Lovaina Contractors OF
Releazed SO-000011 08.03.2024 35122112 Bilabankinn OF
Releazed S0O-000012 13.03.2024 41597832 Mabel Scherrer AG OF
Open SO-000014 15.03.2024 21245278 Maronegaoce QF

In both dialogs, you can change the order by "Move up" and "Move down".

oo

A Move U
Use today | : der

W Move Down

+ Show as menu

7.7.3. Regulate the behavior of preceding and succeeding linked production orders

Two options allow for regulating how preceding and/or succeeding linked production orders are
treated:

e add unplanned preceding production orders first
e do not add unplanned succeeding production orders

These options can be defined as default settings via the VAPS setup:

Scheduling Parameters

Consider EMAD Max. Mumber of Sche... | 3

Add all default behavior for linked Production Orders

Default for Add unpla... m

1D Default for Do not ad... @

Consider Queue Time

808

Consider Send-Ahead

Scheduling Start (rela...
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The overview below lists all possible combinations and their respective effects.

NEVER schedule predecessors/
Max. Number of Scheduling Iterations A|WayS schedule ALL successors

Add all default behavior for linked Production Orders
Upstream prod. orders (“preceding”) do

NOT get scheduled

Downstream prod. orders (“succeeding”)
get scheduled

Always schedule ALL predecessors

Default for Add unplanned preceding ... - (@

Default for Do not add unplanned suc... - (@

Max. Number of Scheduling Iterations

Add all default behavior for linked Production Orders Upstream pI’Od. orders ("preceding") get
, scheduled
Default for Add unplanned preceding ... o " -
Downstream prod. orders (“succeeding”)
Default for Do not add unplanned suc... - (@ ) get scheduled
Max. Number of Scheduling Iterations NEVER schedule successors or
. . ) predecessors
Add all default behavior for linked Production Orders
Default for Add unplanned preceding ... C._\) Upstream prod. orders (”preceding”) do
Default for Do not add unplanned suc.. 0 NOT get scheduled

Downstream prod. orders (“succeeding”)
do NOT get scheduled
NEVER schedule successors

Max. Number of Scheduling Iterations

Add all default behavior for linked Production Orders Upstream prod. orders (”preceding”) get
Default for Add unplanned preceding ... D scheduled
Downstream prod. orders (“succeeding”)

Default for Do not add unplanned suc... D
do NOT get scheduled

However, in the "Add all" dialog, you can also spontaneously determine a deviation from the
standard specifications every time you schedule new production orders via the "add all"
function.
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Select Production Orders to be Added P~

. Reminder: your work date is 31.01.2024

Use today | Change to... | Turn off reminder

Add All Options

Add unplanned precad... m

Do not add unplanned ... @

No. Description Source No. Routing No.

- 101033 Prod 6 - Type 1a PO0000G PO0000G
101071 Prod 10 - type 1c POOGO10 POOGO10
101072 Prod 19 - type 1 POOOO1S POOOO1S
101073 Prod 20 - type 1 PO00020 PO00020
101074 Prod 10 - type 1c PO000T0 PO000TO

machine centers:

| Actions Fewer options
Feb: 2024
Edit > SR
Wk 06
Schedule > Add Al S 3 .
no View > Add All incl. Alternatives >

Capacity Management p Fill Idle Times

Timescale > Fill Idle Times incl. Alternatives
Calendar > Tighten Queues
View Filter p Move to Standby
Search > Recalculate Current Schedule
» I i 0| 'JPI.” oo 01023 48)

[0 05 |06 |07 |08

Quantity

70,00
60,00
75,00
50,00
100,00

Add All from Standby incl. Alternatives

I 100014 107104050 101022 101046 (40)

PN 1021 (40) 101 1018101835 10104 1(80)
01030 (50) 101031 (120) 01037 (50 101043 (S0}

10103 101033 100 101042°(110)

Starting Date-Time
07.02.2024 09:34
28.02.2024 22:10
27.02.2024 18:45
28.02.2024 13:55
27.02.2024 18:50

Ending [
01.0.%
07.0.
07.0.
06.0.
12.0

All procedures described above, also apply when you want to take into account alternate

Add All from Selected Production Orders incl. Alternatives

Add All from Selected 5ales Orders incl. Alternatives

11

7.8.Move unhandled production orders, production order lines, or operations to

standby in one go

The VAPS allows moving unhandled production orders, production order lines, or operations back to

standby in one go.

7.8.1. Definition of “unhandled”

e Unhandled future processes that are to start after the scheduling start date. In case users
have "played around" a lot and then they may realize that they are no longer 100% satisfied
with the plan, this feature helps them to quickly replan starting from a certain date by
moving the operations to standby and then applying the "add all" function.
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e Unhandled past processes, i.e., operations the routing status of which is not “in progress” or
“finished,” meaning operations that should have started before the current work date but
haven't.

1043 (90)
142 (110) 1064 (40) ]

Unpin »

Pin with Capacity blocked * m

i . .
Pin without Capacity Consumption e a

120) o
m| Move to Standby il Move Operation to Standby

Move Prod. Order Line to Standby

|

[

Mavigation ¥

Move Production Crder to Standby
Schedule Successars

Apply Routing

Apply alternative Routing

1030 (50) Set Focus
038 (66) Remaove Focus

B

Change Prod Order Status

Apply Shop Floer Changes

Change Duration

Move Pinned/5tarted Operation

Standard MRF Behavior

@3
g 2
I

Exclude from MRP
Include into MRP

Show Additional Information » o o o o -

7.8.2. Move unhandled operations to Standby per work or machine center

Sometimes planners don’t want to move operations of the whole plan but are focusing just on a
single work or machine center and want a more granular version of this functionality.
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The context menu of the work/machine center in the capacity view offers according options:

sov e ']

4 Gear Cutting | Vpr=ohnon N

Standby (o0) Fill Idle Times on this Work Center

—

Tighten Queue on this Work Center

Move Unhandled Future Operations on this Work Center to Standby

LC 500 Mave Unhandled Past Operations on this Work Center to Standby
LC 180 Maove Operations Without Fully Promised Receipt Dates on this Work Center to Standby
Phoenix Define additional Down Time

4 Milling | Frasen Define additional Up Time

Standby (00} | Edit additional Down Time

Remeove additional Up Time

Sort Order

P —— {
= =
H H
— =

Wagner BAZ
Show operations overlapped in one row

TC 229 Brother

how operations stacked

My very old mill(Eff ="20%) L ! —_— —

=

7.9.Fill idle times

Typically, scheduling with finite capacities, will often lead to idle times on machine centers and of
course, for the sake of efficiency and cost cutting, everybody in planning wants to use their capacities
to the fullest extent possible. The function "Fill idle times" helps to avoid idle times on machine
centers.

7.9.1. How it works

e The VAPS automatically creates a prioritized list of the production orders that are already
assigned to machine centers, following the same strict prioritization rules as in the "Add all"
function.

e All operations are tried to be moved forward to avoid idle times.

e Already scheduled production orders are not getting pushed out (they are only squeezed in).
e The following settings can be made in the VAPS setup
o define the "schedule start" date
o decide whether you want to take into account EMAD
o specify the number of iterations
e When you start the scheduling process under "Actions -> Schedule", click the according
option to determine whether you want to take into account alternate machine centers or
not.
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Schedule View ~ Times

Add All

Add All incl. Alternate MC

1 Fill Idle Times

] Fill Idle Times incl, Alternate MC

7.9.2. Fillidle times on a single work or machine center

If you want to fill the idle times on a certain work/machine center only, select the according item
from the center's context menu.

7.10. Tighten Queues

With this feature you can minimize gaps between operations on a resource by shifting all operations
to the scheduling start position as far as possible. The function differs from "Fill idle times" in that it
does not change the order of the operations. Please note that operations before the scheduling start
will not be affected.

The picture below shows an example with operations before they were tightened:

O | ‘B M ioom R ‘W. oW E e oM 4§

3 i e =@M E®F oW @ME &B
ELN I I @ EPEeW CL] TR Y

And this is how it looks after tightening the operations:

O | :10 <0 Eo :aw <of R Er i s

em | IpE®Ee Gl B R e EER
EN | ) L. IR Y
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You can activate this feature

e for asingle resource via context menu

Cutting #1

Fill Idle Times on this Machine Center
Cutting #2 Tighten Queue on this Machine Center
e Define additional Down Time

Define additional Up Time |

4 Drilling Edit additional Down Time

Remove additional Up Time |
Standby (o0)

Sort Order

Show operations overlapped in one row
ST Show operations stacked

e forall resources by clicking the according item in the "Schedule" menu:

MNETROMIC VAPS Open in Excel Actions Fewer options
Edit -~ Schedule View ~ Timescale ~~ View Filter -
— -
4 Machit
Add All incl. Alternatives
4 Cutti
Fill Idle Times
Stal

Fill Idle Times incl. Alternatives

Tighten Queues

Cut Maove all
Mowve Unhandled Future Operations to Standby

Cut

Move Unhandled Past Operations to Standby

e T | Define additional Down Time |'

7.11. Calculating and working with earliest material availability

The VAPS takes into account the earliest material availability date = EMAD.

7.11.1. Material availability: Fundamentals

Without any further specification, the VAPS calculates the EMAD just on production order line level.
Hence, there is no EMAD per operation at all. You can, however, have the VAPS also consider routing
links so that the EMAD can be calculated by the production order routing line which means that a
production order line can be started even when the material for one (or more) operations is not yet
available. ¢ We calculate a value that we call EMAD = earliest material availability date

7.11.2. Basics of the EMAD calculation

e We create a unique list of component demand day by day
e  We take into account
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Demand from production orders
Demand from sales orders
Demand from transfer lines
Demand from job planning lines
Demand from service lines
o Demand from assembly orders
e Then we create a unique list of component supply day by day
e We take into account

O O O O O

o Supply on inventory

o Supply from purchase orders
o Supply from production orders
o etc.

e Then we allocate component supply to component demand

7.11.3. How we allocate

e First we remove any reservations because reserved components will never get allocated
e Then, day by day, we allocate an available component to a component demand
e You can define the priority which demand to supply first

Example: sales orders first, then production orders, then transfer orders

€ EMAD DEMAND PRIORITY | WORK DATE: 1/28/2021 NOT SAVED 0 o= A2
| o ) —
| M Search -+ New B Edit List Il Delete ﬂﬂ Open in Excel =
Priority Document Type T
1 Sales Line
2 Prod. Order Component
= 3 Sales Line v

Sales Line

Service Line

Job Planning Line

Prod. Order Component
Assembly Component
Transfer Litte

e If there is enough component supply on a certain day, we allocate that supply to the component
line, and have an earliest material availability date for that component.
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Su PP'V Monday Tuesday  Wednesday Thursday Friday
Component 1 100 500 300 50 600

Demand Monday Tuesday Wednesday Thursday Friday
Component 1 50 600 300 250 601

Allocation Monday Tuesday Wednesday Thursday Friday

Component 1 YES (50) NO YES (300) NO NO
EMAD Monday Tuesday Wednesday Thursday Friday
Component 1 Monday none Wednesday none none

7.11.4. Setting the EMAD

A production order typically requires multiple components. If all components are available in the
look ahead window timeframe, each component line gets an EMAD. We take the latest EMAD of all
component lines as the EMAD for the production order. Example:

e Production order 1
o Component 1 - EMAD = December 1
o Component 2 - EMAD = November 20
o Component 3 - EMAD = December 4
e EMAD for production order 1 = December 4

7.11.5. Consider the EMAD on the production order routing line level

Without any further specification, the VAPS calculates the EMAD on production order line level with
no EMAD per operation at all. You can, however, have the VAPS also consider routing links so that
the EMAD can be calculated by the production order routing line which means that a production
order line can be started even when the material for one (or more) operations is not yet available.

Let's assume you have three operations. Let's also assume that this requires a very expensive raw
material, but only at the third. Hence, you want that expensive material to be there only when you
plan that third operation to start. In other words: you can start the first two operations without that
precious raw material available. If you assign that particular raw material to the third operation via a
routing link, you now get EMAD information as follows (on the production order routing line level):

Earliest
Materia

Operation Earliest Start Availability

Ng. t Type No. Description Alternate Routing Set Date Date

— 10 IIlMachine Ce... 110 Drilling | Bohren #1 28.01.2021
20 Machine Ce... |210 Milling | Frase #1 28.01.2021
30 Machine Ce... 410 Welding | SchweiBen #1 16.02.2021
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Per default, after having calculated the EMAD allocation, the VAPS would schedule all three
operations starting after the EMAD of the latest operation. For the sake of clarity, | switched on the
Availability View where you see operations with available material in green, the ones with
unavailable material in red:

MNETRONIC VAPS Open in Excel Actions Fewer options

bruary 2021

Capacities k 06

4 Machining | Fertigung

4 Drilling | Bohren 4
Standby (o)
Drilling | Bohren #1 »
Drilling | Bohren #2 »
4 Milling & Turning | Frasen & Drehen )
Standby (e0)
Milling | Frase #1 » 007, [ 4
Milling | Frése #2 b
Turning | Drehen #1 4
Milling & Turning | Frasen & Drehen b
4 Sawing | Sagen b
Standby (o)
Saw | Sige #1 »
4 Welding | SchweiBen b
Standby (o0)

Welding | SchweiBen #1 » ' l

As stated above, you can instruct the VAPS to consider the routing links. This is done on the VAPS
Setup page:

Material Availability

Look Ahead Window 12W Exclude None-Invent...

Use Routing Links Exclude Blocked Inve...

Further steps needed:

e Create the desired routing link code

= Routing Links | Work Date: 28.01.2021
L Search + New  EREditList  [i] Delete  EE Open in Excel
Code Description
100 Assembling
200 CNC/Axle
300 Inspection
- 999 : EMAD example
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Enter this routing link code on the according routing page and in the BOM

o Routing:

Lines Manage More options
Previ... Next
Operation Oper... Opera... AlternateRou... Routing Link
No. t No. No. Typs Ne. Description Set Code
- 10 20 Machine Ce... 110 Drilling | Bohren #1
20 10 30 Machine Ce... | 210 Milling | Frase #1
30 20 Machine Ce... 410 Welding | Schweifen #1 999
o BOM
Lines Manage  More options B
Type No. Description Quantity per  Unit of Measure Code Serap%  Routing Link Code
- |ltem 70073 Teil 1 - EMAD Routing Link Test 1 PCS 0
Itam 70074 Teil 2 - EMAD Routing Link Test 1 PCS 0
Item 70075 Teil 3 - EMAD Routing Link Test 1 PCS 0
Item 70076 Teil 4 - EMAD Routing Link Test 1 PCs 0 998

As a result, two of your operations start at their earlier EMAD, the last one at its own, later EMAD,
this, of course, saving you time in your production processes.

NETRONIC VAPS

Capacities

4 Machining | Fertigung
4 Drilling | Bohren
Standby (o0)
Drilling | Bohren #1

Drilling | Bohren #2

Standby (o0}
Milling | Frase #1

Milling | Frase #2
Turning | Drehen #1

4 Sawing | Sdgen
Standby (o0)
Saw | Sdge #1
4 Welding | SchweiBen
Standby (o0}
Welding | SchweiBen #1

Open in Excel

4 Milling & Turning | Frasen & Drehen

Milling & Turning | Frasen & Drehen

Actions

-

- v v v

Fewer options

Eﬂuary 2021
k 04

26 (27 |28 |29

Lling Start

L]

February 2021
Wk 05

0072

End of Frozen Perjod
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In the Availability View, the VAPS even provides an optical warning, if you drag an operation to a
point of time that is before its EMAD by showing the according operation in red:

NETRONIC VAPS Open in Excel Actions Fewer options
Rnuary 2021 February 2021
Capacities k 04 Wk 05
26 (27 28 29 30 31 01 02 03 04 10
4 Machining | Fertigung £ E
4 Drilling | Bohren » ‘3\ o
Standby (e0) & 7
Drilling | Bohren #1 » 2 2
g
Drilling | Bohren #2 » o
4 Milling & Turning | Frasen & Drehen » w3
Standby (o0)
Milling | Frése #1 » 0072

Milling | Frase #2

Turning | Drehen #1

Milling & Turning | Frasen & Drehen
4 Sawing | S3gen

Standby (o0)

Saw | Sage #1 > |

4 Welding | Schweiien »
Standby (oo)
Welding | SchweiBen #1 » —ﬂ

Tip: If you work with routing link codes you should define priorities in the dialogs "EMAD demand
priority" and "Routing demand priority".

7.11.6. Exclude items from EMAD calculation

In the current EMAD calculation logic, “all” components of a production order are considered when
calculating the availability date.

With very detailed BOMs and having even low priority material in these BOMs (meaning material
which could be replenished very easily e.g., by a local dealer around the corner), this could create
some downsides:

e material that is out of stock but could easily be replenished might render a production order
as “unable to allocate”

e all these materials need to be calculated, although they won’t be a blocker for the
production process

Because of this, you can exclude certain items from the EMAD calculation by ticking the option
“Exclude from EMAD (VAPS)” on the item card and related pages. You can also exclude complete
item categories from EMAD, by ticking the option on the respective category card. In this case, the
setting is passed on to all associated articles and does not have to be made separately for each
article.
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N
1000 - Bicycle
Process Item Prices & Discounts Request Approval More options
ltem Show more
Ne. |m Show in VJS @ >
Description Bicycle Item Category Code o
Blocked ® ) Caler (VAPS) #911d1d
Type Inventory Exclude from EMAD (VAPS) @
Base Unit of Measure PCS

7.11.7. Consideration of the supplier's delivery date promises in planning

In times of uncertain supply chains, information about material availability has become more and
more important. When parts are ordered, it is important to know whether the supplier has
confirmed a delivery date and what that date is. Production planners need to know for which
production order lines (still to be planned) there are unconfirmed required materials. What is more,
they only want to specifically schedule the production order lines for which the supplier has
confirmed a specific date. We have taken care of these planning requirements and implemented a

new functionality.

The "VAPS Setup" dialog offers a new option that allows to exclude production orders without a
promised delivery date from the planning with "Add all" and "Add all incl. alternatives":

Material Availability

Look Ahead Window
Use Routing Links

Exclude Mone-Invent...

12W

Exclude Blocked Inve...

Exclude Mot Fully Pro...

Include Fully Consum...

Please note that you can still plan these orders manually per drag and drop.

Handling of operations without promised receipt date that are already allocated

In case operations of a production order with missing promised receipt date are already allocated to
resources, they can be made directly visible. For this, we have added a new option to the "Availability
View". Now operations needing material that is not fully promised are shown in orange (default).
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Actions ~ Fewer options
Edit >
Schedule >

] View >

Capacity Management >

Timescale

Calendar

View Filter

Search

ferzahnen

y 2024

@ Enable Focus Mode
@ Disab

@ Show Setup Times

e Foc

iQ Hide Setup Times (50) 10#086 (30) 1010 m
& Hid o 101080150 10104940)

18, View Color Mode > 8 Item View

Use short menu ¥ Machine/Work Centre View

101048)70) 101( .

| B8 5ales Order View | 101 m
- 29 Broduction Order View - 1101101036 (80) 10101048 (70) 10104710804 101

T3

(DL -1§] I Prod. Order View D45 (32'101039)28) 1010§880) 1010/ 103064 (101047

Prod. Order Status View 101044 (50) 1014

100043 (70

! [0 Progress View
" [ Shop Floor Status View

B2 Availability View

5‘5‘,‘ Wait Times View Sets the mode to the availabili ” 101047 (100) 101! 108
B rre view _ 1011048 (70) 10049 (. 101¢

You can change the default color in the VAPS setup:

| Actions ~~
Edit
Schedule

en View

Fewer options

Capacity Management

Timescale

Calendar

View Filter

Search

»

4

>

2024 February 2024 LA~ J
Wk 06
o1 |02 [03°9]64 05 |06 |07 |os |oo |70

Add All

Add All incl. Alternatives >

Fill Idle Times

Scheduling

Fill Idle Times incl. Alternatives

Tighten Queues

1 0 (50101 1046 (40)
Move to Standby > Move Unhandled Future Operations to Standby |
Recalculate Current Schedule Move Unhandled Past Operations to Standby l_

0

Move Operations Without Fully Promised Receipt Dates to Standby

_ [ o el il

The planner can move these operations back to Standby by an according menu item:
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Actions ~~ Fewer options
Febi 2024
Edit > e <
Wk 06
Schedule > Add Al [o4 o5 los [o7 |os o9 [F0 4
en View > Add All incl. Alternatives > =
| - E
=
Capacity Management > Fill Idle Times =
5
Timescale > Fill Idle Times incl. Alternatives
Calendar > Tighten Queues
View Filter > Move to Standby > Move Unhandled Future Operations to Standby |
Search > Recalculate Current Schedule Move Unhandled Past Operations to Standby )_

\ » TOTTUTOT
I u_T Move Operations Without Fully Promised Receipt Dates to Standby =
More options to exclude/include certain items from EMAD calculation can be found on the Setup
page.

7.11.8. Handling of operations with missed EMAD

The picture below shows a production order that is scheduled to start on the 14th (of February)

101044 (60} 1010610111
10104 101047 (100)
107105101045 101036 (80)

101048 (70) 101082 30)

101066 (75

10107107102101010311017 101048 (70) 10711011C

10101021010 101039 (28) 1010303 10710101047 101074

However, when you have a look at the EMAD calculation, you'll see that the earliest availability date
is the 16th.

Earkest

Matedal
Reserved  Manning Unit of Sales Order Sales Ordes Avadlability
Itern No. Starting Date-Time Ending Date-Time Quant.. Quantity  Flexibility Measure Code Ne. LineNo. Date
= P000014 £§ ' 14022024 1840  01.03.2024 08:30 40 40 None PCS SO-000006 10000 16022024

The VAPS provides a helpful feature in the "Schedule" menu that allows you to easily move any
production orders that violate their earliest material availability date back to standby. This ensures
that your production process stays on track and avoids any delays caused by unavailable materials.
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Actions Fewer options
uary 2024
Edit 06
Schedule > Add All
e View > Add All incl. Alternatives i !
1 10 i
Capacity Management > Fill Idle Times " |
e 101044 (60§ 1010610111 o)
Timescale Fill Idle Times incl. Alternatives ' 10104 101047 (100) ;
Calendar Tighten Queues 1010510104¢ 101036 {80)
View Filter Move ta Standby ' Move Unhandled Future Operations to Standby
n
Search Recalculate Current Schedule Move Unhandled Past Operations to Standby
’ 1010°11010:1€1016101031,(120) Move Operations Without Fully Promised Receipt Dates to Standby ﬂ

Verzahnen »

aneleperahons With a Missed EMAD to Standby

7.11.9. Handling of completely picked items

Completely picked (i.e., taken from inventory) items are treated with a higher priority than unpicked
ones

7.11.10. Apply EMAD tolerance to an item

As is commonly known, the EMAD calculation provides a date from which the required quantity of
component demand is available and before which the production order must not start. The newly
implemented EMAD tolerance allows defining the criterion not too narrowly so that, e.g., an order
could already start if only 95% of the required material is available.

To be able to do so, we have enhanced the item card with the respective setting option. When
calculating the demand, the entered value is multiplied by the available quantity.

1001 - Touring Bicycle

Process Item Prices & Discounts Request Approval More options

Item Show more
No. [1001 I[-]  showinvis @
Description ‘Touring Bicycle | Item Category Code | v ‘
Blocked @ Color (VAPS) |
Type ‘ Inventory V| | EMAD Tolerance Percentage | 5,00 ‘|
Base Unit of Measure ‘ PCS v | Exclude from EMAD (VAPS) @

7.11.11. Shortcut to EMAD demand entries

We enhanced the Item card so that you can directly navigate to the EMAD demand entries.
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N
€& Item Card | Work Date: 28.01.2021 (&) + T
NS
1000 - Bicycle
Process ltem Prices & Discounts Request Approval Actions Related Fewer options
Lo History ~ [tem -~ 5’,—“; Availability ~ EZ-} Purchases 1l= Sales - B8 Bill of Materials ~ = Warehouse % Service [ A
@ ltems by Location
No. ses Item Category Code e
B3 ltem Availability by >
Description Service ltem Group o
Statistics > T
Blocked Automatic Ext. Texts @

& EMAD Demand
Type | ey "4 Comman Itam Na
Show Demand Entries calculated from Earliest Material Availability Date process. |

Baze Unit of Measure PCS s Purchasing Cede e
Show in VJS ® Color (VAPS) #0cf151
Last Date Modified 08.11.2019 EMAD Tolerance Percentage 0.00
GTIN Exclude from EMAD (VAPS) -~ @

7.11.12. Run EMAD calculation from Job Queue

With the help of the Business Central job queue, you can schedule certain background jobs for
regular execution. The EMAD calculation, which until now could only be called via the VAPS
(interactively with - depending on the data volume - long calculation times), can now be triggered via
the job queue as soon as the VAPS is installed. Thus, it could be run at night, for example, without
supervision and without the need for someone to log on to the system to start the VAPS.

Setting up the job queue has to be done within Business Central by the administrator.

7.12. Sequence-dependent setup times

Reduce downtimes and operational costs while optimizing resource use with (lightweight) SDST =
Sequence Dependent Setup Times.

With the VAPS, we typically schedule by production order to help customers complete their orders
on time through prioritization methods like “apply all” and “fill idle times.” However, optimizing the
sequence of operations on key machines to reduce setup times can also increase throughput and
reduce late orders. Sequence-dependent setup times (SDST) support this by grouping certain
operations on specific machines to minimize overall setup times.

The SDST function of the VAPS works based on item attributes, so we enhanced the "ltem Attributes"
card accordingly:
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« ltem Attributes

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder

)’3 Search @ Analyze + New [ Edit List MI Delete f Edit ‘S View =“-'E| Iltem Attribute Values Eﬂ}} Translations f}\‘ttribute Dependent Setup Times "~

Name ype Values

=> Color : Option Red,Orange, Yellow,Green,Blue,Violet,Purple,Black, White,
Depth Decimal o
Width Decimal _
Height Decimal _
Material Description Text _
Meadel Year Integer _

Clicking on this button will open the new SDST configuration list for the selected attribute:

ependent Setup Time Configuration List | Work Date: 1/22/2026  Saved 0o »
+ MNew MrEditlist (& Delete ” Edit Exceptions More options e v =
tem Attribute Name Color
Mot Desenpticn Handiing Rule Default Setup Time Same Value Setup Time  Setup Time Unit of Measure
» | COLORI i MikeColor Biggest Only 1500 1000 MINUTES

Meaning of the columns in detail:

e No: Used for identifying and referencing configurations for work and machine centers that
will follow the SDST configuration.

e Description: Provides additional information for users.

e Handling Rule: Can be set to "Additive" or "Biggest Only."

o "Additive" means the regular setup time of the production order routing line, the
default setup time defined in the next column, and either the same value setup time
or special case exception setup time will all be summed up.

o "Biggest Only" will choose the longest setup time from the list.

e Setup Time Unit of Measure: Defines the unit of measure for all setup times on this page or
for the exceptions.

To add special cases for switching between distinct attribute values, click "Edit Exception" on the
action bar or click the "..." in the "No" column.

Dynamics 365 Business Central

<« Attibute Dependent Setup Time Configuration List | Work Date: 1/22/2026

JOIN W -+ New B EditList [i] Delete | £ Edit Exceptions Mare of

ltem Attribute Name

Mo T Description

Mike Color

- | COLOR1 ne

Drill down to record for Mo
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In the Exceptions list, you can define exceptions to the rule when one operation with a certain
attribute value follows another with a different attribute value. Enter the values to check against in
the "from" and "to" columns. Clicking "..." here will give you a list of all attribute values entered in
regular BC so far, including option attributes, number (integer, decimal), and text attributes. You can
also enter values directly via the keyboard. The setup time here follows the same unit of measure
defined in the main SDST configuration for this attribute.

= Attibute Dependent Setup Time Exception List | Work Date: 1/22/2026 1=
L @ | 4+ New BEditList L Y =
Attribute Unit Of Measure
From Attribute Value To Attribute Value Setup Time
Yellow White 15.00
Black White 800.00
5 0.00

After setting up the SDST attributes, you need to assign the resources to which SDST will be applied.
This can be done either

e on the Item Attributes List page:

€ ltem Attributes

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder

O Search (@ ) Analyze -+ New B EditList [i] Delete ¢/ Edit 75 View &H Item Attribute Values % Translations ¢ Attribute Dependent Setup Times
(@] WC/MC Attribute SDST Assoctiation
Name Type Values
. More options
= Color < Option Red.Crange. _ _ N
Depth Decimal _
Width Decimal _
Height Decimal _

or

e onthe MC/WC cards:

& Work Center Card = + Tii]

100 - Assembly department

X Reminder: your work date is 31.01.2024  Use today | Change to... | Turn off reminder

Home Work Center | More opticns

® Load Calendar [ Absence | [ Item Attribute SDST Assoctiation |

-
General Notes +
No. ‘m H:l Search Name |ASSEMBLV DEPARTMENT o
’ Name ‘Assembly department | Blocked Q

Work Center Group Code ‘ 99 w | Last Date Medified 31.10.2022
Alternate Work Center ‘ v | Color (VAPS) |
Posting
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In both cases, a dialog appears where you can define which Item Attribute SDST Configuration should
be applied to which work or machine center. Note that you can set the same configuration for
multiple work and machine centers and set multiple configurations for one work or Machine Center.

= WC/MC Attribute SDST Assoctiation Mot saved D = /
O Search (@ ) Analyze —+ New B¥ EditList [i] Delete e v =
Configuration No. T Type T Wark Center/Machine Center No. T
- COLOR1 Work Center 100

Once the setup is complete, add the relevant attributes and values to items to be used in production
orders. After that, you can load a simulation with the configured data and apply the SDST
Configuration. This will prompt the scheduler to go through the operations and apply the correct
setup times according to their sequence on the resources.

MNETROMNIC VAPS Actions ~  Fewer options
o Edit >
Capacities
Schedule > Add All e
4 Production
SRR view > Add All incl. Alternatives
Standby (o0)
CTX400 (o0} Capacity Management > Fill Idle Times
Timescale ? Fill Idle Times incl. Alternatives
CTX 2500 Calendar > Tighten Queues
PEEELL View Filter > Move to Standby >
Beta 800
Search ? Apply SDST Information
4 Sawing | Sagen 14 - - )
’7 Recalculate Current c,| Apply the SDST information to all aperations, | ’_‘ ’_‘
00 | T

Please note:

e Currently, there is no easy way to see which operation or production order line has which
attributes and values but we are working on a solution. For the time being, we recommend
using item colors.

e Making changes to the SDST Configuration does not automatically update the simulations.
However, clicking "Update Simulation" in an open simulation will load any changes made.

7.13. Resolve conflicts due to overloads or link constraints

It goes without saying that planners want - and need - to work with a schedule free from obvious
conflicts such as sequence conflicts and overloads. On the other hand, due to the complex structure
of Business Central data, production simulations, and updating the simulations with changed
Business Central data, these conflicts cannot be fully avoided.

We solved this problem with the function "Recalculate current schedule":
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NETRONIC VAPS Actions

Capacities Edi
Schedule
4 Production |
4 Turning | Drehen
Standby (eo)

View

Capacity Management

CTX400
CTX 2500 Timescale
Beta 500 Calendar

Beta 800 i i
View Filter

4 Sawing | Sdgen

Standby (o) Search
Saw | Sage

4 Gear Cutting | Verzahnen
Standby (eo)

LC 500
LC 180
Phoenix

4 Milling | Frasen
Standby (o)

Wagner BAZ
TC 229 Brother

This function ensures that

v v v v

i

Fewer options

Sy 2024

11110

'(|'1c1o1-‘1c1'no10103'9“0*'1‘1(101101150(1'20)10
(€1010°101042 (110) " 1010:
66)| 101044071043 (90) "1( (10

= e — v
@ (1011003101034 (4 (1010:4101°1
"~ N i, Py
A1€107 161033 (70 “1011¢d

Add All

Add All incl. Alternatives

Fill Idle Times

Fill Idle Times incl. Alternatives

Tighten Queues

Move Unhandled Future Operations to Standby
Move Unhandled Past Operations to Standby

Recalculate Current Schedule

10 E Resolve conflicts due to overloads o

|
01143 ¢ 101149 (75)

011010101155 (¢

March 2024
Wk 10

TBESEEE 1071

1

10401

@y

.Wkﬂ

101 (o0

il @

e the schedule will be literally "cleaned up" so that there will be no more sequence conflicts

and overloads

e no operation will be pushed to the left - the earliest start date for each operation is the start
date as of the current simulation

It can be very helpful after

e updating the schedule with shopfloor data
e changing the work/machine center capacity settings

8. Simulations

8.1.What is this simulation idea all about?

The Visual Advanced Production Scheduler does not just support one version of the schedule. You

can create multiple simulations and scenarios, then compare them, and then publish the one that

fulfills your purpose best.

Simulations are somewhat a cornerstone of the Visual Advanced Production Scheduler. In essence,

the idea is as follows:

1. You can create a snapshot of the current production schedule.
2. This snapshot is saved as a copy of the production schedule. That way, your Dynamics 365
Business Central database does not get impacted.
3. You then can work with that snapshot (i.e., that copy) and check how certain changes to your
schedule would impact your entire production schedule.

4. You can take as many snapshots as you like. Hence, you can build as many schedule scenarios

as you need.
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6.

If you have a simulation/ scenario that you want to use as a new production schedule going
forward, you can publish it. That way, your Dynamics 365 Business Central database gets
updated.

As long as you do not publish, the Business Central database does not get changed.

Some additional facts that are important to know:

You can view each simulation both in tabular form and as a visual planning board,
You can use the visual schedule to make drag & drop changes to a simulation.
Any change that you do to a simulation gets automatically saved in the simulation table.

8.2.How does the production simulations page work?

We have our own page to manage simulations. It is called "production simulations". Here, you can
create, change and publish simulations.

You can access the "production simulations" page from the NETRONIC VAPS menu, or by simply
searching for "production simulations". The production simulations page looks as follows:

VAPS Demo 3 {s Sales & Purchases Journals Worksheets Product Design Capacities Setup & Extensions NETRONIC VAPS - > =
Simulations: Al O Search  [i] Delete B EditList D EMAD Allocations  [R Create Simulation 53] View Simulation B Update Simulation -+ Y = ® /[
£ Publish Simulation

Description Default View Color Type :fd:?;?ﬂt Inva..  Out.. Creator 2 Compare Simulations Basefilter ID Datafilter ID
ion Created on 13.10.22 19:14 ! Prod. Order Status 36 ADMIN B view simulation Data 1 0
Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN 5 Copy Simulation 1 0
Copy of Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN EE Open in Excel 1 0
Simulation Created on 02.11.22 10:35 Prod. Order Status 37 ADMIN More options 2 1
Simulation Created on 02.11.22 10:36 Prod. Order Status 1 ADMIN 02.11.2022 10:37 2 2
Simulation Created on 02.11.22 10:39 Prod. Order Status 1 ADMIN 02.11.2022 10:39 2 2
Simulation Created on 02.11.22 13:35 Prod. Order Status 1 ADMIN 02.11.2022 13:35 2 2
Simulation Created on 02.11.22 14:28 Prod. Order Status 1 ADMIN 02.11.2022 14:28 2 2
Simulation Created on 03.11.22 16:30 Prod. Order Status 37 ADMIN 03.11.2022 16:31 3 1
Copy of Simulation Created on 02.11.22 14:28 Prod. Order Status 1 ADMIN 07.11.2022 11:27 2 2
Simulation Created on 07.11.22 11:29 Prod. Order Status 1 ADMIN 07.11.2022 11:29 3 2

As you can see, this page consists of certain functions and a specific table. Let's have a look at both
separately.

8.2.1.

Functions of the simulations page

The following functions are available on the "production simulations" page:

Search: The search field starts a dynamic search within the description column of the
simulations overview table below. The list of simulations is automatically adapted while you
type in your search term.

Delete: You can delete the selected simulation. You can also select multiple simulations
(press edit list first) and then delete them in one go. Please note you cannot undo a
deletion..

Edit list: This is standard Dynamics 365 Business Central functionality and allows you to edit
the list below

EMAD Allocations: Opens the EMAD — calculate allocations” page
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8.2.2.

Create a simulation: Create a new simulation that is based on certain criteria such as
timeframe and production order status. Here is more detailed information about how to
create a simulation.

View simulation: Select a simulation in the table below and click "view simulation" to open
the visual schedule in which you can manage your production simulation via drag & drop.
Update simulation: You can update a simulation here or also directly in the planning board.
If you select more than one simulation, all selected simulations will be updated.

Publish simulation: Select a simulation from the table below and publish it. A publish
updates the underlying Dynamics 365 Business Central database. Once published, the
respective simulation is removed from this table on the "production simulations" page.
Compare simulations: You can compare different simulations and decide which one suits you
best.

View simulation data: With "view simulation data" you open a tabular view of all data that
are part of the selected simulation.

Copy simulation: If you want to create a new simulation that has lots of settings in common
with an older one, just copy this simulation.

Filter: Click on the filter icon ?to define and apply a filter to the table below.

Layout options
in form of tiles.

: You can choose whether to show your overview of simulations as list or

Notes ©: by clicking this icon in the menu ribbon, you open a small window where you can
add, edit, and delete notes for a specific simulation to provide additional information.

Content of the simulations overview table

Description: You can name a simulation with any description that you want. You can do this
when you create the simulation. Or you can just click on a table cell in the "description"
column and type in any name for that specific simulation. If you do not give a description on
your own, the VAPS will determine one (like in the above table, where it says, "Simulation
No. 0 on 07/22/19".

Default view color type: Select the color scheme (see separate article on color schemes) that
you want to apply when you view the simulation.

Created on: Date on which this specific simulation was created.

Production order lines count: Number of production orders that are included in this specific
simulation.

Production routing lines count: Number of production order routing lines that are included
in this specific simulation.

8.3.How do | create a new simulation?

We have our own page to manage your simulations. It is called "production simulations". Here, you
can create a simulation by applying various criteria.

You can create as many simulations as you like. Each simulation is a snapshot of your current
schedule, which you then can change via drag & drop in the visual scheduler. We keep each
simulation persistent as long as you either publish or delete it.
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You can create a new simulation on the "production simulations" page, which you can access from
the NETRONIC VAPS menu, or by simply searching for "production simulations". The production
simulations page looks as follows:

Simulations:  All ~ \ O Search il Delete  BREditList (3 EMAD Allocations [y Create Simulation 0] View Simulation BB Update Simulation -+ Y =0 /720
Show
Bas...
Production Filter
Description Default View Color Type Order Count  Inva..  Out. Creator Created On 't Dial... Basefilter ID) Datafilter ID
Simulation Created on 13.10.22 19:14 Prod. Order Status 36 ADMIN 13.10.2022 19:14 1 0
Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN 13.10.2022 20:18 1 0
Copy of Simulation Created on 13.10.22 20:18 Prod. Order Status 36 ADMIN 27.10.2022 17:55 1 0
Simulation Created on 02.11.22 10:35 Prod. Order Status 37 ADMIN 02.11.2022 10:36 2 1
Simulation Created on 02.11.22 10:36 Prod. Order Status 1 ADMIN 02.11.2022 10:37 2 2
Simulation Created on 02.11.22 10:39 Prod. Order Status 1 ADMIN 02.11.2022 10:39 2 2
B n H H " .
If you click "create simulation", a new page opens:
Create Simulation 2~ X
Use default values from ‘ Last used options and filters s ‘
Filters
Description ‘ Simulation Created on 15.11.22 15:44 ‘
Minimum Status ‘ Planned V‘
Earliest/Latest Date Input Type ‘ Relative Date V‘
Earliest Date Formula ‘ -1wW ‘
Latest Date Formula ‘ ow ‘
Earliest Date 21.01.2021
Latest Date 08.04.2021
Default View Color Type ‘ Prod. Order Status hd ‘
Data Filter
No. ‘ 2 v ‘
Name One prod order
o

With this page, you define - in the filters section - certain criteria that should get applied for your
simulation.

By clicking OK, a new simulation is created.

In case of inconsistent data, a warning message pops up:

G) Production Order No. 101087 has no Resource On Operation No.

el
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8.3.1.

The Filter settings

Minimum status: Define which status the production orders included in the simulation shall
have. Minimum status "planned" as in the picture above means that this simulation includes
all production orders with the status planned, firm planned and released.

Minimum Status Planned b

Earliest/Latest Date Input Type Firm Elannad

Released

Enrlinct Dintn Crrmanla 1

Time range for the simulation: In the time fields relating to earliest/latest date you can
specify either absolute or relative data.

We recommend working with relative date settings.

Please note that if you select "relative date", the absolute date fields get updated
automatically!

. Earliest/Latest Date Input Type Relative Date b

3 Absolute Date
* Earliest Date Formula Relative Date

Absolute time range: If you select "Absolute Date", you enter the desired dates in the
according fields:

Earliest Date 1/20/2021

Latest Date 6/30/2021

In the picture above, the simulation (remember this is the snapshot of your overall schedule that you
then want to work with) includes all production orders with the minimum production order status
"planned that start on or after 20 January 2021 and finish on or before 30 June 2021.

Relative time range: If you select "Relative date", you have to enter an according data
formula. In the picture below, we look four days back and three months into the future:

Earliest Date Formula -40

Latest Date Formula M
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e Default view color type: Select the default color type for this simulation

Default View Color Type Pred. Order Status hd

Item View

Machine/Work Centre View
Progress

Availability

Wait Times

Production Order View

MRP View

Data Filter

No.

Mame

e Data filter
The settings in this area allow you to load only data that you really need (e.g., if you only
need to work with data from your department). This means that these filter settings work as
a Dynamics 365 BC data filter on loading the data into the simulation. Data filters are already
effective at the data interface to make sure that only filtered data are handed over from
Dynamics 365 BC to the VAPS. You create and edit filters as is described below under “Base
view filter.”
Read more about using data filters in this chapter

VAPS Data Filter 7 X

Filter: Work Center Group

* Code |E v|

* Name | |

-+ Filter...

Filter totals by:

-+ Filter...

Filter: Work Center

* No. | v|

* Mame | |

-+ Filter...

“ Ca " (el

e Base view filter
A base view filter is assigned to a simulation. This means that by opening the according
simulation, the settings of the base filter come into play in addition to the data filter, but in
contrast to the data filter, the data filtered out by the base filter are nevertheless taken into
account for the planning. Please note that the settings of the base filter cannot be changed
while the simulation is running.
A base filter can be created directly upon creating a new simulation or via the simulations

page

Decide whether the base view filter dialog pops up at the start of the simulation
Select an existing filter from the drop drown list

Create a new one by clicking "Select from full list". For details, please see the
description below on "How to define regularly used filters".
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BaseView Filter

Show BaseView Filter Dialog on Start

No.

Name

Filter: Production Order

* No.

No.T  Name
> 1 Show All
2 Machining
+ New Select from full list

8.3.2. How to define regularly used base view and production order filters

If you have filters that you want to apply multiple times, it makes sense to define them once. In order
to do so, click the downward-facing triangle in the dropdown menu under "saved settings" and then

click "select from full list".

EDIT - CREATE SIMULATION

Saved Settings

4

Data

Use default values from:

Filters

Changes to the options and filters below will be saved only to: 'Last used options and filters' )ER LINES

v/ SAVED

\

PROD. ROUTING L

Minimum Status

[ E

O Search B Edit List li] Delete

SELECT - REPORT SETTINGS

NAME

Last used options and filter:

Released March

COUNT Cl
Last used options and filters v ‘ -
NAME
Last used options and filters!
Released March
Select from full list
A new page opens, from where you can manage (i.e., create, edit, and delete) all your filters:
¥ New @ Copy Show Attached [x:] Open in Excel
SH...
WITH
REPORT ID ASSIGNED ALL  COMPANY NAME
¥ REPORT NAME oY CREATED BY us.. 4
5526150 Create Simulation ADMIN ADMIN CRONUS Internati...
5526150  Create Simulation ADMIN ADMIN CRONUS Internati...

Cancel
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When you click "new", you can create a new filter with certain criteria. Here is how the "Released
March" filter was defined:

EDIT - CREATE SIMULATION I/I
Filters

Minimum Status Released v
Earliest Date 3/1/2021
Latest Date 3/31/2021

Once defined, you can also apply this filter if you create a new simulation:

EDIT - CREATE SIMULATION I/'

Saved Settings

Changes to the options and filters below will be saved only to: 'Last used options and filters'

Use default values from: Released March N

Filters

Minimum Status Released v

Earliest Date 3/1/2021

Latest Date 3/31/2021
OK Cancel
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8.4.How changes to a simulation are managed

While working in a simulation, multiple changes can happen that are treated in different ways

8.4.1. General changes to production orders

General changes to production orders while there are simulations (opened or not opened) that do
not include these production orders are

e add new production orders
e delete production orders
e change "general" production order data, like

o duedate

o required due date

o color

o quantity

o setup time for one routing line etc.

Effects of general changes

e the simulation gets outdated
e you get a notification if this happens while a simulation is open
e you can directly update the simulation
Edit ~~ Schedule ~ View
Undo
! 5 Redo
| E Update Simulation
Schedule successors
Apply standard Routing

Apply alternative Routing

X Exit discarding changes
Cutting #2

8.4.2. A specific change to a production order: the status change

Changing the production order status can lead to a change of the production order ID, this making
the handling of simulations rather tough.
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Impacts of changing the production order status

e If you change the production order status from within the VAPS, we will seamlessly update
the open (and all other simulations)
e If you change the production order status from another session/as another user
o all not opened simulations get silently updated
o in the open simulation: if you made a schedule change to the production order and
somebody else changed the status while you did so, you will not be able to save your
changes because the production order ID got changed.

8.4.3. A change to the production order routing line status

Changes to the production order routing line status can happen if

e somebody starts posting output/consumption on an operation from a released production
order

e somebody finishes an operation from a released production order
Impacts of changing the production order routing line status

e the simulation silently updates

8.5.Compare simulations

With version 1.3 of the VAPS we introduced a (first) set of KPIs so that you can compare different
simulations and decide which suits you best.

Click "Compare Simulations" on the simulations page:

E] View Simulation Data

== Compare Simulatiu:!;]i’fj

Creater
HE Open in Excel
B/30/

Actions
&/30/

6/30/, Fewer options

The “Simulations KPI1” pages opens up:
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“— ( j\- 4 [l ./ SAVED = S
Simulations KPI

4l Previous Set > Next Set =% Refresh KPls e Setup

Options

Show Code (. ) Last Update Date-Time 9/30/2020 2:34 PM

Simulation KPI Matrix Manage =1

Ne. Ops. on Neo. Late Prod ot;
Description MNo. Prod. Orders Standby Orders

= Simulation Created on 07/06,/20 02:45 PM

Simulation Created on 09/15/20 11:22 AM

Simulation Created on 09/17,/20 11:40 AM

R I IR |

Simulation Created on 09/30,/20 02:34 PM 2

—
B
P

Simulation Created on 09/30/20 02:35 PM

This page shows the following KPIs per simulation:

e Number of production orders

e Number of operations on standby

e Number of late production orders

e Total delay (hours)

e Total setup time

e Total buffer time (time between end of production order and required due date)
e Number of production orders without required due date

On the "Simulations KPI" page you can

o refresh the KPIs: if you have added a new simulation, the KPIs of this simulation remain
empty until you have refreshed them

e call the "KPI Setup" dialog, where you can exclude/include outdated simulations from/in your
comparison

e call another dialog via Setup-->Navigate-->Measures where you can administrate your KPIs
(delete, hide, change order)
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€ SIMULATION KPI MEASURES | WORK DATE: 1/28/2021 -~ SAVED =
O Search - New  BREditlist [i| Delete @8 Open in Excel Y =
Show in
Code T Description Caption Seguence Martrix
> ! Number of Late Production Orders No. Late Prod. Orders 3
NOUD.ATE Number of Prod. Orders missing ... No. Prod. Orders Missing Due Date 8
NUMPRODORD Number of Production Orders No. Prod. Orders 1
STANDBYOPS MNumber of Standby Operations Mo, Ops. on Standby 2
TOTALBUFFER Total Buffer Time Total Buffer Time (hours) 7
TOTALDELAY Total Hours Delay Total Delay (hours) 4
TOTALSETUP Total Setup Time Total Setup Time (hours) 6

8.6.How do | publish a simulation?

We have our own page to manage your simulations. It is called "production simulations". From here,
you can publish a simulation. "Publish" means that we update the underlying Dynamics 365 Business
Central database.

You can publish a simulation from the "production simulations" page, which you can access from the
NETRONIC VAPS menu, or by simply searching for "production simulations". The production
simulations page looks as follows:

& PRODUCTION SIMULATIONS | WORK DATE: 1/28/2021 ~/ SAVED A4
p Search @ Edit List T Delete [® Create Simulation % Publish Simulation 5l view Simulation 5] View Simulation Data  --+ Y =
DEFAULT VIEW PROD. ORDER LINES PROD. ROUTING LINES
DESCRIPTION COLOUR TYPE CREATED ON COUNT COUNT
Simulation No. 0 on 07/22/19 Prod. Order Status 7/22/2019 10:40 AM 23 131
Released production orders - 07/22/19 - Item View 7/22/2019 11:48 AM 6 42

If you click "publish simulation”, the selected simulation gets published. Once it is published, it gets
automatically deleted and removed from the above-shown table.

In case of inconsistent data, a warning message pops up:

@ Production Order No. 101087 has no Resource On Operation No.
60

OK
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Please remember: "publish" means that we update the Dynamics 365 Business Central database.
"Publish" means that the simulation becomes your new production schedule.

8.7.Handling of simulations with warehouse activity lines

When a production order contains a warehouse activity line, the order cannot be modified, and the
associated simulation cannot be published. To provide more meaningful user information in these
cases than the generic error message from Business Central, the VAPS offers the following support:

e asymbol for blocked production order routing lines

e aninfo window telling the users which production orders have been blocked

The following changed Production Orders have blocking
Warehouse Activity Lines that need to be handled before
publishing the simulation;

Released: 101006

Released:; 101007

Since checking for affected production orders could consume excessive time in environments with a
high volume of orders, the "Disable Warehouse Activity Line Check" option in the "General" section
of the VAPS setup dialog allows for disabling the checking process. Please note, however, that in this
case, the affected orders will still be blocked from modification.
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General

Hide Links between P... Show Infosymbol on Additional Information

Show Symbel on Co...

80

Include Operations o...

Progress Calculation | Based on Quantity v Show Symbol on Tool...

Disable Warehouse A... m Show Symbol on Pers...

Show Symbal on Qlty...

008
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9. Day-to-day use cases

9.1.Working with subcontracting work centers

The VAPS supports setting up and visualizing subcontract work centers

Many manufacturers seem to use the subcontracting functionality of Dynamics 365 Business Central
which implies setting up a work center as a subcontract work center. In general, two major use cases
can be differentiated:

1. Subcontractor as standard operation
In some cases, manufacturers need to outsource certain steps of their production process,
because they don't have the needed machines. In this case, they set up a routing and have a
subcontracting work center (which equals their supplier) as usual step of this routing.

2. Subcontractor as option to deal with bottlenecks
In this case, manufacturing companies do everything on their own. But there might be cases
in which they want to outsource something to a subcontractor because all their machines are
busy. In that case, their standard routing is on their own machines, but they can change it
manually so that then they send one operation to a subcontractor.

Since working with subcontractors is a really fundamental functionality for manufacturers, the VAPS
enables visualizing and handling subcontractors as follows:

e Subcontract work centers are treated as work centers with infinite capacities because
capacities and availability of the subcontractors are unknown to us.

e Subcontract work centers can be made part of alternate routing sets (although the rest of
the VAPS currently still focuses machine centers when scheduling).

| (Q / SAVED
Alternate Routing Set
| Header

Description Blocked

| | Alternate Routing Lines~~

1 SETUP TIME RUN TIME
TYPE CENTER NO. MACHINE CENTER NAME MULTIPLIER MULTIPLIER
| i 1.00 1.00
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After having set up a subcontractor work center, operations can be assigned just the same as is done
with "normal" work centers. However, please note that there is no Standby machine center.

Capacities

Standby (o) =
ia
- o
Milling #1 g=
=
o
. )
Milling #2 ﬁ
Turning #1
Milling & Turning l

Subcontractor 1 [ 3 01033 01023

4 Assembly & QC

The default color of the subcontract work centers can be set in the "Color Setup":

Workcenter

Subcontract Workcenter Color #00a0a0

9.1.1. Handling of subcontractor production orders with related purchase orders

If a purchase order mirrors a certain production order (and is used for communication with the
subcontractor/vendor), the due date from the subcontractor production order is used for EMAD
calculation. The reasons for this are as follows:

in this constellation, the purchase order has no quantity (and hence cannot be used for EMAD
calculation).

There is also no reservation/tracking between the purchase order and the production order.

9.2.Infinite capacity for work centers/machine centers

This feature is helpful for customers who have, e.g., certain clearly defined bottleneck areas in which
it is imperative to plan with limited capacity and other areas in which it is perfectly possible to plan
with unlimited capacity.

Moreover, in cases of orders being late, this feature helps to find out more easily where the
bottleneck is, based on the overload that has occurred (when setting a machine center to infinite).

The respective work center and machine cards were enhanced to activate the “Schedule with infinite
capacity” option.
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Scheduling

Unit of Measure Code | MINUTES e | Shop Calendar Code ‘ 2 4 |
Capacity | 4—| Queue Time ‘ 0|
Efficiency | 100| Queue Time Unit of Meas. ... ‘ s |
Consolidated Calendar @ Schedule with Infinite Capa... @

Having activated this setting will be indicated by the oo symbol on the respective work/machine
center:

METRONIC VAPS Open in Excel Acti

Capacities

4 Milling & Turning (=) »

The behavior on such an "infinite" center is the same as on standby resources and subcontractor
work centers. Operations may overlap without driving out each other. Switching on or off this option
will affect the respective center in all existing simulations but operations having been scheduled
already will not be rescheduled automatically.

9.3.Using data filters: filter on capacities

With a data filter you can load only data that you really need (e.g., if you only need to work with data
from your department). This means that these filter settings work as a Dynamics 365 BC data filter on
loading the data into the simulation. Data filters are already effective at the data interface to make
sure that only filtered data are handed over from Dynamics 365 BC to the VAPS. Read more on
creating and editing filters in this chapter.
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Let’s say, in your overall plan there is a capacity “Subcontractors” but in your individual day-to-day
work, this capacity does not matter so that you don’t need to load it. So, what would be more
obvious than creating a data filter for this with the settings shown below?

VAPS Data Filter 7 X

Filter: Work Center Group

#* Name | |

-1 Filter...

Filter totals by:

Filtering by capacities results in loading only production order lines that are assigned to these
capacities via routing. Production order lines that, due to filtering, have no child elements are not
loaded. If lines that are not complete because, for example, an operation is missing because its
capacity is filtered out, the remaining operations are displayed paler and can no longer be moved,
i.e., they are treated as "pinned with blocked capacity". The same applies to production orders.

After opening our newly created simulation with the filter "No subcontractors", you'll recognize
some operations appearing in a pale color and some links being somewhat "interrupted" because the
operations of this production order that are handled by the subcontractors get, of course, filtered
out. The paler color indicates that these operations can't be moved.
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9.4.(Basic) production line scheduling
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This feature is helpful for customers with a line-type scheduling approach.

We've encountered certain customers who follow a line-type scheduling approach. Through
collaborative sessions with these customers and their partners and a deep understanding of their
processes, we've identified specific requirements that posed challenges with our initial VAPS design.
This process revealed a plethora of potential features that could enhance the VAPS for more

effective production line scheduling.

Recognizing the substantial amount of work involved, we opted to begin with a minimum viable set
of features that would enable these customers to benefit from the VAPS immediately. Naturally, we

plan to gradually expand this functionality with future releases.

As a first step in this direction, here's what we've implemented (and what we haven't):

9.4.1.

Business Central setup

Define the line as work center

Define each “workstation” (i.e., each process step) as a machine center
Flag the work center as “Production Line (VAPS)”

Example:

o Workcenter =linel

o Machine centers of that work center

boyumlid
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< Work Center Card | Work Date: 31.01.2024 f = -+
WO00010 - Line 1

Home Work Center Related ~~ Reports »~» Automate .~ Fewer options

@load [EHcalendar B Absence

General
No. W00010) Search Name LINE 1
MName Line 1 Blocked .
Work Center Group Code 1 ~ Last Date Modified 25.10.2023
Alternate Work Center ~ Color (VAPS)
' Posting > 250 | Time MANUFACT
Scheduling
Unit of Measure Code MINUTES i Queue Time 0
Capacity 1 Queue Time Unit of Me... ~
Efficiency 100
Consolidated Calendar o
Shop Calendar Code 2 v

9.4.2. Scheduling: We take the “line dependency” into account

Example:

e 2 work centers flagged as “production line”
e Both with 5 machine centers: step 1 ... step 5

o If the first operation of a production order is assigned to the machine center “step 1” within
work center 2, all subsequent operations will also get assigned ONLY to machine centers

within that same work center 2

9.4.3. Visualization: We also monitor the “physical dependency”

e Once production order 1 is on a certain line, it cannot be overtaken by production order 2

Hence, on each machine center in that work center, the operations of production order 1 must start

and end earlier than the operations of production order 2
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The line dependency is taken into account as
hard restrictions, when you do the following:
* Apply alt. routing (if prod order is on standby)

* Add all incl. alternatives
* (Apply routing and add all only work if your
default routing keeps the line assignment)

Notice: All other scheduling tools currently do
not take the line dependency into account.

Attention: you can violate any of these
restrictions via drag & drop.

DANGER: “fill idle times” will most likely break

up all line dependencies.

9.4.4. How to cope with the limitations

e Two new color schemes
o Production Line Assignment -> gives a visual warning if the “line dependency”
restriction is violated (e.g., multiple operations from one production order flipping
between lines)
o Production Line Sequence -> gives a visual warning if the “physical dependency”
restriction is violated (e.g., one production order overtaking the other)
e Recommendations
o Set your default routings in a way that the line assignment is granted
Set alternate routing sets so that you can efficiently “fill” all your lines
When doing line scheduling, trust the automatic scheduling
Avoid drag & drop as much as you can
If there are issues (sequence or line assignment violation), move the production
order to standby and reschedule -> all line restrictions will be considered again

O O O O
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